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Tiger compatible ... 

The complete Macintosh problem solving utility. 

Diagnostics and Repair 
Tech Tool® Pro includes options to thoroughly check various hardware 
components, drives, and other aspects of your computer system. 
One of the most important tests is the S.M.A.R.T. test, which checks 
for impending drive failure . 

Optimization 
This feature defragments the files on your hard drive and consolidates 
all the free space into one large b_lock. Optimizing enhances the 
overall performance of your hard drives and simplifies file layout on 
the disk. 

Data Recovery 
TechTool Pro includes routines that can search a damaged drive 
and attempt to recover valid files to another location. Hence, even 
if a drive is damaged beyond repair, you may still be able to save 
important data that had not been backed up. 

Safety 
The Safety feature can be configured to protect your drives by 
automatically creating backups of critical drive directory data. It can 
also test the computer for developing problems and alert you, both 
onscreen and via email, if problems are detected. 

eDrive 
One of the most innovative features of Tech Tool Pro is the eDrive. 
This is a bootable Mac OS X partition containing TechTool Pro and 
a small copy of your system that you can use in an emergency. It 
is created on one of your ha.rd drives without the need to reformat. 

Micromat, Inc ., 5329 Skylane Blvd., Santa Rosa, CA 95403 
800-829-622 7 707-566-3831 info@micromat.com www.micromat.com 
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Clicks well with others 

Air Click 

fOl Madefor 

@J iPod 

iTalk 

AirClick 
Remote Control for iPod 

·Control your iPod, iPod mini, or computer from up 
to 60 feet away ---·Uses RF signals that travel through walls for 
remote control use anywhere in the house 

·Tiny remote attaches to backpack, bike, steering 
wheel - anywhere for on-the-go control 

.............. . 
- ~~:::::: : 

!Talk • ::: : : :: : : :1 
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Lapel Mic 

fQ] Madefor 

~ iPod 

iPod Voice Recorder Multipurpose Stereo Microphone 

·Internal microphone and· 
laptop quality speaker 

·Connect external 

• Passthrough jack for 
headphones or additional 
speaker 

microphone or headphones ·Automatic level control for 
perfect recordings 

fOl Madefor 

@J iPod 

iTrip 
FM Transmitter for iPod 

·The only FM Transmitter 
designed exclusively for the 
iPod & iPod mini 

·Powered from the iPod -
no batteries necessary 

iTrip 

·Choose any empty station 
from 87.7to 107.9, and 
change your iTrip stations 
directly from the iPod 

learn more at www.griffintechnology.com 

·Self-powered microphone 
with stereo-quality sound 

·Swivel clip for easy 
attachment 

fOl Madefor 

@J iPod 

TuneJuice 

·Connects directly to iTalk, 
iMic, or PowerWave 

Battery Backup for iPod and iPod mini 

• Provides up to 8 hours of 
additional power to iPod 

·Uses any disposable or 
rechargeable 9-volt battery 

·Carry emergency iPod 
power wherever you go 

·Works with any dockable 
iPod or iPod mini 

(GRIFFIN) 



$ 2999 

iVault 
Aluminum Case for iPod shuffle 

·Elegant, protective enclosure for iPod shuffle 

·Available in Silver, Purple, Blue and Red 

·Four screws ensure that your iPod shuffle is 
completely secure and only comes out of the 
iVault when you want it to 

·Includes 36" USB cable for connectivity while ) 

your iPod shuffl_e_i_s_p_ro-te_c_te_d----------------------

$3999 

iMic 
USB Audio Interface 

·Adds stereo audio inputs and outputs 
to any USB equipped Mac or PC 

• Includes everything needed to record 
albums and tapes to make MP3s and CDs 

·Plug-and-Play simple, no install required _____ / 
/--

{ $3999 

Sightlight 
FireWire Light for iSight 

·Custom-designed Fresnel-based lens 
diffuses light to even out shadows 

·Auto setting automatically senses the 
amount of ambient room light and 
adjusts its output accordingly 

·Shares the iSight's FireWire connection 

$7999 ~ 

fa Madefor 

~iPod 

RoadTrip 
FM Transmitter, Charger, and Cradle 

·Power and charge an iPod or iPod mini 
from any 12-volt cigarette lighter 

• RoadTrip transmitter module works 
separately as an FM transmitter for your 
home computer 

·Transmits on a full range of frequencies 
from 88.1 to 107.9 

fs~499- (~ 
$19

99 

~ 
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iPod 

Dock400 & Dock800 
Dock Cables for iPod 

·Take advantage of the Fire Wire 800 or 
FireWire 400 port on your computer -
no more unplugging another device to 
sync your iPod 

·Charges and syncs your iPod or iPod mini , 

·Connects to iPod or iPod Dock ) ___ ./ 
learn more at www.griffintechnology.com 

$6999 

• AM/FM radio for your Mac or PC 

·Record your favorite programs 
while you listen or schedule recordings 
for later 

• Easily transfer recordings to iTunes 

·Pause and resume live radio 
or scroll back in time and record 

$45 

Power Mate 
USB Multimedia Controller Knob 

·Eliminates repetitive keystrokes 

·Great control for iTunes, iMovie, 
and GarageBand 

·Programmable for any appl ication 

• Now in Brushed Aluminum and Black 

------~\ 

$3999 I 

iCurve 
Invisible Laptop Stand 

• Keeps laptop cool with maximum 
air circulation 

·Raises laptop screen to the perfect 
height and creates room on the desktop 
for an external keyboard and mouse 

·Fits all Apple PowerBooks and iBooks 

I 

I 
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features 
20 Extreme 
Mac Makeover 
Alter appearances, manipulate menus, improve 

interfaces, and customize your Mac to work just 

the way you want it to. 

by Johnathon Williams 

30 Calling 
All Macs 
Forget the phone company. 

Put your Mac to work 

answering phones, taking 

messages-even calling 

dear ol' mom . 

by Cathy Lu 

how to 
56 Ask Us 
We show you how to upgrade your iPod's hard drive, 

deauthorize your iTunes Music Store purchases, 

and prep an old Mac for a ch arity drive. 

58 Make a Chaptered Podcast 

'4. A New Chaptu (2S:22) 

Follow along as we create 

a podcast complete with 
audiobook-like chapters, 

titles, links, and images. 
by Dan Pourhadi 

60 Find Your Effin' Cursor 
In these days of giant 

displays, finding your cursor 
can be an eye-straining 

pain . Here are a few tricks 

for keeping track of that 

pesky pointer. 
by Niko Coucouvanis 

36 iTunes 
Alternatives 
There 's more to music 

shopping than the iTunes 

Music Store. Try out some of 

these Mac-compatible, iPod

friendly online music stores. 

by Logan Kugler 

MP33!lir1f 

•e• music• • ee• 

62 Get Smart with Spotlight 
Spotlight puts untold file-finding power at 

your fingertips-as long as you know how 

to use it. We've got five ways to become a 

smarter Spotlight user. 

by Niko Coucouvanis 

64 Make Your Mac a 
GarageBand Singer 
Use TextEdit, GarageBand, and the freeware 

app Soundflower to turn your Mac's inner 
voice into a superstar singing sensation . 
·by Niko Coucouvanis 

Cover image by Oliver Wolfson 
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10 Editors' Page 
Our Editor in Chief recommends that you take those 
earbuds out of your ears. 

12 Get Info 
The iPod nano and iTunes Phone usher in a new era 
of on-the-go aural pleasure. Also: News and new 
technology from the Intel Developer Forum. 

39 Reviews 
43 14-inch iBook G4 notebook Mac 
52 ARP2600 V software synth 
46 Bumperz iPod shuffle cover 
46 Cool Caps iPod shuffle cap 
41 050 SLR camera 
40 iPod nano digital-music player 
46 Jam Jacket iPod shuffle cover 
42 LaCie mini external hard drive 
48 LCM-17w7 LCD display 
50 Mercury Elite-AL Pro external hard drive 
49 Mighty Mouse multibutton mouse 
54 mini Grandstand Mac mini stand 
42 miniMate external hard drive 
42 miniStack external hard drive 
54 mini Tower Mac mini stand 
48 PhotoKit Photoshop plug-in 
50 Pixma iP90 portable inkjet printer 
44 QuicKeys X3 automation utility 
52 Radio YourWay LX digital-radio recorder 
46 Shieldz iPod shuffle cover 
46 SiliSkins iPod shuffle cover 
45 Star Wars Battlefront action game 
46 SuperClip iPod shuffle clip 
46 SuperHook iPod shuffle clip 
46 The Clips iPod shuffle clip 
46 TuffWrapz iPod shuffle cover 
46 TuneCaps iPod shuffle cap 
53 Wirecast 2 Webcasting software 
49 Wireless Headphones for iPod headphones 
51 Xingtone Ringtone Maker ringtone editor 

55 The Hot List 
We'd spend our own hard-earned money on these 
products. 

QUICK TIPS 
FROM THIS MONTH'S ISSUE 

78 Log Out 
78 Letters 
Our readers explain how to turn 
your car into a 'Podracer and 
what to do with those extra AOL 
CDs you've got lying around. 

+ SPOTLIGHT 
PLUG-IN POWER 

+ THE ART OF EFFICIENCY + MULTIPLICITY 

You may not be getting the 
most out of Spotlight if you 
don't have the proper plug
ins. Check out www.apple 
.com/downloads/macosx/ 
spotlight to find out what you 
might be missing. 
From "Get Smart with 
Spotlight," p62. 
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Remove album artwork to free 
up precious iPod space-an 
album's 
worth of 
art can 
easily 
take up 
SMB. 
From Ask 
Us, p56. 

Be wary of the 
multiplier effect 
when using 
lenses designed for 35mm film 
cameras with digital SLRs; 
the effective focal length of 
a Nikon AF lens, for example, 
can be 1.4 to 1.6 times that of 
its stated length. 
From Reviews, p41. 

79 Contest 
Feeling creative? You could win 
yourself a copy of Avid Xpress 
Pro 4.8. 

80 Shut Down 
Presenting an exhibit from the 
hallowed halls of the MacAddict 
Rejected How-To Museum. 

+ iCHATSMS 
You can send SMS messages 
to cell phones from iChat-go 
to File> New Chat With Person, 
enter+l, a mobile number, 
and chat away. 
From "Calling All Macs," p30. 

r- '"" '"' lns1ant Mesuqe 

Ente r the address of the person to Invite. 

+15555473405 
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the disc 
OMG, have we got a load of goodies for 
you this month . First, check out all the 
apps you can use when working your way 
through this month's feature stories . Then 
dig into all the other software, utilities, 
and games packed onto this month 's 
Disc- a total of 70 killer apps! 

iVideo 
demo 
Th e organizati onal 
smarts of iPhoto and 
iTun es-for your videos. 

AUDIO & MUSIC 
Amadeus II 3.8.4 trial 

ARP2600 V 1.0 demo 

ChapterToolMe 1.4 trial 

Peak LE 4.1.3 trial 

Podcast RSS Buddy 2.1 shareware 

SoundSoap 2 Demo Video 
Synergy 2.1 shareware 

Xingtone Ringtone Maker 1.0 demo 

DEVELOPMENT 
REALbasic 2005 R2 demo 

Widget Maker X 1.1.3 shareware 

FUN&GAMES 
Atlantis 1.0 trial 

Cross Eyes 1.1 .1 shareware 

Crossword Forge 4.0 shareware 

FlipWords 1.0 trial 

Tri 1.1 shareware 

Universal Boxing Manager 
1.0 trial 

Wild West Wendy 1.0 trial 

Poser 6 
demo 
Simply put, Poser is t he 
world 's best 3D figure
creation app. 

Mouse Locator 1.0 freeware 

Serene Saver 1.0 trial 

ShapeShifter 2.2 shareware 

ThemePark 2.1 .1 shareware 

Visage (OS 10.1) 1.0.1 shareware 

Visage (OS 10.2) 1.2.4 shareware 

Visage (OS 10.3) 1.3 shareware 

Visage (OS 10.4) 2.2 shareware 

WindowShade X 4.0.1 shareware 

Xounds 2.3.1 shareware 

INTERNET& 
COMMUNICATION 
Blog.Mac 1.0.5 shareware 

Fetch 5.0.2 trial 

Gizmo 1.0.0.55 freeware 

MT·NewsWatcher (Classic) 
3.4.freeware 

MT-NewsWatcher (OS X) 3.4 
freeware 

Skype 1.0.0.24 freeware 

SMS Mac plug-in 1.0 freeware 

SMS Mac widget 1.1 freeware 

GRAPHICS & MULTIMEDIA smsZap 1.0.1 rreeware 

iVideo 3.0.1 demo Transmit 3.2.1 trial 

Photoshop Elements 3.0 tryout Unison 1.6.3 trial 

Poser 6 demo • -------' Wirecast 2.1 demo 

INTERFACE 
Amnesty Widget Browser 
1.0.2 shareware 

CandyBar 2.5.1 shareware 

Earth Desk 3.0 shareware 

FruitMenu 3.4.1 shareware 

Menu Master 1.2 shareware 

MenuCalendarClock for 
Entourage 2.0.2 shareware 

MenuCalendarClock for 
Entourage 2.1 shareware 

MenuCalendarClock for 
iCal 2.0.5 shareware 

MenuCalendarClock for 
iCal 2.0.9 shareware 

Mighty Mouse v1.2.2 
shareware 

UPCiRADE 

PRODUCTIVITY 
3D-Space VFS 1.4.2 trial 

A-Dock 2.8.6 freeware 

A-Dock X 1.4.1 shareware 

CueType 1.0.3 shareware 

DEVONagent 1.7 demo 

DEVONthink Pro 1.0 demo 

DragThing (OS 10.1.5 to OS 10.2) 
4.6.1 shareware 

Change the look of 
your windows, buttons, 
menus, and more. 

shareware 

IClip 3.7 shareware 

Launch Bar 3 3.3 shareware 

Launch Bar 4 4.0.2 shareware 

QuicKeys X3 (OS 10.3 to 10.3.8) 
3.0.2 demo 

QuicKeys X3 (OS 10.3.9 or later) 
3.1 demo 

Text pander 1.0 donationware 

The Omni Group Software 
Bundle demo 

UTILITIES 
DiskTracker (Classic) 2.3.2 
shareware 

DiskTracker (OS X) 2.3.2 
shareware 

SoftRAID 3.2.1 demo 

TechRestore Demo Video 
Xupport 3.0 shareware 

SPONSORS 
Atlantis 1.0 trial 

DEVONagent 1.7 demo 

DEVONthink Pro 1.0 demo 

FlipWords 1.0 tria> 

Peak LE 4.1 .3 trial 

Poser6 demo 
SoftRAID 3.2.1 demo 

SoundSoap 2 Demo Video 
TechRestore Demo Video 
The Omni Group Software 
Bundle demo 

Universal Boxing Manager 1.0 trial 

Wild West Wendy 1.0 trial 

If you don't receive the Disc with your copy of MacAddlct , you might want to consider upgrading. Each monthly Disc contains coo l 
demos, useful shareware and freeware, and the Inimitable MacAddlct Staff Video. To get 12 Issues of MacAddlct that Include th is value
packed disc with your subscription (prorated if necessary) for Just $1 more per issue, call 888-771 -6222-the operator will take care of 
everything. 
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l 0 /1 EDITORS' PAGE 
tr a note from the kernel 

Take Time to Whistle 
I took a walk down by the Golden Gate 
Bridge the other day, enjoying the slap 
of breakers on the breakwaters, the 
squawking of seagulls as they squabbled 
over picnickers' excess Doritos, the 
squealing of little kids as they tried to 
outrun the waves of San Francisco Bay, 
and the steady beat of joggers' feet as they 
passed me on the trail. It was a wonderful 
aural landscape. 

And then I noticed that a good 
percentage of the runners had those telltale 

white earbuds pressed into their ears. Whatever they were hearing-be 
it Bach, Beyonce, Billy Bang, or the Bellamy Brothers-two things were 
certain. First, they were shutting themselves off from the glorious sounds 
of the world around them. Second, they were isolating themselves from 
their fellow San Franciscans. According to John Donne, no man is an 
island, but when you plug your head into an iPod, you instantly become 

Take those 
earbuds out 
of your ears 
sometimes. 

one pretty damn skinny peninsula. 
Don't get me wrong-I love my iPod. It's stuffed 

with about 30GB of tunes, from Aaron Neville to 
ZZ Top, plus family photos and my most important 
contacts. My 'Pod is my constant companion 
when reading or writing and my photo vault when 

shooting in the field-but I never wear it in public. Call me old-fashioned, 
but I think it's rude to cut myself off from others, whether they're clerks 
in my local supermarket or passers-by on the street. And I like to listen to 
the world-it's where I live, and there's a lot to learn by tuning into it. 

And now Apple has given us two more temptations toward isolation: 
the gorgeous iPod nano ( p40) and the multitalented phone 
cum camera cum music machine, the iTunes Phone (see Get Info, p12) . 
They both make it vastly easier to take your tunes with you when you're 
on the go-and who isn't these busy days?-but they both also tempt 
you to shut yourself off from your surroundings and, for that matter, from 
quiet, random musings. · 

So enjoy your new nano or phone, but take those earbuds out of your 
ears sometimes. Listen to the world around you. Talk with folks on the 
street. Maybe even find time to whistle a happy tune. 

Enjoy, )1:4 

comingsoon: december2005 
Here's what our editors are preparing for the next issue of MacAddict. 

Sean Molloy PSYCHOBABBLER 

What would life be like ii all electronic gadgets disappeared? 
1 You'd probably see the end of conditions like Attention 

Deficit Disorder. Without a PDA to constantly remind you 
of all the niggling crap on your to-do list, anxiety and panic 
attacks would all but disappear. People would be able to 

focus on things without the help of brain-altering chemicals. Actually, 
I have no idea what I'm talking about. Who am I, Tom Cruise? 

Niko Coucouvanis GEORGE w. OUEEG 

What would life be like if all electronic gadgets disappeared? 
To paraphrase Thomas Hobbes, in such condition there is 
no place for industry and consequently no culture of the 
earth ... no account of time; no arts; no letters; no society; 
and which is worst of all, continual fear and danger of violent 

death; and the life of man solitary, poor, nasty, brutish, and short. 

Jake Widman FUDDY-DUDOY 

What would Ille be like If all electronic gadgets disappeared? 
It would be vewy, vewy quiet. 

Roman Loyola TUBE BOOB 

What would Ille be like if all electronic gadgets disappeared? 
Like you mean there would be no remote control for the 
TV? Or there would be no TV at all? No, no, no, no, no! 
Step back-I think my head is about to explode! 

Peter Marshutz UNPLUGGED 

What would Ille be like if all electronic gadgets disappeared? 
Generally I think most people spend way too much time 
plugged into their gadgets-TVs, iPods, stereos, phones, 
and so on. I enjoy turning it all off at home, but must make 
an effort to do it. Entertainment gadgets can be very 

addicting-it's very easy to become a mouse potato and tune out life. 
I wouldn't be surprised if someday we see a Betty Ford clinic for the 
gadget addict. 

Mark Rosenthal c. o. FISH 

What would life be like if all electronic gadgets disappeared? 
Using gadgets is no different than any other activity; they 
just replace another experience. For example, let's say 
you go snorkeling. You notice cute fish but are not talking 
with girls on the beach or noticing the sunburn developing 

on your back. One activity always gives way to another. 

What would life be like If all electronic gadgets disappeared? 
Living in a two-dimensional world, I don 't have access 
to all the three-dimensional gadgets you thick folks 
do-however, now that Apple has introduced the ultra-thin 
iPod nano, my life is about to become way more tuneful. 

Trying to keep your stuff organized on multiple Macs? We'll show you how to synchronize your tunes, contact info, and 
calendar with another Mac, a PDA-even a peecee! We'll also reveal our picks for tt:ie best iPod accessories. Our Field 
Guide to Wi-Fi will teach you how to tell WAP from WEP and why WiMAX is not a supermarket. We'll show you how to 
customize your Sims characters, put flipbook animations on your iPod, how to best enlarge photos for oversized 
printing, and personalize your Mac with home-brew icons. Finally, we'll take a look at Macromedia's latest version of 
Dreamweaver, Hasbro's iDog, Aspyr 's LEGO Star Wars, lmation's Micro Hard Drive, and a whole lot more. 
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TRANSFORM YOUR PAPERWORK. 
Give your admi ni strative paperwork new li fe with the Fu jitsu ScanSnap™ Paper Manager fo r Macintosh™ Its 50-page automatic 
document feeder quickly transforms a stack of paper into use ful . easy-to-manage electronic files. It transforms double-sided documents 
into PDFs with one-bunon ease and automatically transforms documents into email anachments for faster. su rer delivery than faxing. 
All on a sca nner footprint smaller than a sheet of paper. Add Advance Excha nge owne rship protection for worry-free se rvi ce . 
Now. that is a thing of beauty. Call 800-831-8094 ext.9489 or see it in action now at www.fcpa.fujitsu.com/9489 

Adobe· Acrobat· 7.0 Standard -Included s495!!.!! 

cP 
FUJITSU 

Advance 
EXCHANGE THE POSSIBILITIES ARE INFINITE 

C 2005 Fujitsu Computer Products of America. Inc. All rights reserved. Advance Exchange upgrade of $59 is sold separately and is not included in the $495 cost. Service program and ScanSnap prices are subject to change. Fujitsu and the 
Fujitsu k>go are registered trademarks of Fujitsu Ltd. ScanSnap and Advance Exchange are trademarks of Fujitsu Computer Products of America, Inc. Adobe, the Adobe logo and Acrobat are either registered trademarks or trademarks of Adobe 
Systems, Inc. in the United States and/or other countries. Mac and the Mac logo are trademarks of Apple Computer. Inc., registered in the U.S. and other countries. All other trademarks are the property of the their respective owner. 

~- Insight. TigerDirect.com PCNatio:rf 
W.cutpticeL.l\Ot_....tal 

,...----......_ 
PC Connection MacMaJf 



12 
~ G ET I N F ohe news ofthe month in Me-size ~unks . 

SOMEBODY 
GET THE 

Now Playing -

PHONE! 
Few are stunned by Apple's iT unes Phone 
announcement. 

0 
n September 7, we joined 
a few hundred press 
folk in San Francisco's 
Moscone West convention 
center to find out what 

Apple had up its sleeve-or rather, in its 
pocket. A couple weeks earlier, we had 
received an invitation bearing a photo of 
the change pocket on a pair of jeans and 
the cryptic statement, "1,000 songs in 
your pocket changed everything. Here 
we go again." Obviously, whatever was 
up was a Big Secret-smiling attendants 
warned us that anyone caught blogging 
would be asked to leave. 

When the lights went down, Steve 
Jobs took the stage and raved about the 
success of the iTunes Music Store-half 
a billion songs sold so far, 82 percent 
market share in the U.S., 7 million 
podcast subscriptions, 10 million iTMS 
accounts (for more iTunes news, see 
"But Wait! There's More!"). 

Then came the first "just one more 
thing," and it was (insert drum roll)-the 
iTunes Phone, possibly Apple's worst
kept secret ever. Made by Motorola, 
the ROKR (as in "rock 'n' roll," not the 
TV weatherman) comes with stereo 
speakers, a set of stereo headphones 
that also function as a headset, and 
a VGA camera with video capability. 
Motorola claims a battery life of up to 9 
hours of talk time or 9 days in standby. 

But it's the ROKR's musical abilities 
that make it stand out from the mobile 
crowd. Steve referred to it as a "shuffle 
in a phone," and like the iPod shuffle, 
you can attach the phone to your Mac 
with the included USB connector and fill 
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it with up to 100 songs from your iTunes 
library, either manually or via autofill. An 
Apple spokeswoman told us that the tiny 
SanDisk microSD (aka TransFlash) cards 
used in the phone are currently available 
only in capacities up to 512MB, and 
512MB holds about 100 songs. When 
asked if it would be possible to replace 
the card with a larger one if and when 
they become available, she replied that 
the phone would let you download only 
100 songs "at a time." 

To listen, you press a dedicated iTunes 
button on the front to bring up the 
iPod-esque menu on the ROKR's color 
screen. One way the phone is definitely 
not like a shuffle is that you can scroll 
through your library and playlists and 

BUT WAIT! There's More! 
Although the iTunes Phone and iPod nano stole the show at 

Apple's September 7 "music event," there were a handful of 

other announcements that kept us editor types busy scribbling 

notes and quotes in the darkened auditorium. 

iTUNES GETS SMARTER 
The interface of iTunes 5 has 

been gently tweaked, with a 

light blue tint in the Source 

pane and persistent time

elapsed and time-remaining 

indicators. A new Smart Shuffle 

feature (iTunes >Preferences> 

Playback) allows you to control 

the likelihood of how often 

you'll hear songs from the same 

album or artist when listening 

in shuffle mode. Most welcome 

is the addition of nestable 

folders (File> New Folder) into 

which you can place playlists

great for arranging playlists any 

way your little heart desires. 

You can also now block your 

kids from listening to pod casts, 

visiting the iTunes Music Store, 

and accessing shared music by 

clicking the appropriate check 

boxes in iTunes > Preferences > 

Parental. You can also choose 

to block iTMS content that's 

tagged as Explicit-these 

songs still appear in the iTMS 

browser, but the Buy Song 

button is dimmed out, and 

nothing happens when you click 

to listen to the preview. Apple 

missed a spot, however: Bands 

with vulgar names are still 

searchable. (We'd give you an 

example, but this is a PG-rated 

magazine). 
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ACTUAL SIZE: The new iPod nano (left) and 

iTunes Phone (right, a Motorola ROKR) actually 

look smaller in person-really, they do. 

the music. The ROKR also has an 
"airplane mode" that allows you to listen 
to music without violating the ban on 
cell-phone use in airplanes. 

Cingular provides phone service for 
the ROKR-it's for sale at Cingular stores 
or on line for $249.99 (a 2-year service 
contract is required). The phone allows 
Internet access (if you purchase the 
service), though it won't support buying 
songs from the iTunes Music Store. 

After the iTunes Phone had taken 
its turn, Steve moved on to the iPod 
segment of the program, and the stage 
was set (literally) for the announcement 
that Apple was replacing the iPod mini 
with a device he pulled from his jeans 
pocket-the change pocket, that is : 

select songs on the fly. Music playback 
automatically pauses when you take an 
incoming call and then picks up again 
when you hang up. If you'd rather listen 
than talk, you can send text messages 
(or use the camera) without interrupting 

the iPod nano (see our review on page 
p40) . The crowd, as they say, went wild. 
Finally, the event closed with two songs 
by megarapper Kanye West, who got the 
crowd of decidedly non-hip-hop nerds, 
analysts, and news folk on their feet, 
raising the roof. Well, OK, not really. 
-Jake Widman 
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iTUNES MUSIC STORE 
GETS BIGGER 
The iTunes Music Store is 

now easier to search and 

navigate-and, by the way, it's 

freakin' huge. According to 

Steve Jobs, iTMS now contains 

over two million songs, fifteen 

thousand podcasts, ten 

thousand audio books, and over digital-Potter experience to a 

a thousand album reviews. We hefty $548. Better be a fan. 

didn't have time to count them 

all, so we'll have to take him at 

his word. 

MADONNA MEETS 
HARRY POTTER 
Speaking of iTunes Music 

Store content, you can now 

plunk down 99 cents for 

each and every song from 

Madonna's entire oeuvre and 

buy the six Harry Potter books 

in audiobook form at prices 

ranging from $32.95 (Stone and 

Chamber) to $49.95 (Phoenix 

and Half-Blood) . If you're 

feeling flush, you can get all six 

audiobooks in The Complete 

Harry Potter for $249-and if 

you're feeling royally flushed, 

you can add a Hogwarts

crested 20GB iPod for another 

$299, bringing the complete 

MORE CARS GET 
'PODDABLE 
Finally, Apple added Acura, 

Audi, Honda, and Volkswagen 

to its garage of manufacturers 

that will integrate iPods into 

their car-stereo systems, 

bringing the total fleet to 12 

carmakers (for more details, 

see www.apple.com/ipodnano/ 

ipodyourcar). According to 

Steve, 30 percent of cars sold 

in the U.S. in 2006 will have 

optional iPod integration. For 

those of you too impecunious to 

pop for that Audi TT you've been 

lusting after, take heart-there 

are after-market setups 

available, as well-check out 

www.apple.com/ipodnano/ 

ipodyourcar/accessories 

.html.-Rik Myslewski 

~ MINDVOUR 
P'S AND ZOOM 
EasyShare P880 
$599 
www.kodak.com 

Available: Now 

It looks like an 

SLR- but it's not. 

The flagship member of Kodak's new 
Pline is an 8-megapixel camera with a 
24mm to 140mm (35mm equivalent), 
f/2 .8 to f/4.1 wide-angle zoom lens. It 
also features a 2.5-inch LCD, shutter 
speeds from 1/4000 to 16 seconds, 
and the ability to capture 640-by-480-
pixel QuickTime videos. 

Small on the 

outside. 

Big on the 

inside. 

~ HARD DRIVE IN YOUR POCKET 
120GB Mercury On-The-Go 
$349.99 
www.macsales.com 

Available: Now 

owe now offers a 120GB version of its 
Mercury On-The-Go 2.5-inch hard drive. 
The bus-powered, 5,400-rpm drive has 
an 8MB cache, two FireWire 400 ports, 
and one USB 2.0 port. The software 
bundle includes EMC Dantz Retrospect 
and lntech SpeedTools. 

~ TWO THROUCiH ONE 
2x1 DVI KVM Switcher 
$199 
www.gefen.com 

Available: Now 

This box lets you control two Macs with 
one keyboard, mouse, and display 
(it supports DVI video up to 1,920 
by 1,200 resolution). The 2x1 comes 
with two audio cables, two 6-foot DVI 
cables, two 6-foot USB cables, and an 
external power supply. 

Control two Macs through one keyboard, 

mouse, and display. 
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DROOL WORTHY 
Sexy Stuff We Can't Wait to Get Our Mitts On 

In the 
iMix + 
Nu mark's iDJ ($399, www.numark.com) is a two-channel audio-mixing 
console that can handle any iPod with a Dock connector. The iDJ features 
precision switches and knobs, a three-band equalizer with gain control for 
each channel, a crossfader, USB connectivity, and more. 
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+. Boomin' 
Tripod 
The Japanese are so 
lucky-they get first dibs 
on hip, cool gadgets such 
as Tunewear's Boomtune 
mini (¥3,980, about $36 at 
press time, www.tunewear 
.com) . The Boomtune 
mini has a pair of 1-watt 
speakers; the third leg 
houses one AAA battery. It 
plugs into any headphone 
jack, so you can use it with 

any 'Pod or 'Book. Sadly, 
Tunewear says there 

are no plans to sell 
this cute Iii' item in 

the U.S. (yet?). 
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• Alias's Maya 
Complete 7 
($1,999, WWW 

.alias.com) is a 
3D modeling, 
animation, and 
effects app. It now 
integrates Alias's 
MotionBuilder, a 
new toonshader, 
the ability to 
transplant a 
character's hair, 
and more. 

• Red Giant's Magic 
Bullet Editors 2 
($395, WWW 

.redgiantsoftware 

.com) is a set 
of plug-ins for 
video-editing apps 
for adding film
look treatments 
to video. The 
plug-ins can now 
isolate rendering 

Hey VJ, play the video to nVidia GPUs, 
of my favorite song. cutting down on 

processing time. 
• Waterfall Software's iVideo 3 ($19.95, 

on the Disc or download from www 
.waterfallsw.com) is a video organizer 
with an iPhoto-like interface. Version 
3 adds folders, 
WMV support, 
faster performance, 

ON THE 
DISC 

and more. iVideo 3.0.1 

• SilhouetteFX's Silhouette Roto 2 
($595, www.silhouettefx. com) is 
a film-rotoscoping application . 
The latest version offers layering, 
keyboard customization, support for 
Silhouette Paint, and more. 

• Korg's kaptivator Dynamic Video 
Station ($2,500, www.korg.com) is 
a VJ tool that lets you sample, mix, 
and play back video clips without 
the need of a Mac. The station has a 
pair of 2.5-inch LCD displays, 16 clip 
pads, and more. 

• RE :Vision Effects' RE: Flex 3 ($595 for 
After Effects, $795 for Shake, www 
.revisionfx .com) is a plug-in for Afte r 
Effects or Shake that helps you create 
morphs and warps. 

• Avid 's Xpress Pro 4.8 ($1,695, 
www.avid.com) editing app is now 
optimized for Tiger and uses Core 
Image units.-Michel/e Victoria 



THRILLS, SPILLS, AND LONG LINES 
~ Roller Coaster Tycoon 3 is all about drawing people into your 
amusement park, entertaining them with rides and attractions
and sucking every dime out of their virtual pockets . You set the 
prices for admissions, rides, and food; build coasters and ride 
them yourself via the Coaster Cam; create fireworks displays; 
and even augment rides with music from your MP3 library. 
Advance through the game's levels by accomplishing specific 
goals, or play in Sandbox mode with no limits.-MO 

TIPS & TRICKS: GANGLAND 
Life is tough on the streets-and so is Virtual Programming's 
Gangland, a game in which you work your way up the Mob 
ladder. These tips could mean the difference between 
becoming fish bait and becoming the don. 
AVOID CITIZENS Gangland's citizens carry tasers and 
pepper spray, and they like to attack when they see mayhem 

l on the streets. They can stun you while your rivals turn you 
I into lunch meat. 

WHAT LURKS UNDER YOUR FEET? 
~ The lncredibles: Rise of the Underminer begins where 
the movie left off as a new villain, The Underminer, hatches 
a devi lish plot to pollute Metroville and rule the Earth from 
below its surface. You play cooperatively as the dynamic 
duo of Mr. Incredible and Frozone, reliving past adventures, 
upgrading your superpowers, and battling The Underminer's 
robot minions in his underground lair.-MO 

LEAVE A TRAIL OF BLOOD If your health drops below 50 
percent, you can only stagger, so make sure to run away (or 
take care of any coordination-dependant business) before 
that last bullet hits. 
HIRE GOOD HELP Always employ the right number of 
henchmen for the job. Bring too few goons, and you might 
be outgunned. Bring too many, and they could eat up your 
ammo supply before you get to your destination .-MO 
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Apple's switch to Intel processors 
is not just about Intel processors. 

In fact, Intel is not just a company that 
designs and manufactures processors. 
At the Intel Developer Forum (IDF), 
held in San Francisco on August 23 
through 25, the company proclaimed 
that it has "realigned itself as a platform 
company." 

No, Intel isn't building height
enhancing shoes for seventies hipsters. 
A platform, in this context, refers to 
Intel's design and production of not 
only processors but also the support 
chips that work with them to create fully 
functioning PCs. Y'know the Centrino 
marketing blitz that began back in 
2003? Centrino's not a chip; it's a 
platform. Intel's platform-defining chips 
don't include just the familiar system 
controllers that handle memory access 
and the 1/0 controllers that 

the company has the multi-core Yonah 
on the way as the heart of Napa, the 
Centrino-follow-on mobile platform 
slated to appear in 2006. (Actually, 
Napa is a follow-on to the Pentium M's 
Sonoma platform, which will appear 
later this year, but we digress.) The 
real muscle, however, won't appear 
until Intel debuts its next-generation 
processor architecture in the second half 
of 2006. Multi-core processors based 
on this architecture will find their way 
into everything from high-end servers 
to workstations, office computers, 
home computers, home-entertainment 
devices-perhaps based on Intel's new 
Vi iv (it rhymes with jive) technology-as 
well as laptops and a new projected 
class of computing devices that Intel 
CEO Paul Otellini calls "handtop PCs," 
to be powered by Monahans, the next 

Buzzwords Oebuzzed 

generation of Intel 's XScale processors 
(see "Intel 102," Oct/05, p14). 

The details of Intel's next-gen 
architecture are .resolutely Deep Geek, 
but processors based on it will improve 
RAM-access speed, take efficient 
advantage of mango on-chip L2 caches, 
schedule commands more productively, 
and manage power more effectively
waaaaaay more effectively. We're going 
to see some seriously powerful chips in 
low-power, cool -running devices. 

Say goodbye to the megahertz myth. 
In fact, Intel so thoroughly touts power 
management as a central design goal 
of its next-gen chips that "performance 
per watt" vied with "multi-core" for 
most-overheard phrase in IDF's crowded 
hallways, geek-infused meeting rooms, 
and eerily polite keynote presentations. 
Admittedly, "performance per watt" 

sounds as if it were invented 
by some marketing weasel keep FireWire and USB in 

line; they also include more
esoteric technologies such 
as FB-DIMMs, PCle, WiMAX, 
Wireless USB, and more (see 
"Buzzwords Debuzzed," 
right). Intel doesn't take 

With every advance in technology comes new terminology. Here 
are a few on-the-horizon techie bits to wrap your head around. 

to wriggle out of the fact that 
gigahertz one-upsmanship 
has left the building, but 

the final step of integrating 
its platform chips into 
motherboards-it leaves that 
to others. Like Apple. 

Multi-core across the 
board. The true stars of IDF, 
however, were Intel's future 
multi-core processors (see 
"Intel 101," Sep/05, p32). 
Intel is already shipping the 
multi-core Pentium M, and 
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FB·DIMMs {aka fully buffered DIMMs) An Intel 
technology that allows hardware designers to economically 
design motherboards that support large amounts of fast RAM . 
PCle (aka PCI Express) A standards-based technology 
that blows away PCI and PCl-X and signs the death warrant of AGP. 
WiMAX (aka World Interoperability for Microwave 
Access) A standards-based technology (IEEE 802.16) that can 
theoretically transfer up to 75 Mbps per channel at ranges of up to 
37 miles. In the real world, however, don't expect that performance. 
Wireless USB (aka WUSB) A standards-based technology 
that promises to provide wireless USB 2.0-level s'peed with a 
range of about 10 meters. If it succeeds, bye-bye Bluetooth. 

as we Mac addicts have 
been shouting for years, 
mere clock speed is no way 
to judge a processor's true 
effectiveness. Now that 
processors have multiple 
cores, hyper-threading 
capabilities, and insanely 
effective caching schemes, 
the proverbial cat is out 
of the proverbial bag: We 
were right, and they were 
wrong-and now they're 
admitting it.-RM 



GET EXACTLY 
THE RIGHT MEMORY 

FOR YOUR MAC ... 
FOR A FRACTION OF WHAT 

YOU'D EXPECT TO PAY! 

You know that finding just the right 

memory upgrade plays a big part in 

getting the performance you want from 

your Mac (and that upgrading your Mac's RAM 

can save you a bundle of cash compared to buying 

a new system). Now that you're ready to get your 

upgrade installed and start enjoying better 

performance, how do you figure out w ho has 

"the best deal" on Mac memory? You'll see tons 

of "lowest-price-anywhere!" deals, but really 

getting the best deal involves more than just 

price-it's also about things like compatibility, 

performance, and support. That's where Crucial 

comes in. 

Will your memory be 
COMPATIBLE with my Mac? 
Today's Macs require specific memory designed to 

exacting standards. Do you really feel 

comfortable trying to sort through a foreign

looking list of base part numbers to figure out 

which memory is right for your Mac? Our Crucial• 

Memory Advisor'" tool has approximately 594 

upgrade choices for 250 distinct Mac models. In 

just three clicks, we'll provide you with a specific, 

detailed list of compatible upgrades, 

recommended upgrades, and even the most 

popular upgrades. Your FREE memory upgrade 

advisor report w ill show you only the parts that 

we guarantee will work in your Mac, or your 

money back! 

We're ab le to do this because Crucial is a division 

of Micron, one of the world's largest memory 

manufacturers and a supplier to leading 

notebook and desktop manufacturers (OEMs). 

Micron collaborates with OEMs to develop 

memory that will perform compatibly with the 

rest of the system specifications; in fact, chances 

are good that you have Micron memory in your 

Mac right now ! 

What kind of PERFORMANCE 
can I expect? 
Whether you use your Mac as a tool for 

schoolwork or household bills, an entertainment 

center for music or movies, or as part of your job 

in image editing and design, a Crucial memory 

upgrade is a fast and easy way to prepare your 

Mac to run faster, multi-task between 

applications, and open large files. Our Memory 

Advisor tool provides you with information to 

advise you and explain the various levels of 

performance gains you can expect when you 

purchase a certain upgrade. 

Exclusive offer for 
MacAddict readers! 

Visit Crucial today, and in just three mouse clicks, get your 

memory upgrade advisor report for your specific Mac 

desktop or notebook, including specific performance recommendations, 

the most popular upgrades, and the best upgrade value for you. And, for a 

limited time, Crucial is offering Mac users a SPECIAL DISCOUNT. To find the 

right memory for your system in just seconds (and get a great deal!) visit: 

www.crucial.com/macaddict 

Will your PRICE max out my 
credit card? 
You want the assurance that your memory 

upgrade is the right match for your Mac and that 

it will be the same quality as the original 

manufacturer's parts, but you hate paying the 

premium "dealership" price. As the only 

consumer memory upgrade provider that's part 

of a major DRAM manufacturer, Crucial sells OEM

quality modules over the Internet at factory

direct prices. 

On top of that, enjoy free shipping (for a limited 

time, on orders shipped within the contiguous 

U.S.), free customer service, free tech support, and 

a free limited lifetime warranty. 

Will you SUPPORT the 
product after the sale? 
Don't worry; we won't leave you hanging if you 

need help. Our expert technical support-al/ 

"levels" of it-is always free. And our 30-day, no

risk compatibility guarantee means that if the 

memory you purchased through the Memory 

Advisor tool isn't compatible with your Mac or 

doesn 't perform as you expected, simply package 

it up and send it back. 

Crucial is the answer for Mac 
memory! 
With Mac memory from Crucial, you get premium 

quality and premium service without paying 

premium price! Crucial's user-friendly Memory 

Advisor tool and helpful customer support make 

it easy to get compatible memory for your Mac. 

Order yours today and start enjoying better 

performance for your Mac tomorrow! 

crucial® 
T E C H N 0 L 0 G Y 

A Division of Micron 

The Memory Experts'M 

C2005 Micron Technology, Inc. All rights reserved. Information is subject to chanC)e wi thout notice. Crucial Techr:iolog_y,. t.he Cruci~l logo, M.emory Advisor, and The Me~orx Experts are trademar~s/. service n:iarks 
of Micron Technology, Inc. All other trademarks are the property of their respective owners. Crucial Technology is a div1S1on of Micron Semiconductor Products, Inc., w hich 1s a wholly owned subs1d1ary of M icron 
Technology. 
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SHAREWARE PICK OF THE MONTH 

@DI www.petermaurer.de donationware 

How do you become a faster writer 
or a more efficient programmer? 

You don 't type faster; you type less. 
With Textpander, you can create textual 

shortcuts to type out long words, 
phrases, or code.-Andrew Tokuda 
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Textpander 1.0 

~( Show All J 

6 To make Textpander work, you'll need 
to create your own Snippets. Click on 

!\Enable Textpander 
f Snlppell j Preferences Updates l-

the plus button on the lower left of the 
Preference Pane to create a new snippet. 
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0 After you install Textpander, click 

'1'; MacAdd1ct 

I Content Pltlln Text 
MacAdd ict 

I the Enable Textpander check box to get 
started. There are four Snippets ready for 
use, including ttime and wwbr. Type one of 

them out in a text document and see what 
happens. 

@) In the Content box, type the text you'd 
like to create a Snippet for. We have our 
own oft-used term. 

Bug of the Month 
>»»,. '>) 

SAF AR I STICKLERS 

Sometimes surfin' with Safari results in a gnarly 

wipeout- pages won't or only partially load, or you get 
error messages. Here are a few quick fixes that may reso lve 
your Safari issues. 

CACHE Empty the Safari Cache by clicking on the Safari 
menu and selecting Empty Cache. 

HISTORY Clear the browser history (History> Clear History) . 
PREFEREN CES Delete the file com.Apple .Safari.plist, 
located in /user name/Library/Preferences. You'll lose some 
settings, but nothing important. 

ICONS Delete the Icons directory from /user name/Library/ 
Safari. The small icons known as favicons that load in the 
URL field will no longer be cached. 
COOKIES Delete site-specific cookies by going to Safari> 
Preferences, clicking t he Security tab, and selecting Show 
Cookies. Remove cookies that correspond to the sites you're 
having problems with. 

JAVA CACHES Delete your Java caches. Open the application 
Java 1.4.2 Plugin Settings located in /Applications/Utilities/ 
Java. Click the Cache tab. Click Clear. Repeat this process 
for Java 1.3.1 Plugin Settings (also located in /Applications/ 
Utilities/Java) . 

RESET Reset Safari by choosing Reset Safari from the Safari 
menu. Resetting Safari clears the history, empties the cache, 
clears the Downloads window, and removes all cookies . It 
also removes any saved user names and passwords, other 
Auto Fill data, and Google search entries . 
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0 Type out a short version of the text 

in the Abbreviation field. When you 
type this in a document, Textpander will 
replace it with the "expanded" version . 
Make sure your abbreviation isn't also a 

common word. 
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Tutpander Preferences ... 

., 

0 Your Snippets are also accessible from 
your Mac's menu bar. Notice that you can 
add abbreviations for formatted text and 

pictures, as well. 



French Italian German 

Chinese Vietnamese Russian 

Japanese 

Indonesian 

Portuguese English Spanish Farsi 
(US or UK) (Latin America or Spain) 

Award-winning software successfully used by 
U.S. State Department diplomats, Fortune 500" 
executives and millions of people worldwide. 

Step-by-step immersion instruction in all key language skill s: 

Listening - Rosetta Stone uses native speakers and 
everyday language to develop your understanding of 
the spoken language naturally and easily. 

Reading - Text exercises develop your reading 
ski lls by linking written language to real-life objects, 
actions and ideas. 

Speaking - Speech-recognition feature records, 
diagrams and compares your voice to the native 
speaker's, grading your pronunciation . 

Writing - Dictation exercises evaluate your spell ing, 
syntax and punctuation. 

" ... your program is the absolute best, bar none. I am 

shocked at how quickly I learn." 

- Michael Murphy 
Texas, USA 

"Stupendous ... the juxtaposition of text, sound and picture 

was masterful. The quality of both sound and graphics 

was first rate." 

- The Boston Globe 

Thai 

Korean 

Hindi 

Arabic 

Hebrew 

Greek 

Turkish 

Danish 

Swahili 

Polish 

Welsh 

Dutch 

Swedish 

Pashto 

Latin 

Each fully interactive course includes: 

·CD-ROM curriculum with 20 activities in each of 92 lessons 
• Previews, comprehensive exercises and testing for each lesson 
• Automated tutorials that "learn" where you need extra help 
·Curriculum Text and 45-page User's Guide 

Level 1 Program 
Regularly~ 

0 
Your Price 

$175.50 

Level 2 Program 
Regularly~ 

Your Price 

$202.50 

SAVE 
10°/o 

Personal Edition. Solutions for organizatiqns also available. 

Call today or buy online 
for a 10% discount. 

RosettaStone.com/masl 15 
1-800-399-6162 

Use promotional code masl 15 when ordering. 

Language Learning Success 



ON THE 
DISC 

EXTREME MAC 

KE OVER 
Home-improvement shows are all the rage. And why not? A new look 
and a new set of appliances can make an old house seem like a new 
one-and it's the same with your Mac. As much as we love Aqua's design 
and the Finder's handy tools, staring at the same interface and using the 
same tools day in and day out can get boring. But never fear! We're 
going to show you how to use third-party utilities to add decorations that 
are all your own; we'll also tell you how to install alternative application 
launchers, Dock replacements, and more. It's your Mac- make it look 

and work the way you want! By JohnathOn Williams 

Find most of the apps 
featured In this article 
on the Disc. 

A\\ BE CAREFUL IN THERE! 
"i.j The apps recommended in this article 

~ere safe and reliable in our testing, but 
use t_he_m with ca~tion . Some achieve their effects by 
modifying essential system files- always a risk. So 
before you proceed. make a backup. And don't say 
we didn't warn you. 
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nterior Decorating 
Appearances matter, no matter what your mom told you . These apps will help you put a new shine 

on your Mac, whether you want a complete renovation or a simple touch-up. 

Go Global 
PROJECT Replace your desktop background with a real-time 

image of the Earth . 

Earth Desk's purpose seemed silly until we installed it-and 
then spent the rest of the day mesmerized by it. This app 
replaces your desktop with a·real-time image of the Earth, 
complete with night-and-day separation and cloud coverage. 
You control the zoom and centering through the Preferences 

TOOL EarthDesk 3 
menu, allowing you to peer down on 

COMPANY Xeric 
Design (www 
.timepalette.com) 

PRICE $19.95 

a specific continent or region. See the 

REQUIREMENTS 
Mac OS 10.2 or 
later 

world as a traditional satellite image, 
or divide it into nations with political 
boundaries. Remember the globe that 
you had in your room when you were a 
kid? Earth Desk is kinda like that, only 
waaay cooler. 

Clear the Dock . 
PROJECT Change the color and placement of the Dock. 

Ah , the poor Dock. Years after its 
introduction, interface snobs and power 
users are still bashing it. Personally, we 
like it-but we like it even more when we 
use TransparentDock. This lightweight 
app's titled purpose is just the least of 
its abilities . In addition to setting a new 
background and border color (or removing 
them entirely), it can free the Dock from 
its center anchor, allowing you to position 
it almost anywhere on the screen . 

TOOL 
TransparentDock 2 

COMPANY 
Free Range Mac 
(www 
.freerangemac 
.com) 

PRICE 
$8 (donationware) 

REQUIREMENTS 
Mac OS 10.2 or 
later 

No, Save Hollywood isn't the MPAA's latest DVD-protection 
scheme-it sets a Quicklime movie as your screen saver. 

Go Hollywood 
PROJECT Set a movie as your screensaver. 

As much as we love the new RSS screen saver in Mac OS 10.4 
(Tiger), there are times when all those headlines give us a 
splitting headache. We prefer to relax by watching our favorite 
current movie trailer during those spare moments when the 
screen saver kicks in. Enter Save Hollywood, an app that 
displays QuickTime movies (complete with sound) whenever 
your screen saver activates. 

To install Save Hollywood, simply drag the unpacked screen
saver file into your / Library/ Screen Savers folder. (Alternatively, 
you can create a Screen Saver folder in /user 
name/Library and drag the file there.) Once ~~~Y~~~~e 
installed, Save Hollywood appears as an 
option in System Preferences> Desktop & 
Screen Saver. To select i he movi'e that will 
play during your Mac's downtime, click the 
Screen Saver tab, choose Save Hollywood, 
and cli ck the Options button . 

COMPANY 
White Box (http:// 
s.sudre.free.fr) 

PRICE Free 

REQUIREMENTS 
Mac OS X or later 

Like a quality rug, TransparentDock really pulls the Mac desktop together . 

... , fS'~- , ~a 9a,rl~Ui c:~J~®®~-.-e il 11m~ 
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Makeover 
Essential 
Pick a Theme 
PROJECT Give your desktop a makeover 
with new themes. 

When talking about redoing the Mac 

interface, the word theme refers to the 

collection of window bars, menu styles, 

buttons, and other items that make up 

a desktop design. The only theme most 

Mac users know is OS X's default theme, 

Aqua-and OS X only offers the meager 

choice of Blue or Graphite elements in 

System Preferences> Appearance. With 

ShapeShifter, however, the sky's the limit. 

ShapeShifter groups interface elements, 

icon sets, and desktop backgrounds into 

packages called guiKits, allowing 

theme designers to issue top-to

bottom makeovers for the Mac 

desktop. Launch it from System 

Preferences, click the Apply tab, 

and you can replace the default 

theme with any that you choose 

or download. To acquire new 

themes, simply click ShapeShifter's 

Download tab. You can also find 

more at the following sites: 

MAX THEMES 

(www.maxthemes.com) 

RESEXCELLENCE 
(www. resexcel lence.com) 

MACTHEMES 

(www.macthemes. net) 

INTERFACELIFT 

(http: //interfacelift.com) 

XTHEMES 

(www.xthemes.net) 

The Sweet Slumber theme 

includes some beautiful icons 

inspired by Alice in Wonderland, 

but buttons can be hard to find. 

You can stick to a single theme or 

mix and match parts from different 

themes-applying one theme's' icon set 

with another's interface elements, for 

example. Most 

of the themes we 

tested only made us 

appreciate Aqua's 

clarity. A few, 

though, provided a 

unique look without 

sacrificing any 

usability. 

TOOL 
ShapeShifter 2.2 

COMPANY 
Unsanity (www 
.unsanity.com) 

PRICE $20 

REQUIREMENTS 
Mac OS 10.3 or 
later 
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With WindowShade X, OS X's windows will collapse faster than an old Las Vegas casino. 

Pull the Shades 
PROJECT Bring Back OS 9's collapsible windows. 

Call us nostalgic, but there are days when we still get misty 

thinking about OS 9. One of the things we miss most is the 

ability to collapse a window by double -clicking its title bar. 

WindowShade X restores that function while adding options 

exclusive to OS X. Make collapsed windows translucent, add and 

adjust drop shadows, configure sounds to play on collapse

these ain't your mama's window shades. You can also configure 

a mouse-click combo to minimize windows in standard OS X 

fashion, giving you the best of both worlds . 

Using a screen saver as your background will keep your desktop 

moving, but the effort takes a heavy toll on slower Macs. 

Better Backgrounds 
PROJECT Replace your desktop background with a screen saver. 

Visage is a slick little app that is difficult to classify because it 

does so many things-our favorite is its ability to set a screen 

saver as your desktop background. Using Tiger's RSS Screen 

Saver, for example, allows you to check the headlines of your 
favorite news sites while you work. This convenience, however, 

is not without cost. Setting an animated screen saver as a 

desktop background is a huge drain on system resources, 

especially on less-powerful machines. Doing so on our 1GHz 

iBook G4 with 512MB of RAM made the poor little guy nigh 
unusable, and the moving text was a train wreck-halting and 

choppy. Our dual GS, on the other hand, barely blinked. 

When you're done playing with animated backgrounds, Visage 

can also change the default login and boot messages to display 
user-specified text, replace your Boot Panel (the picture that 

comes up with the progress bar during startup), and add your own 

prefix to common system messages. Like an all-in-one tool kit, it's 

very handy to have around the house ... er, around the Mac. 

TOOL 
WindowShade X 

COMPANY 
Unsanity (www 
.unsanity.com) 

PRICE $10 

REQUIREMENTS 
Mac OS 10.3 
or later (earlier 
versions available 
for 10.1 or later) 

TOOL Visage 

COMPANY 
Sanity Software 
(http://keakaj.com) 

PRICE $9.95 

REQUIREMENTS 
Mac OS 10.1 or 
later 
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Like rides at your favorite amusement park, ThemePark requires 
you to meet certain conditions before you get on board. 

Design Your Own Theme 
PROJE.CT Design and build your own unique theme. 

When you tire of canned themes (and trust us, you will) , it's 
t ime to create your own. Theme Park 2 provides all the tools 
you need to build guiKits that install through ShapeShifter. 
The application breaks down the various elements of the GUI 

Cl 

TOOL 
ThemePark 2 

COMPANY 
Geekspiff (www 
.geekspiff.com) 

PRICE $20 

REQUIREMENTS 
ShapeShifter, Mac 
OS 10.3 or later 

into categories, which then break into 
subcategories, which then ... you get the 
idea. Fair warning: Creating a theme isn't as 
easy as you might think. It requires design 
skills, moderate Photoshop abilities, and 
some knowledge of Aqua's inner workings
check the tutorial on the developer's site 
or at www.digitalramen .com/themepark 
before you get started. 

Do-It-Yourself Projects 

Save Your Soundsets 
· PROJECT Restore OS 9's soundsets to OS X. 

As important as appearances are, any decent renovation must 
consider acoustics. Xounds brings the ability to assign alert 
sounds to almost any event within OS X (another function that 
was lost in the transition from OS 9) . Supported events include 
application launches, disk ejections, and menu 
selections. You can assign the system's default 
sounds (basso, bottle, and so on) or record 
your own : Any AIFF file is fair game. Xounds 
appears as an icon in System Preferences. If you 
want some applications to run silently, simply 
add them to the list in the Exclude pane. OS 9 
loyalists can import existing soundsets, making 
their new OS X home a little more familiar. 

TOOL Xounds 

COMPANY 

Unsanity (www 

.unsanity.com) 

PRICE $10 

REQUIREMENTS 

Mac OS 10.3 or 

later 

Bl Show All ~ 

1~------11 Xounds Sounds Setup Exclude List 1-------1 

Xoundset '. Custom Xoundset • ) ( Save As... ) 

Assign sounds to these actions: (o_ f ilter Actions 

Applic•t ion Hi dden Tiniuliff (Al•n Sounds) 

Application launched Funk.ili ff' (Alen Sounds) 

Appl lm ion Quit frog.aiff IAl• rt Sounds) 

Appl ication Shown Blow.ai ff (Alen Sounds) 

Disk Ej ect Biow.aiff (Al•rt Sounds) 

' . 
Our therapist says constant reassurance is good for us-Xounds lets 
us know what our Mac is up to. 

Apple may have locked down most of the design elements in Aqua, but OS X still allows for some basic customization. Best of 

all, these changes require no third-party software, sparing both your wallet and your hard drive. 

CHANGE FILE AND MAKE THE TERMINAL 
FOLDER ICONS TRANSPARENT CHANGE YOUR STARTUP SCREEN 
You're not stuck with the Here's a sharp-looking effect Visage (see "Better on QuartzDisplay 
boring default icons for files that 's easy to create. Launch Backgrounds," p22) lets you .bundle, and choose Show 
and folders . In the Finder, the Terminal (/Applications/ replace your Boot Panel (the Package Contents from 
highlight the file with the Utilit ies/Terminal) and select image that appears with the the resulting Contextual 
icon that you want to copy Terminal> Window Settings. progress bar during startup) Menu. Open the Resources 
and select File> Get Info · From the drop-down menu, with one of your choice, but folder, find the file called 
(or press Command-I). In select Color. Move the you can also do it yourself. BootPanel.pdf, and copy it 
the resulting Info window, Transparency slider at the First, create a PDF file of the somewhere else. Rename 
highlight the image of the bottom to adjust the opacity image you want and size it it OriginalBootPanel.pdf 
icon in the top-left corner of the window. You can also appropriately (it will appear or something similar. Now 
and press Command-( to click the color-selection at whatever size you make it) . drag your new file into the 
copy it. Then, highlight t he boxes to select text colors. You can also download some Resources folder and rename 
file or folder whose icon Hint: Use a calm desktop fun Boot Panels from www it BootPanel.pdf-you'll 
you want to replace. Press picture for th is trick-trying .theapplecollection .com / have to click Authenticate in 
Command-I again, select the to read the Terminal against desktop/Startup.shtm l. the warning dialog box and 
image of its existing icon, a background of RSS feeds Then open /System/ type in your Administrator 
and press Command-V to could make your head Library /CoreServices/ password. Next time you 
paste the new icon. explode. SystemStarter, Control-click reboot, enjoy! 
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Mighty Mouse 

Show All 

Availab le Cursors 

I-Beam Wait Small Alias Big Alias Small Copy ( lmpon Cursors ... ) 

Cursor Edi tor 

Image Mask Image Ma.sk 

II ~ ll n 
Superpower Your Pointers 
PROJECT Replace your cursors and mouse pointers. 

Speed [ Fast 

Slow 

r 

' Tiny 

Current magniftcation: 1.0 x 
cursor c.a ng may b~ 
proc uo 1. ten.swe 

Once you've installed a new theme, switched icon sets, changed your desktop 
background, and modified the Dock, only one default remains: your cursor set. 
Mighty Mouse (how long until somebody gets sued , do you think?) integrates with 
ShapeShifter to apply cursor sets alongside desktop themes. 

Mighty Mouse can also apply cursor changes individually. A built-in editor allows 
you to modify the default cursors and pointers, or you can download and install those 
made by others. (ResExcellence maintains a nice collection at www.resexcellence .com .) 
Mighty Mouse can even import cursors made for Windows XP. 

Makeover Essential 

Not to be confused 

with Apple's newest 

rodent, Mighty 

Mouse lets you 

create custom 

cursor sets. 

TOOL 
Mighty Mouse 

COMPANY 
Unsanity (www 
.unsanity.com) 

PRICE $10 

REQUIREMENTS 
Mac OS 10.3 or 
later 

Sweeter System Icons Mac OS Xis happy to let you change icons 

for user-level files and folders (see "Do 

(www.pixelgirlpresents.com), or just 

Google your favorite subject plus the 

word icon. (Scrabble icons? Invader Zim 

icons? They're all out there.) Look for 

icons in I containers, which let you bring 

an entire icon set into CandyBar at once. 

PROJECT Customize your system icons. 

Iii ~ 
,--, 

101 9 I ~ I 
Oocumtnt App fo nt Alias Otlt! C! 

,--, ,--, ,.----, ,.----, ,--, 
0 I ~ Q ,• 

Ntw Folder Applic;,:ulons Computt r Documents F<ivodtu 

r=--' 

10 l'1 lo l r" l >;! 
I ~ I 

Conntcl Find Get Info Mov~s Musk 

Apple likes you changing system icons 
about as much as they liked iCon, that 

biography of Steve Jobs. Get around 

the restrictions with CandyBar, and use 

whatever icons you please. 
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It Yourself," p23), but it says "Keep out!" 

when you eye your Mac's system files. 

CandyBar 2 overrides its objections, 

making every icon in your system fair 

game. The app comes with two icon sets, 
and you can either apply these sets for a 

quick system-wide change or swap out 
icons individually. 

CandyBar also serves as a convenient, 

drag-and-drop manager for all your file and 
folder icons. We didn't realize how tedious 

the manual method for switching icons was 

until we enjoyed the simplicity of dragging 

new icons into CandyBar's icon panel. After 

a few minutes, it spoiled us rotten. 
Getting more icons is easy. You can start 

at sites like the lconfactory (www 

.iconfactory.com) or Pixelgirl Presents 

Once you start accumulating an icon 

library, you'll want to pick up Pixadex 
($18 .95, www.iconfactory.com/ 
px_home.asp), a handy " iPhoto for 

icons" application that lets you view 

all your icons, organize them into sets, 
assign them 

to particular 

functions 
(Empty and Full 

Trash icons, for 

instance), and 

export them to 

CandyBar. 

TOOL CandyBar 2 
(www.panic.com/ 
candybar) 

COMPANY Panic 

PRICE $12.95 

REQUIREMENTS 
Mac OS 10.2 or 
later 



Nuts and Bo ts 
Now that your desktop's looking good, try these function-enhancing apps for better efficiency and 

convenience. If our first collection of apps was the new decorating scheme, these are the new appliances 

System Preferences Edit View Window Help 

About This Mac 
("') Software Update ... 

• System Preferences • 
Cl Customize FrultMenu .. . 

ii Calculator 

13 Appllcauons • 

Recent Applications • 

i.:t Recent Documents • 

System Services • 

Log Out.. . {)XQ 

!!I A- Dock 

I Address Book • 
[1i1 Adobe Photoshop 7 

.;. Adobe Photoshop Elements 3 
r:J. Adobe Reader 7.0 

AOL Instant Messenger (SM) f 
~ AppleScrlpt 
[J AppleWorks 6 
D audacity- macosx-1.2.3 

• Audio Hijack Pro 

iJ Audlon 3.0.2 Free 
i:- Automator 
j' Backup 

ll Bi!Torrent 
t Butler 

• 
• 
• • • • • 
• 

We liked the Apple menu better the old way. So did a lot of people. 

Renovate the Apple Menu 
PROJECT Add appl ications, scripts, and Contextual Menus to 
the Apple menu. 

By default, OS X's Apple menu isn't good for much. Sure, it's 

where you go to Restart, Log Out, and Shut Down, but the list 
of other Apple-approved items is short. Fortunately, FruitMenu 
opens up the menu so it can display anything you like. The 
app installs as a new icon in System Preferences. Click the 

icon, then click the Apple Menu tab; existing menu items are 

TOOL FruitMenu 
COMPANY 
Unsanity (www 
.unsanity.com) 
PRICE $10 

REQUIREMENTS 
Mac OS 10.3 or 
later 

displayed on the left, and available items 

appear on the right. To add an item, simply 
drag it from the right to the left. Adding a 

folder or disk to the menu allows you to 

navigate through its contents, activating 

applications and sc ripts with a single click. 
Hot keys can be assigned to your favorite 

items, as well. 

Build Another Dock ... and Another ... 
... and Another 
PROJECT Create multiple customizable replacements for your Dock. 

Set Up a Storage Bin 
PROJECT Create a storage bin for stray files 
and folders. 

A storage bin. A junk drawer. Every house 

has that place where odds and ends, 
loose change, and stray buttons end up. 
It 's how you fight clutter without throwing 

away things you might need. Odds are 
that your Mac is even more cluttered 

than your house. For a virtual storage 
bin, check out DragThing. The app's Dock 
floats on your desktop, allowing you to 
toss files, folders, text snippets, and 
URLs into its compartments . Both the 

size and number of compartments are 
configurable, making 
it usable for both TOOL DragThing 

packrats and neat 

freaks. Preset Docks 

allow you to switch 
quickly between 
disks, folders, and 
open applications . 

COMPANYTLA 
Systems (www 
.dragthing.com) 
PRICE $29 

REQUIREMENTS 
Mac OS 10.2 or 
later 

You won't find 
your car keys in 

DragThing's Dock, 
but you might find 

that missing memo. 

This Dock alternative allows you to create multiple Dock replacements, each with its 
own set of folders and apps. Like the Dock, each WorkStrip serves as an application 
launcher and gateway to commonly used files and folders. Unlike the Dock, clicking 
on the tab beneath an icon opens a panel where you can preview files and link files to 
specific application s. Right-clicking or Control-clicking an icon displays a Contextual 
Menu with options well beyond those offered in the Dock. WorkStrip's design is 
attractive and its features well-placed , but th e sheer number of options often left us 
a little dumbfounded. Still, if you're willing to spend time learning about these many 
features, WorkStrip may be just the thing to put your desktop in order. 

TOOL WorkStrip 3 
COMPANY 
Softchaos (www 
.softchaos.com) 
PRICE £22.95 
($41 at press time) 
REQUIREMENTS 
Mac OS 10.2 or 
later 

WorkStrip takes one of the best things about the Finder-extensive file-preview features-and puts it right where you used to find your Dock. 
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Makeover Essential 
Work More Efficiently 
PROJECT Find and launch applications and files with greater speed. 

- /Applications/Sound Studio 

Sound - Preference Pane 

C} soundtrack - Genre !6 t racks l 

DJ Soundtrack - Genre {270 tracks) 
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SOUND 0 

Objective 
Development 
(www.obdev 
.at) or BlackTree 
(http://quicksilver 
.blacktree.com) 

Fri 3:30 PM 19 

Augu st 2005 

CW Su Mo Tu \flt.~ Th fr Sa 

31 1 2 3 4 5 6 

32 7 8 9 10 H 12 13 

33 14 15 16 l!. 7 18 • 20 
34 21 22 23 24 25 26 27 I 

35 28 29 30 31!. 

I 
0 0 <DOG 
To Do Ue1ns: 

! Gitt Dave to Make Sears 
Payme nt (due 5/ 16/()5) 

1 ! Go by Engl D@pL, :Sign u.p for 
Works op due 5/19/05) 

l Go o Mac. store. drool over i 4ac 
GSs 

u Post rn1'w podcast 
r1 Upciat@ iPIXll 
o ! prnp 'lonq or query to rnn ior 

mag ~- AARP? (due 5!16/'~5) 

Help your aging memory by placing this 
iCal shortcut in the menu bar. It's the virtual 
equivalent of tacking your calendar to the 
refrigerator. 

Hang Up Your Calendar 
PROJECT Add your iCal calendar to 
the menu bar. 

Out of sight, out of mind. The more we 
use iCal, the more that phrase rings true . 
iCal is great for keeping track of tasks 
and appo intments, .but it's only as useful 
as your ability to remember to open it. 
MenuCalendarClock takes care of that by 
putting your calendar and to-do items in 
the Finder's top menu bar, where you're 
more li kely to see them . Clicking on a 
day or a task will open iCal with that 
day in view. The application can even 
provide birthday 
alarms, and 
the registered 
version will read 
the birthdays 
from Address 
Book. (An 
Entourage 
version is also 
available .) 

TOOL 
MenuCalendarClock 

COMPANY Objectpark 
Software (www 
.objectpark.net) 

PRICE $18.95 for 
advanced features, free 
for basic use 

REQUIREMENTS Mac 
OS 10.1 or later 



Synergy: Controlling iTunes 
has never been easier (or better looking). 

J 
Menu·bar·ify iTunes 
PROJECT Add iTunes controls to the menu bar. 

iTunes is a constant companion for many Mac users, running in 

the background at all times. This makes switching to it when you 
want to skip a song or pause the playback a bit of a pain-not to 
mention a waste of time. Synergy adds a small control panel for 

iTunes to the menu bar; it also gives you a series of system-level 
shortcut keys for common commands, 

allowing you to control music playback 
without leaving your current app. 

Synergy can also display song and 

album information in an attractive 

translucent window at the beginning of 

each track . 

TOOL Synergy 

COMPANY 
Wincent Colaluta 
(http ://wincent.com) 

PRICE $10 

REQUIREMENTS 
Mac OS 10 .2 or later 

Synergy takes advantage of the Mac's spiffy visual effects to 
provide you with album and song information. 

Makeover Essential 

Soup Up the Dock 
PROJECT Add hot keys, folder browsing, disk access, and more to the Dock. 

A-Dock X offers to replace the standard Dock with a souped-up 

version that includes advanced Contextual Menus, assignable 

hot keys, and themes. The optional themes are eye catching, 
to put it kindly, but we suspect they'll wear on any serious 
user. The Contextual Menus and hot-key support, however, add 
a considerable amount of convenience and power. Optional 
modules add support for displaying all mounted discs, both local 
and remote, as well volumes shared through Bonjour. A simple 
Shift-click allows you to drag A-Dock X to any position on the 

edges of the screen • 

Take a Shortcut 
PROJECT Add or remove shortcut keys from any appl ication menu. 

Menu Master can make you a true keyboard ninja by assigning 
and removing shortcut keys to and from menu items in any 
Cocoa or Carbon app. After installation, find it inside of (you 
guessed it) System Preferences. Click 

its icon, then click the Application 
Settings tab. To create a new 
shortcut, highlight a menu item in the 

appropriate application , and press the 
key combo for the shortcut. That's it. 
Now go use your powers wisely. 

TOOL Menu Master 

COMPANY Unsanity 
(www. unsanity.com) 

PRICE $ 1.0 

REQUIREMENTS 
Mac OS 10.2 or later 

e 0 0 Menu Master ~ 

~I Show All l ra:--
Menu Master I• Application Settings 1 Exclude li st 

App lication : ' ;ii Mail (/Applications/ Mail.app) 

Changes will ta ke effect next time you launch the a pplication -Mail 

Me.nu Item 

New Smart Mailbox Folder . .. 

Your keyboard fu is strong, Grasshopper, 
but it will be stronger with Menu Master. 

Original Shortcut 
None 

TOOL A-Dock x 
COMPANY The Tijej 
House (http ://jerome 
. toucher. free. fr) 

PRICE $10 

REQUIREMENTS 
Mac OS 10.2 or later 

To install A-Dock X, simply drag it into your Applications 
folder and double-click its icon. Once your new A-Dock appears, 

Control-Shift-click it to access the Preferences and Themes 
menus or to quit. To prevent your regular Dock from getting in 

the way of your spiffy new one, go to System Preferences > Dock, 
select a different screen position, and check Automatically Hide 

And Show The Dock. 

Despite the flames, the A-Dock X's themes aren't so hot-but 
you'll love its added power and convenience. 

• .rt::,. Johnathon Williams has made over his desktop so many times that it 's start ing to look like Michael Jackson. Find out more about him at www 
~ .johnathonwilliams.com. 

November 2005 MacAddict 27 



100's of Prices~! Call or visit macmall.com! 

The NEW iPod nano 
Even though the iPod® nano is 1/5 the size of the original iPod, it still packs incredible 
audio fidelity into a sleek and eye-catching design that's as thin as a pencil! It weighs 
just 1.5 ounces but holds up to 1,000 of your favorite songs or thousands of photos! 

NEW! iPod nano startingat$194f 
The coolest iPod accessories! 

Mac® mini G4 
up to 1.42GHz 
Up to 256MB SDRAM; exp. to 1 GB 
Up to 80GB Serial ATA hard drive 
Combo Drive (DVD/CD-RW) or 
SuperDrive (DVD±R/CD-RW) 
10/1 OOBT Ethernet networking 
Optional AirPort• + Bluetooth 2.0 

starting at 

$494! 

eMac·M G4 
up to 1.42GHz 
17" built-in display (16" vis.) 
Up to 512MB SDRAM; exp. to 1 E 
Up to 160GB Serial ATA hard dri1 
Combo Drive (DVD/CD-RW) or 
SuperDrive (DVD±R/CO-RW) 

starting at 

$794! 
Finance for as low as 520/mo 

' WE'LL BEAT ANY PRICE or competitive promotion on any App~ computer. We may require pioof of dea~r"s pncing.Com· 
petitor must be an Apple Autholized Res~ler.Product mU<t be in Siad< at the competition.Advertised hem must be identical 
to theoneoffmd by Mac/&11 and must be a,,.,., nem in a faaory sea~ box. We reserve the right to limit quantityordeled 
This offer does not apply to special bonus or rr .. offers, grand openings, special purchases or special bU)'I, manufacturers 
rebates, closeouts, clearances, m to dea!m' on.-ol..rkind m other limned quantity offers. Nor does r. app!J to a<i~ong 
erTOll made by any authorized dealer.Not open to dealers. Void where prohibited Sooy, offer not valid in conjunction ~~h 
other rebate offeii.On multipleitem quote>"We'll ile•t Any Price' appfres to the price of the entire order, not individual line 

The hottest software deals! 



Nm INSTANT 
Iii SAVINGS! 

Save even more 
than our advertised 
price by shopping 
online or calling. 
Prices are too low 

to advertise! 
Look for the shopping cart symbol 

for models that quality. 

·----~-- --
~f 
li\''~"·'''l'.iA:~·' ,,. 

r.-im~~~~ .. n 

iBook® G4 iMac® G5 
up to 1.4GHz up to 2GHz! 
512MB SDRAM; exp. to 1.5GB Up to 512MB SDRAM; exp. to 2GB 
Up to 60GB ATA/100 hard disk drive Up to 250GB Serial ATA hard drive 
Combo Drive (DVDICD-RW) or Combo Drive (DVD/CD-RW) or 
SuperDrive (DVD±R/CD-RW) SuperDrive (DVD±R/CD-RW) 
AirPort® Extreme + Bluetooth 2.0 AirPort® Extreme + Bluetooth 2.0 

starting at starting at 

$994! $1,294! 
Finance for as low as 520/mo Rnance for as low as s39/mo 

ti Authorized Reseller 

PowerBook® G4 Power Mac® G5 
up to 1.67GHz up to 2. ?GHz! 
512MB SDRAM; exp. to 1.25GB PowerPC GS dual processors 
Up to 100GB Ultra ATA hard drive 512MB DOR RAM; expandable to BGB 
Combo Drive (DVD/CD-RW) or Up to 250GB Serial ATA hard disk drive 
SuperDrive (DVD±R/CD-RW) 16X Dual Layer SuperDrive '" 
AirPort® Extreme + Bluetooth 2.0 Gigabit Ethernet networking 

starting at starting at 

$1,494! $1,994! 
Finance for as low as 545/mo Finance for as low as 560/mo 

nenl>Offur applies ID pre-taxed price< only.Offer valid on~ at time of purchas~not afterthefa<t. tfREE RAM OffER·fREE up to !GB totll pr>mium RAM for your eMacor iMac after MacMall mail·in rebate. This offer is for a branded 512MB memory module. Toti! RAM stated Is based on 
innial RAM configuration of eMac or iMac + the 512MB upgrade.A $39.99 installation fee is required. Price of RAM before rebate is $65. FREE up to 1.SGB total premium RAM for yOtJr Pow<r Mac. This offer is for a branded !GB memory module. Total RAM stated is based on initial RAM 
configuration of PO\"'r Mac+ the !GB upgrade.A $39.99 installation fee is required.Price of RAM before rebate is $119.FREE up to 1.5GB total premium RAM for your PowerBook or iBook. This offe> Is for a branded !GB memory module. Total RAM stated is based on initial RAM con· 
figuration of PowerBook or iBook +the !GB upgrade.A $39.99 instal~tion fee is required.Price ofRAM before rebates is $179.All RAM offers end 10131105. FREE PRINTER OffER·Epson CX4600 All·in·One printer is free after 129 MacMall mail·in rebate and $20 and $50 Epson mail·in 
rebates with purchase of any Apple Computer through 10/31105. Price before rebate is $99. FREE ENGRAVING OFFER-Get your iPod or iPod mini engraved for FREE when you purchase it through MacMall. Not 3'•ilable for iPod shuftle or Ul iPod.Place your order now, then ~sit 
1wmmaanall.com for detail< FREE FM TRANSMITTER OFFER-Mer $19.99 MacMall maiHn rebate.Price before rebate is $19.99. Ends 11/JOi05. All OFFERS VALID WHILE SUPPLIES LAST. 00\vnload rebate coupons atwwwmacmall.com/rebates. 

The best selection of displays and accessories! 

Call MacMall today 
1-800-965-3282 
Source Code: MACADDICT 



Put your Mac to work answering 
phones, taking messages-

even calling your dear ol' mom. 
By Cathy Lu 

our Mac is the center of your work life, your creative world, and 

maybe even your home entertainment system. So why not make it 

your communication center as well? 
Sure, you already use your machine for email and instant 

messaging-maybe even video chatting. But there's a world of technology 

out there that can connect your Mac to your telephone system, too. 
Telephone-messaging software lets you use your Mac as your 
own private answering service, while Voice over IP 

(VoIP) technology can replace some of your 
current phone services entirely. And with 
cell-phone text messaging on the rise, you 

can even use your Mac to send quick notes 
to mobile phones. The best part? You can do 
it all for less than what a phone company-or 
a receptionist-would charge. 



Good 
Morning! 

While you were out 

•you received 
16 calls. 

•you got 12 
messages. 

Illustrations by Oliver Wolfson 

ON THE 
DISC 

Amadeus II 3.8.4 
Gizmo 1.0.0.55 
Skype 1.0.0.24 
SMS Mac plug-in 1.0.1 
SMS Mac widget 1.1 
smsZap 1.0.1 

If you work out of a home office but 
have neither the space nor the money 
to hire a personal assistant, here's an 

easy solution: Put your Mac on the job. 

The 411 Answering mach.ines ar~ adequate if 
your needs are s1mple-1ust a way for 

people to let you know they've called. But what if you need 
more? With telephone-messaging software, your Mac is able 

to log calls, record and save messages, handle multiple voice 
mailboxes, and even forward messages via email. You can also 

use it to record calls while you're talking, giving you a way to, 
for example, capture "Is your refrigerator running?" pranks for 

podcasts. 
In addition to software, you also need to connect your Mac to your 

telephone with an adapter (included with the software mentioned in 

"The Tools" below). The adapter connects to a phone jack on one end 
and your Mac's USB port on the other. You may need a splitter for your 
wall jack to accommodate both your phone line and the adapter, and if 

you have DSL, you'll have to do a bit more finagling-just plug another 
splitter into the phone-jack part of the adapter, with one line going to 

your DSL line through a DSL filter and the other going to the regular 
phone line. From there, you're ready to roll. 

The liools Of the t~o contenders for ~ac t~lephone
messaging software, the first will have 

you up and running before you can finish your morning coffee, while 

the second might take a few refills. 

PhoneValet PhoneValet ($199.95, www.parliant.com) is the 

receptionist who files all of your papers, organizes your morning 
messages, and makes the perfect, steaming pot of coffee before you 
come in. It's a powerful, easy-to-use app that takes care of all your 

telephone-messaging needs. 
The main PhoneValet window features two tabs: Phone book and 

Call Log. Phonebook stores all your contacts and even dials the 
numbers for you-just double-click the contact, then pick up the 

phone to complete the call. PhoneValet can also dial from Address 
Book, any app that supports Services (such as Safari), and even 
Entourage via the 

f"I Q 8 Phont Valet 

AppleScript menu . If.~~";;~~. liT.~~l~~--~----~ir.i~~;a.==:::.::; 
Whenever you make 
or receive a call, 
PhoneValet keeps 
track of it in the 
Call Log pane. If 
you have Caller ID, 
PhoneValet records 
the caller's name or 

phone number. 

DI.al Ott.a ib Oelt lt Add Number 

Unt""Numbtr N~mt 
1 - (100l4 :U - 9792 

l 16006611433663 

1 llOOJ 2<1 7- 2676 
I (8001463- 3339 

·' !866)U0- 120<I 

Record Rtpott 

St11 rt " DYr<ttlon TVpe Nott Mso M.lllt 
l :OS rM 17-Aug- 05 00:0 p 
1!08 PM 17- Aug-05 00:15 P 

l2;S9 PM I 7- Au9-0 00:14 M 
11!06 AM 17- Auo -o Ol :SS p 

11:02 AM 11-Aug ·O 01:50 
10:32 AM 17-Aug-O 24:<14 

The Call Log shows you all the action your 
telephone's been getting. 
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PhoneValet (continued) 
Of course, one of the app's main goals is to replace your trusty old answering machine. To set up voice mail, 

go to PhoneValet > Preferences> Voice Mail, and enable the Default mailbox. If you want to set up multiple 
voice-mail accounts, enable any of the other mailboxes (0 through 9), then create greeting messages for your 
mailboxes by pressing the Set button in the Voice Mail Preferences window. You can either use the default 

greeting (boring), write a script that's recited by one of Apple's built-in voices (creepy), or create your own 

AppleScript Se tup 

Copy Ap pleScripts Into the specified fo lders 
using the Finder, the.n enable them here. 

Voice Mail Preferences 

~ Enable Voice Mail 

--{ CallerlD Recording ' Voice Mai l ~ Hook Statu< j-
Maln Greeting: ~ recorded from microphone 

message (possibly creepy). lfyou 

choose the latter, you can record a 
new message or pick a sound file 

to import. 
If someone's left you a voice 

Hook status scri pts run twice: when the first local phone is 
picked up and when the last phone has hung up. 

Choices for u .llcr or caller doe:sn't selca then choke #- is assumed, if en.a.bled) 
mail, you'll see a cassette-tape icon 
in the Message column of the Call 
Log window. You'll find a player for 
your messages in the details drawer 

atthe side of the window. You 

Folder: / Library/ Application Support/ Parliant/ AppleScripts/HookStaws . Dig it .Name 
~~u1t 
O o 

--2:!'!>·--:1 ';:;i;:;J1~scmrt"m'nN•mm[• :::::::::::::::::::::.....:::::::::~ 1 

' ~ ITuncsPausc.scpt I WI 

MJ.!!box : 
MJilbOJo: ;-

l51l 2 llox 2 Mailbox 

PhoneValet comes with several AppleScripts 
already installed, including one for pausing 

0 3 Mailbox 

You can enable different mailboxes in Voice Mail 
can also get your messages from 
the PhoneValet Message Center, 

iTunes when a call comes in. Preferences. a separate window that only lists 

( 

voice-mail messages. 
Other cool tricks : PhoneValet can notify you of calls by email and even attach messages (see "Set the 

Right Format," below), as well as record conversations while they're going on . Those of you with Caller ID 
can even create unique profiles for different people, to, say, create a custom greeting for a certain caller. 

Phlink If PhoneValet is the superstar assistant, then Phlink ($149.95, www.ovolab.com) is the 

frazzled receptionist that works cheaper but needs lots of attention and training. Ph link does most of what 
PhoneValet does-it logs phone calls, greets callers, records voice mail, and emails messages. But while the 

app looks simple on the surface, it harnesses a lot of its power through AppleScript and other behind-the

scenes trickery. 

unknown~: : ="="'=OS=l=:lO=PM=========== ~ 00:)2 L- ., 
~ r-:~~::;::~::;:;:;~. M~~~·~'.~~~~.~;.~~Mt:-::::~'."".'l 

~ veiludav. 7:35:57 PM 

!it yUltrday, 8:29;16PM 

:J vutud;iy, 9:S8 .00 PM 

Ph link's main window-the Call Log-features a list of all incoming calls (but 
unlike PhoneValet, it doesn't have an address book for dialing calls straight 
from the app). Double-clicking a call plays a message. The Note pane lets you 
add comments about a call while the Call Lists pane on the left lets you sort 

'!) ~s!trday, l O:OS:SlPM 

:J ytstCfdl'(, 10:14 :0~ PM 

:J yuttrd<1y. 10 :22.08 PM 

~ todll'f,1J :21:48A.\1 

~ 1oday. 12:53 :0 1 PM 
~ iod.iv.1 :27:41 PM 
':J 1oday, 1:29: 16PM 

~ tod.:iy, l :JS:52PM 

:J r.od:w, l :l6:09PM 

9 ~ today, 3:19.32 PM 
!) 1od;iy, l :2.C:l91'M 
'!) today, l :25:18PM 

0 J today,l :26:HPM 

unknown 

1.111.lrncwn 
u11lmown 

1mlrnoun 
unknown 

untnown 
unknown 

1JJ1known 

. 

::: calls by different parameters, such as Missed Calls or Today's Calls. You can 

even create your own call lists with different parameters, such as a particular 
set of dates or call duration-sort of like playlists in iTunes. 

But here's the problem: While you can do a fair amount of setup in the app's 

Preferences windows, you have to go outside of Ph link to do the rest. For 
instance, to customize your greeting, you have to create your own text or sound 
file. So to create a message for one of Apple's default voices to read, you· have 

Ph link's Call Log window is a straightforward list of all 
to type the greeting into TextEdit and then store the file in the Ph link Items 
folder. To record your own message, you'll need to buy a third-party app that 
can record audio, such as Amadeus II ($30, on the Disc or download from www your incoming phone calls. 

Ovolab Phlink 

0:07 oool 
.hairersoft.com/amadeus. html) . 

The app offers a lot of advanced functions, but they involve AppleScript. 
You can write your own scripts, or if you don't know how, Ovolab's site 
offers a wealth of downloadable scripts for remotely retrieving voice 
mail, setting up multiple mailboxes, and dialing in for weather 
forecasts. But not having these as basic built-in functions is a pain. 

Ph link's status window floats on your desktop and 

lets you control rec::rd:i:ng~----------:~~~~~~~~--~-------........... __ options. 

Set the Right Format 
Both PhoneValet and Phlink let you choose an audio format for recordings. While they offer options 

like AAC and WAV (Phlink also offers AIFF and QuickTime), for simple voice mails, there's no reason to aim high. 
Choose 3GPP: This format offers the smallest file sizes without notably decreasing the quality of voice messages. 

You may, however, want to use a higher-quality format such as WAV when recording phone 
conversations for podcasts or radio broadcasts. 
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Text messaging is a great way to communicate when you don't feel 
like conversing or when you're in a coffee shop where it's too loud (or 

obnoxious) to talk. But typing out messages on your cell's numeric keypad 
can tie your fingers in knots. Type them on your Mac instead. 

The 411 SMS (Short Message Service, aka text messaging) is a cell-phone feature that lets you send 
and receive 160-character text messages. Because messages go directly to a cell phone, 

SMS can be more immediate than sending email, especially if your recipient is away from his or her computer. 

Sending SMS messages from your Mac offers several advantages (though, obviously, mobility isn't one 
of them) . First, you don't have to type on a keypad designed to punch in numbers. Also, if you come across a 
URL, headline, or section of email you want to send, you can simply copy and paste it into your message. 

The liools From third-party software to tools already built into Mac OS X, there are several 
ways to send text messages from your Mac to a cell phone. 

tnstant Vessage. 

iChat Need to dash off a quick reminder to yourself? Send a friendly hello to a buddy? Tell your spouse to 

remember to pick up a pineapple? iChat provides a quick and easy way to send an SMS message. 

Enler the address or che person to invite. 

Open iChat, go to File > New Chat With Person, and a new Instant Message window will 
appear with a field for the name of your invitee. But you don't have to enter an iChat user 

name-you can instead enter a mobile number. Just make sure you add +1 before the phone 
number and omit the dashes (+14445551212, for example) . One caveat: iChat SMS only works 
with U.S. phone numbers- so forget texting that friend in Swaziland. 

+155 ';5473405 

After that, all you'll see is a regular chat window-but whatever you type into the text field gets 

Start a new chat window and enter sent to that phone number as a text message. If the recipient replies, the response appears in 

your recipient's mobile number. your iChat window as if it 's a regular IM session . 

SMS Mac If you need to do heavy-duty text messaging, you might want 

to try a third-party app such as SMS Mac ($15 for first year plus 50 SMS 
messages, $10 per year afterward; on the Disc or download from www 
.smsmac.com) . The initial cost includes 50 messages, and you can 

Because SMS messages are 
limited to 160 characters (and also 

because typing out words with a phone's 
numeric keypad is a drag), regular SMSers purchase another 100 for $10-10 cents per message. The beauty 

of SMS Mac (and the big advantage over messaging through iChat) 
is that it works seamlessly with Address Book. Just open Address 
Book, click and hold the Mobile label next to any mobile phone 
number, and in the menu that appears, select Send SMS To name. An 

SMS Mac window appears. 
The first time you use SMS Mac, click the Configure button. Click 

the Account tab and enter your PIN-this ensures that you receive your 

Send SM S 1.0 Uthy Lu 

!::! FlnhSNS f!!l copy1omt ~ Allow longmtJl~u 

SO-message allotment. 
Under Country Code, 
check the Add Default 

have developed a system of abbreviations and 
shorthand to keep character count to a minimum. 

One advantage to sending messages from your 
Mac is that you have access to online translators, 
such as those at www.lingo2word 
.com/translate.php and www 

.transl8it.com. They'll help you 
say a lot in a small space

or rather, they' ll hip U sA 
a lot n a sml spAc. 

He.y let's mtet tonight at 7:30. Do you ful like sushi or Ethiopian? ;-) Country Code box and choose 

SMS Mac is so invisible you 
won't even know it's there 
until you click the Mobile 
label in Address Book. 

SMS Mac automatically counts down the 
number of characters you have left (160 
maximum) as you type your SMS message. 

your country from the pull-down menu. 
Now you ' re ready to text . In SMS Mac's main 

window, type out your message, then click the Send 
SMS button and your message is en route. Tiger 
users can also download an SMS Mac 
Dashboard widget to chat away. 



ID Yourself 

smsZap 1fyou wantto 
send SMS messages straight 

When you send an SMS from your Mac, you'll have to let rec ipients know who you are, 
since messages are not tagged with identifying info. You can do this by signing 

your name or including a reply-to number (using the format Reply To: your 
mobile number). If you're using smsZap, you'll have to do this for every 

message. With SMS Mac, the Signature feature lets you create 
a sign-off that gets appended to every message. 

from Safari, Mail, or Entourage (or ·,~~----···· 
any app that supports Apple's Services), . 
you'll want to check out smsZap (free, on the Disc or 
download from www.smszap.com). Even though the app is free, you'll have to prepay for a certain number 

of credits-for instance, 500 credits costs $25.62. In the U.S., each SMS messages eats up three credits, but 

smsZap is a standalone application, but it 

links to Address Book for quick access to 

phone numbers. 

~"~"'""' -~ ..... ~· · ~1- "'"' 
Att<101\.!an 11-.°""""! 
h""nl"'l!• I OIWUI~ . • 

smsZap lets you send text from 

Safari-just highlight the text, 

then select Safari >Services > 

Send As SMS Text Message. 

the amount is different for each country. 
smsZap works similarly to SMS Mac-only it runs 

as its own separate app rather than as an add-on to 
Address Book. It does, however, feature an Address 

Book button in its interface so you can access any of 
your contacts from within the app. 

Say you're using Safari, and you run across a great 
headline or the address for a restaurant. Simply 

highlight the text, and go to Safari >Services> Send As 
SMS Text Message. A window pops up asking whether 

you wish to send the text to your phone or another 
number. Clicking either option brings up the smsZap 
window, where you can tweak your message. 

Unless you've been living iri a remote Siberian village for the past year, 
you've heard of VoIP (Voice over Internet Protocol) . This up-and-coming 
technology lets you make voice calls over the Internet rather than over 

traditional phone lines. 

The 411 Think of VoIP as the Taco Bell of telephony: It's a supercheap way to make long
distance calls, costing anywhere from nothing to a couple of cents per minute, even for 

international connections. But there are other advantages. You can get a phone number with just about any 
area code, no matter where you live; you can get voice mails sent to your email; and you can easily record 
conversations as a digital file. 

Of course, there are disadvantages, as well. In order to receive or make phone calls, your Mac has to be 
running-meaning that if your Mac, VoIP software, or the Internet crashes (or the power goes out), so does 
your phone. And while the FCC has mandated that VoIP providers find a way to give their customers full access 
to 911 services by the end of November, some providers are asking for more time-and until that's settled, it's 
possible that the emergency operator you get (if you get one at all) won't be able to see your address. 

There are several ways to make VoIP calls-you can buy a dedicated IP phone or an adapter that turns 
your regular telephone into an Internet-connected phone. But if you have a Mac-and we're assuming you 
do because you're, uh, reading MacAddict-all you need is VoIP software, a speaker (or headphones), and a 
microphone. Once you have those, you'll be halfway home to phoning home. 

The liools Softphone applications allow your Mac to operate as a phone using VoIP technology. 
We looked at two popular softphone clients for the Mac: Skype and Gizmo Project. 

Others include Eyebeam ($60, www.xten .com) and Sjphone (free, www.sjlabs.com) . 



Skype Started by the founders of Kazaa, Skype (free, on the Disc or download from www.skype.com) 
provides a user-friendly interface for placing Internet-based phone calls . 

Here's how it works : Downloading the Skype client lets you place free phone calls to other Skype users. 
But to call a land line or cell phone, you need to purchase SkypeOut credit, which is sold in increments of €10 
(roughly $12 at press time) . Phone rates vary by location, but to call a landline in, say, the U.S. or Britain, it 
costs €0.017 a minute (about 2 cents) . If you want people to be able to call you from a regular phone, you 

also need to subscribe to Skypeln (€10, or roughly $12, for a three-month subscription), which gains you a 
phone number (with just about any area code you choose) and voice mail. 

Skype's interface is as easy to use as IM software (and in fact, it has a chat function built in) . But first, you ' ll 

ril Frank O'Connor Is calling . X 

have to do a bit of setup. To start, you'll want to alter your Privacy settings; change Allow Calls 
From to either Only People From My Contacts or Only People Whom I Have Authorized; do the 
same for Allow Instant Messages From. That is, unless you like getting messages from random 

dudes in Turkey. Next , set the Output and Audio Input sources to whatever hardware you're 
using. (See "Get the Right Chat Gear" below for more info.) 

~ C' Answe r :::. Rejec t 

When you receive a phone call, 
Skype tells you who's calling and To add contacts, click the Add button in the toolbar and enter someone's Skype name or 

phone number (you can also do a search for someone if you don't know his or her Skype name), 
or import the info from Address Book. And remember to format phone numbers correctly- for 

;;' the U.S., you'll need to include a +1 before the area code. 

gives you the option to answer. 

9 6 fianltO'C'oMot l hi 

To make a phone call, double-click a name, or 

enter a number in the field at the bottom of the 
window and click the green Call button . A Calls 

drawer slides out from the main window, displaying 
the call status and the profile of the other person . 
The triangle located next to the person's name gives 

you access to options such as Hold, Mute, Hang Up, 

and Send IM. And don't overlook the double arrow at 

Allow utts ff orn.; 
0 Anyont 

onty ptoplt rtom my Col'IUtu 
0 Only l)tOplt whom I tav1 a.uthoilud 

Allow Instant muu.gu from: c .. ,. .. 
€} OT'lly l'ltOplt h om my COt'll&cts 
0 0n1y people whom I hivt 11uthoriUd uo .iatt 

Skype includes an instant
messaging feature, in case you don't 
feel like using your voice. 

the top of the main window, which lets you set up a 
conference call for up to 50 people (as of version 1.3; 
previous versions only allowed five). 

Proceed quickly to the Privacy settings to 
prevent random, bored people from trying 
to befriend you. 

Gizmo Project In terms of basic functionality, Gizmo (free, on the Disc or download from www 
.gizmoproject.com) works similarly to Skype. But behind th e scenes, they're as different as AIM and MSN. 
While Skype operates on a closed network, Gizmo Project is based on SIP, an open, standards-based 
network. That means t hat unlike Skype, Gizmo lets you talk for free with non-Gizmo users as long as they're 

also on a SIP-based voice network-Eyebeam or Sjphone, for example. 
As with Skype, you'll have to buy Call Out credit if you want to call landlines and mobiles. Credit is available 

in $10 or $20 increments. lf you're calling within the U.S., rates start at 1.8 cents per minute. For Call In service, 
which gets you your own phone number, you'll have to pony up $5 a month. 

One great thing Gizmo does offer is free voice mail. If you are unable to answer a call-or 
you don't feel li ke ch atting-callers can leave you messages that get delivered 

straight to your email as WAV files. 
~.::::. •• .,. Gizmo has other cool featu res that are missing from Skype. For one, it plays 
a..i o~· G-... 

Now 
calling 
your 

friend in 
Austrs/is
for free! 

--~-~· music when you put a call on hold-and you can actually choose between several 

~"-------"~- -~C'_·~_·_·~_··-~ options, including Funky 70s and Piano Happy (select Gizmo Project> Preferences, 
Gizmo offers easily accessible 
record, mute, and hold buttons
and even customizable hold music. 

Status 

Title: working 

su.1e: ! O Away Jj: I 

Message: 

I .am hard .it workl ] 

go to the Sounds window, and click the Call Hold Music tab) . Gizmo also features 
the ability to record calls, which is useful for interviews, pod casts, or basic 
blackmail. Just click the Rec button at the top of the call-details drawer (which 
slides out when you're on a call), and Gizmo records the whole conversation. 

Get the 
Right Chat Gear 

In order to use your Mac as a telephone, you 
need to hear and be heard- which means you need 

a mic and speaker. An iSight and a pair of iPod earbuds 
work just fine, but a USB headset provides better-quality 

sound, ridding conversations of echo and background noise. We tried 
Click the Status tab in Gizmo's 
Preferences to customize your 
own status messages. 

out two and both sounded great: GN Netcom's comfy GN 503USB ($59.99, www. 
gnnetcom.com) and Plantronics' wireless CS50-USB ($299.99, www.plantronics.com). 

,~ Cathy Lu is 
~ a MacAddict 

contributing editor and 
former features editor. 

Just when she thought 
email and IM meant she'd 

never have to speak 
again , Vo IP came along 

and ruined everythin g. 



iTunes Alternatives 
~Y Logan Kugler 

-M ost ~ac addicts d~n't lo?k further th~n the. iTune.s ~usic Store when buying music o~line. But 
1 despite how great 1TMS 1s, there are times when 1t iust doesn't offer what you're looking for. 
And unfortunately, most of the other well-known o·nline music stores are tied to Microsoft's copy
protection scheme and won't work with your Mac. But that doesn't mean you're stuck. Other Mac
compatible on line music stores-good ones-are waiting to accept your music dollars. 

.. AUDIO LUNCHBOX 

STANDARD PRICE: $0.99 per song, $9.99 per album 

FORMATS: 192-Kbps VBR MP3~ Q6,Qgg Vorbis 

TYPICAL BANDS: i-94, Nickel Creek, Pennywise 

METHODS OF PAYMENT: Credit card, PayPal, Audio Lunchbox Lunchcard 

With a focus on independent artists, Audio Lunch box jsthe 

iTunes of indi~ music . All the songs come DRM-free an:d are 1 · 

offered in your choice of two formats-192-Kbps VBR (Variable 
Bit Rate) MP3 and Q6 Ogg Vorbis. (Note that iTunes won't' play 

BLEEP 
STANDARD PRICE: $1.35 per song 

FORMAT: VBR MP3 

TYPICAL BANDS: Circlesquare,.Field Music, Bjork 

METHODS o~ PAYMENT: Credit card, PayPal l 
Bleep specializes in e.lectronic and alternative music and offers · 

a widely diverse catalog from labels such as Rough Trade, Planet 

Mu, and C~icks on Speed. You ca~_ hear a 30-second preview of 

EMUSIC 
www.emusic.com 

eee m USIC • ~ ·11) 

i I 

STANDARD PRICE: $9.99 to $19.99 
per month 

FORMAT: VBR MP3 ••• TY_PICAL BANDS: Coldplay, Harry 
Nilsson, Frank Sinatra, The Decemberists, The Pixies 

METHODS OF PAYMENT: Credit card, gift subscription 
Taking an a-pp roach much different from that of other music 

sto res , eMusic uses a monthly subscription model-but one 

that lets you keep the songs you download. The Basic plan 

($9.99) gets you up to 40 downloads per month; the Plus plan 

($14.99) lets-you have 65; and the Premium option ($19.99) 

gives you up to 90 . 
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Ogg Vorbis without a QuickTime plug-in such as the one you can 

- download from www.illadvised.com/- jordy; unfortunately, the 

ones we found didn't work with QuickTime 7) . If you're a little low 

on cash, yo,u can add your favorite songs to a Wishlist that you 

can then send to your well-heeled relatives and friends. 

Navigating AL is effortless: Using drop-down menus, select 

the first letter of the artist or album you're looking for, o_r choose 

the nam·e of a genre to get a list of everything matching your 

search . One of the coolest features is the Change Your Download 

Settings option, which lets you control exactly how you want 

your tracks to be named, from whether the name includes the 
album title to what ch'aracters s·eparate the words. AL recently 

added the Audio Lunchbox Community, a message board where 

you can talk with other music buffs. 

any song through a built-in music player that works quite well. 

As you choose songs, an invoice on the right side of the screen 

autohiatically updates to show your total cost, total megabytes 

in your shopping cart, and estimated download time. 

The songs are DRM free, ~o you can play them on any 

·digital-audio player that accepts MP3 files. ~he sound quality 
is superb, though yoJ pa'y for the quality with large.file sizes, 

averaging 1.SMB to 2MB per minute of song. While the per-

. song cost is high, the shopping interface is µser-friendly and 

' straightforward . 

This store feels more like a community of music enthusiasts 

than :simply a place to buy music because of features such as 
Neighbors, which gives you a list of fellow eMusic members 

with musical tastes similar to yours. You can chat with your 

Neighbors and find out what other types of music they're into. 

.You can also post your own reviews and ratings of any artist or 

album for others to see. 

O_ther ways eMusic helps you find good music include 
PowerCharts showing the day's, week's, and month's top 
downloads; Editor's Picks; and a list of tunes with the highest 

· member ratings. There's even a collect ion of live recorded 

music, unavailable elsewhere, called eMusic Live. With a 

catalog of more than 600,000 tracks, and more added each 

week, eMusic is enough to make the subscription model 
suddenly look like a great idea. 



LIVEDOWNLOADS 
www.livedownloads.com 

STANDARD PRICE: $7.95 to 
$12.95 per album or show 

'-IVE:>OWOLOA:>S FORMATS: 128-Kpbs 

------------ MP3, FLAG 
TYPICAL BANDS: Armored Saint, Fates Warning, The String Cheese Incident 
METHOD OF PAYMENT: Credit card 
LiveDownloads' selection is feeble by comparison to the other 
stores, but it carries stuff you won't find anywhere else. More 
than half of the site 's catalog consists of live shows, often 

MP3 TUNES 
www.mp3tunes.com 

MP3~ 
STANDARD PRICE: $0.88 per song, 
$8.88 per album 
FORMAT: 192-Kbps VBR MP3 
TYPICAL BANDS: The Tokens, Amir 

METHOD OF PAYMENT: Credit card 
The MP3 Tunes home page represents the store well
straightforward and unpretent ious-and with Top Songs and Top 
Albums on the right and Genres on the left, it's. easy to navigate. 
Founded by the former CEO of MP3.com, MP3 Tunes focuses on 

WORDS, N01i MUSIC 
From comedy to documentaries, audioVille (www.audioville. 
co.uk) is a great resource for nonmusical audio. The site's British
oriented catalog of MP3s offers all sorts of aural pleasures, from 
Blackadder episodes to Martin Luther King's "I Have a Dream" 
speech to readings of The Jungle Book. With prices like £0.49 

DeHnlleArtlcle 

Author: Eddle luard 
Pubi5hM: l aughing Stock Produ<:tSon1 

Eckf«t lzzard is the UK's mo!lt succe.ssful stand up comic 
of the last decaae, ilOd he is .mo currend'f 1.aJcing the 
Amcrkan marVet by swm. Few Brltlsh stand up r.orr.ics 
have made ttlis &i;tnlflt'ant breaklhrough, whtch says a Sol 
for Eddie's groundbreakhg bot urwersatj aecr.; slbto 
comody. 

Looking for a little Eddie Izzard? Head to audioVilte. 

(about 60 
cents at press 
time) for a 
15-minute 
relaxation 
track, how can 
you go wrong? 

NEED SUGGESTIONS? 

available for download within 48 hours of the actual concert. 
Want last week's Widespread Panic show? How about a 1997 
Doc Watson and David Grisman collaboration? Live Downloads is 
the place to go. 

Shows and albums are available as MP3s or, for a couple 
bucks more, in the high-quality, lossless FLAC (Free Lossless 
Audio Codec) format-to listen to these, though, you'll need to 
download a FLAC decoder such as FLACer or xACT-both are 
free and available at www.versiontracker.com. You can also 
buy some of the live shows on a physical CD for $23 or so; or, 
if you're planning to burn a CD yourself, you can download a 
predesigned CD label, booklet, and tray insert to print at home. 

emerging artists and boasts nearly 400,000 songs by more than 
50,000 performers. The songs come in unprotected (ORM-free) 
form, so you can play them on virtually any digital-audio player. 

The staff members put out a weekly newsletter highlighting 
their favorite music, which can help you find something you'll 
like among the (probably) mostly unfamiliar offerings. One of 
MP3 Tunes' nicest features is My Locker, which keeps track of 
every song you purchase from the store and lets you download 
the songs again at no charge . Artists should check out the 
site's Artist Cafe, which offers promotional opportunities, stats 
and .earnings on posted so~gs, and other performer-oriented 
features. 

MP3S, COMRADE? 
If you go surfing for music-store alternatives, it won't be long 
before you run into the Russia-based sites www.allofmp3 
.com, www.mp3search.ru, and www.mp3spy.ru. With prices 
running around 10 cents a song and $2 an album, these sites are 
wonderfully-yet suspiciously-cheap. They also offer songs by 
artists who haven't licensed their libraries for on line distribution 
in the West. The stores claim to be legally operating under the 
terms of Russian copyright law, but even if that's true, it's by no 
means clear whether it's legal for those of us in other counties 
to "import" songs from these sites. Similar stores in Spain were 
recently closed due to legal action-so until the situation is 
clarified, these stores come with a big virtual warning sticker. 

The vast selection available from online music stores is great, but sometimes finding 
music you like can be daunting. Luckily there are several free iTunes plug-ins that can make 
recommendations by comparing your music library to that of other plug-in users: Mobster 
(www.musicmobs.com), Audioscrobbler (www.last.fm), and Goombah (www.goombah 
.com). The usefulness of these plug-ins depends on how many people are sharing their 
libraries this way, but you might stumble upon some new artists you might have otherwise 
overlooked. 

Scrobbling mobster goombahs can help 
you find music you might like. 

,.n:-,., Logan Kugler lives in Tampa, Florida, and is currently in a 
~love affair with downloading music by the barrel. 
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You thought you had 
the best antivirus software? 

Oh, welt ... 
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iPod nano 
MINUSCULE DIGITAL-MUSIC PLAYER 

The iPod mini is gone. We'll miss it 
dearly. The good news, however, is 

that its replacement, the iPod nano, is 
just so damn wicked cool. It's a killer 
addition to the iPod line-and not just 
because of its compact design, but 
also because of the new features its 
software offers . 

The nano measures a diminutive 3.5 
by 1.6 by 0.27 inches-small enough 
to fit in the change pocket of most 
pairs of jeans, and strong enough to 
survive if you sit on it when it's in your 
back pocket (yes, we actually tried 
that). And since it weighs a meager 1.5 
ounces, you may not even notice that 
it's in your pocket. The main reason 
for its ultraportability is that the nano 
uses flash-based storage instead of a 
hard drive. You have your choice of 2GB 
(approximately 500 4-minute songs) 
for $199 or 4GB (about 1,000 4-minute 
songs) for $249. 

Let's get small. The nano's interface 
is essentially identical to that of the 
fourth-generation iPod-it's just been 
shrunk down. Despite the clickwheel's 
size, even we ham-handed MacAddict 
editors found it easy to navigate, though 
to some it felt a bit too sensitive. The 
Hold switch sits on top of the nano, while 
a headphone jack and standard 30-pin 
Dock connector share the bottom-you 
can use many of the third-party Dock
connecting accessories you've already 
invested in, but not Apple's Camera 
Connector (t; Sep/05, p50); it's 
not supported. And while the nano lets 
you transfer songs and photos only via 
USB 2.0 (it comes with a USB cable and a 
spacer that allows it to fit into a standard 
iPod Dock), both a USB 2.0 and FireWire 
connection will charge the lil' fella. Audio 
support mirrors that of the standard 
iPod: Apple Lossless, unprotected and 
protected AAC, MP3, MP3 VBR, Audible, 
WAV, and AIFF. 

Your choice of colors is limited to 
just white or black-in our experience, 

black was 
undeniably cool 
but also far more 
prone to fingerprint 
smudges. If you 
yearn for iPod 
mini-like flavors, 
however, Apple 
offers nano 
Tubes-silicone 
covers that come 
in a five-pack of 
clear, blue, purple, 
green, and pink for 
$29. If you don't 
like the Tubes, 
we ' re sure nano 
cases will be out 
sooner rather than 
later from the usual 
iPod-accessory
manufacturing 
suspects. 

9of 12 
The Journey 
Fatboy Slim 
Palookaville 

3:37 -0:59 

----~--- _ ___,. The nano looks 
impressive, and to Perfect harmony in ebony and ivory (shown at actual size). 
our ears, sounds as 
good as any other 'Pod-and plenty 
loud. And while you can store and view 
photos on the nano, you'd better have 
sharp eyes-one of our few complaints 
about the standard iPod is that the 
7-by-5.5-millimeter thumbnails in photo 
mode are hard to decipher; even though 
the nano changes each thumbnail's 
aspect ratio to 7 by 6.5 millimeters and 
reduces the five-by-five thumbnail grid 
of the standard iPod to three-by-four, 
thumbnails remain eye-strainingly 
weensy on the nano's 1.5-inch LCD
which, by the way, is marginally brighter 
and as sharp as that of a standard iPod. 
Another disappointment: Unlike the 
standard iPod, the nano has no video/ 
audio minijack, so you can't display your 
photos on your TV. 

More new hotness. Since you can 
keep your contact list and calendar on 
the nano (it syncs with iCal and Address 
Book) , a new screen-lock feature lets 

you set a four-number combination to 
protect your precious private info from 
prying eyes. We found it was a breeze 
to scroll on the clickwheel and press the 
center button to enter a combination . The 
new World Clock feature lets you keep 
track of local time as well as the time 
in other parts of the globe; we added a 
dozen clocks spanning from Cupertino 
to Paris, Tokyo, Cape Town, and points in 
between-and we could 've added more. 
There's also an easy-to-use stopwatch 
with basic stop, start, and lap-timer 
controls. The four games (Brick, Music 
Quiz, Parachute, and Solitaire) won't 
replace your PlayStation Portable, but 
they'll help pass the time until your 
eyesight gives out. 

The bottom line. The nano has the 
most compelling combination of features 
and size we've seen in a 'Pod; it sets a 
new standard of iPod excellence. · 
-Roman Loyola and Rik Mys/ewski 

COMPANY: Apple 
CONTACT: 800-692-7753 or 
408-996-1010, www.apple.com 
PRICE: $199 (2GB), $249 (4GB) 

REQUIREMENTS: USS-equipped 
Mac, Mac OS 10.3.4 or later 

GOOD NEWS: Small and lightweight. but maintains full 1Pod 
function and style 

MacAddict RATED 

0000 
AWESOME 
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BAD NEWS: Can only transfer files via USB. No video-out to 
display photos on an external display Slightly touchy cltckwheel 



050 
AFFORDABLE ENTRY-LEVEL 
DIGITAL SLR 

With its new $899 D50, Nikon is 
reaching out to anyone who's 

ready to move up to an SLR ca mera
and if that's you, you should definitely 
take this one for a spin . The D50 has 
all the tools you need to take great 
pictures. 

The D50 has a 6.1-megapixel CCD 
imager and comes in a kit that includes 
Nikon's AF-S DX Zoom-Nikkor 18-55mm 
f /3.5 -5 .6G ED zoom lens. Images are 
stored on Secure Digital (SD) flash - · 
memory cards. Wi th SD card storage 
capacities up to 1GB, the D50 should 
have sufficient capacity to capture a 
day's activities-but we wish the D50 
used CompactFlash cards like its big 
brother, the D70 ( ~~ Jul/04, 
p50), since they have capacities of up 
to 8GB. Howeve r, large-capacity SD 
cards are coming in the near future. You 
can store images as JPEGs, in Nikon's 
proprietary RAW file format (NEF), or 
as both the RAW and a JPEG . You can 
choose pi xel resolutions ranging from 
3,000 by 2,000 pi xe ls down to 1,504 by 
1,000 pi xe ls. 

The D50's sensitivity can be set from 
an ISO of 200 up to 1,600, and if you're 
in a low-light situation, the D50 has 
a built-in flash unit that pops up from 
the top of the viewfinder. There's also 
a built-in hotshoe for using Nikon's 
electronic flash units. 

In the field. Our time with the D50 

FREE MILLIMETERS! 
The DSO uses Nikon's line of AF lenses, 
but be aware of the multiplier effect that 
comes with using lenses designed for 
35 mm film cameras. CCD sensors are 
smaller than 3Smm film frames, so when 
used on the DSO, the effective focal 
length of a Nikon AF lens can be 1.4 to 
1.6 times that of its stated length; a 
lOOmm lens, for example, will produce 
images comparable to those captured 
by a lSOmm lens. 

produced no surprises. If you're familiar 
with 35mm film SLR cameras, you'll 
enjoy a seamless transition to the D50. 
The only thing we didn 't like about the 
camera body was the thickness of its 
handgrip-ifyou have short fingers, 
it may be a stretch to firmly grasp the 
camera and access all the controls 
available to your right hand . 

The D50 has the traditional four 
operating modes (program, shutter
priority, aperture-priority, and manual), 
as well as several modes designed for 
specific shooting scenarios such as 
night shooting, portraits, and more-we 
experienced no difficulties with any of 
the operating modes. These additional 
shooting modes let you pay attention to 
what you're trying to capture and spend 
less time worrying about how to set the 
proper shutter speed or aperture. 

The D50 has a shutter-speed range 
from 30 seconds to 1/4,000 of a second, 
and it can sync an external flash up to 
1/500 of a second. You can also set the 
D50 to capture a single frame per shutter 
release or, when set to Continuous 
mode, capture up to 2.5 frames per 

Intimidated by SLRs? 
Here's a friendly one. 

REVIEWS ti 4 J 

second-about a half-frame slower than 
some of its competitors, but definitely 
not a deal breaker. 

Color. The D50's images display nice 
color fidelity-in fact, for the price, this 
camera provides good, useful tools for 
getting great shots. You can select the 
color space the captured images are 
saved in as either sRGB or Adobe RGB 
(use the sRGB color space if you plan on 
displaying your images on the Web only; 
use Adobe RGB if you plan on printing 
out any of your pictures). You can also 
adjust tone compensation, adjusting for 
different levels of contrast. 

There is one aspect of our images 
that we thought could be improved: 
sharpness. A number of our images were 
a bit soft. You can adjust the sharpening 
effect in-camera with the factory 

default set to Auto, but you can't turn 
sharpening completely off. We preferred 
adjusting sharpness in Photoshop rather 
than in camera. 

The bottom line. If you're looking 
to jump into digital SLR photography, 
the D50 is a good place to begin the 
leap.-Rick O/dano 

COMPANY: Nikon 
CONTACT: 800-645-6687, 
www.nikon.com 

REQUIREMENTS: USS-equipped Mac, 
Mac OS 9 or later (Mac OS 10.1.5 or later for 
PictureProject software) 

GOOD NEWS: Easy to use Attractive entry point into 
d1g1tal-SLR shoaling 
BAD NEWS: Slill pricey for some. Images tend to lack 
sharpness PRICE: $899.95 
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LaCie mini 
mini Mate 
miniStack 
MAC MINI- ESQUE 
EXTERNAL HARD 
DRIVES 

·Although the LaCie mini, MicroNet's 
miniMate, and Newer Technology's 

miniStack are designed to match the 
look of the Mac mini, you can use these 
external hard drives with any USB- or 
FireWire-equipped Mac. All three drives 
are well designed, but we found one of 
them stood out from the pack. 

Design. All three drives are designed 
to cosmetically complement the Mac 
mini, but each one has its own little 
aesthetic nuances, such as the way the 
Mac mini sits on top of the drive. The 
miniMate's top closely resembles the 
Mac min i's top-a single flat surface 

Lacie mini 

COMPANY: LaCie 
CONTACT: 
503-844-4500, 

(160GB). $199.99 
(250GB, tested) 
REQUIREMENTS: Mac 
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upon which the Mac mini rests . The 
miniStack's top is formed so that the 
Mac min i's bottom fits snugly on top of 
the drive; the drive is 1.5 inches tall . 
The LaCie mini (1.77 inches tall) uses 
raised corners to prop the Mac mini 
up, leaving a small gap between the 
Mac and the drive. We didn't find one 
design more advantageous over the 
others, nor did we encounter any heat 
problems during our testing-which 
design you like depends on your own 
personal tastes. 

The aesthetically nitpicky will want to 
know that of the three drives, the LaCie 

miniMate 

COMPANY: MicroNet (160GB), $271.95 (250GB) , 
CONTACT: $544.95 (400GB) 
310-320-7272, REQUIREMENTS: Mac 
www.micronet.com OS 9.2 or later for FireWire 
PRICE: $162.95 400, Mac OS 10.2 or later 
(80GB, tested) , $196.95 for USB 2.0 

'L ..,--.. ' -I '-)) 
~ .. 

Max out your 
Mac mini's 

storage with a 

matching drive. 

• 

<.O mini's brushed metal most 
~ closely resembles the Mac mini's. ~ 

The miniStack's metal is a slightly ~ 

different tone, while the miniMate's ~ 
metal looks more polished than ;;: 
brushed . None of the drives use plastic i 
that exactly matches the Mac min i's ~ 
white, but the plastic is used on areas 
of the drives that wouldn't be on display 
anyway-the top and rear. 

Hubs. The miniMate and miniStack 
have a major feature not found in the 
LaCie mini-both double as FireWire 
400 and USB 2.0 hubs . Both drives 

miniStack 

COMPANY: Newer 
Technology 
CONTACT: 
800-275-4576, http:// 



Lacie's design not only 
doesn't provide a hub, but you 
also don't get both FireWire 

400 and USB 2.0 ports with 

the same drive-you purchase 
either a FireWire 400-only 

model or USB 2.0-only model. 

The FireWire model comes 
with two FireWire ports: one 

to connect the drive to the Mac 
and another to connect another 

FireWire peripheral. The USB 
model, however, has only one USB 

port-considering t hat the Mac mini has 

only two USB ports, you'll need to buy a 

separate USB hub for other peripherals . 
The lack of ports is reflected in the 

pricing; the LaCie mini drives are the 
lowest priced of this group. 

Speed. Both the miniMate and 

miniStack give you the option to 
connect via FireWire or USB, but you'll 
benefit greatly from using FireWire 

instead of USB. We used Xbench (free, 
www.xbench.com) to gauge the speed 

of each drive, and we found that on the 
80GB miniMate, the FireWire speed 

was twice as fast as the USB speed in 

Xbench's Sequential Uncached Write 
test; in the Sequential Uncached Read 
test, the FireWire connection was 1.8 
times faster than USB. When testing 

the 400GB miniStack, FireWire was 

almost three times faster than USB in 
the Sequential Un cached Write test 
and 3.2 times faster in the Sequential 
Uncached Read test. When comparing 

the three drives' speed over FireWire, 
the 400GB miniStack was 9 percent 
faster than the LaCie mini in the 
Uncached Sequential Read test, and 
the miniStack was 3 percent faster 
than the LaCie mini. When writing, the 

80GB miniMate was marginally the 
slowest of the three-but these speed 
differences could very well be a result 

of the drives' different capacities (all 
three drives spin at 7,200 rpm). When 
we duplicated a 2GB file in the Finder, 
the differences were dramatic, as we 
expected. File duplication via FireWire 
on the three drives took just over 2 
minutes. Duplication via USB on the 
miniMate and the miniStack took well 
over 6 minutes. 

The bottom line. The miniStack 
stands out in our trio of drives-its 
pricing nudges it over the miniMate. 
-Roman Loyola 

~- .. - . 
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14-inch iBook G4 
IMPRESSIVE NOTEBOOK MAC 

Fin ally, there's a new iBook. But is 
it worth buying a 14-inch iBook G4 

when Intel Macs are coming next year? If 

you're in need of a snappy, inexpensive 
laptop today, the answer is yes. 

The top-of-the-line 14-inch iBook has a 

1.42GHz G4 processor; the 1.33GHz G4 in 
the previous top iBook model can now be 
found in the $999 12-inch iBook. The new 
iBook also comes with 512MB of RAM (up 
from 256MB in the previous model) and 

a RAM expansion slot that allows you to 
max out to 1.5GB (at press time, Apple 

asked $500 for that additional lGB; you 
can find the same capacity SO DIMM from 
major memory vendors for under $200). 

The iBook also has a 142MHz frontside 
.bus, a 4,200-rpm 60GB ATA/100 hard 
drive, and a single-layer SuperDrive. The 
graphics subsystem has been upgraded 

to a 32MB ATI Radeon 9550, which 
supports Tiger's Core Image technology. 

More new stuff. The iBook's new 

track pad lets you scroll by placing two 
fingers on the pad and dragging them in 

the direction you want to scroll, including 
diagonally. It takes practice, but it soon 

becomes second nature. We found it to 
be a great productivity booster-but if you 
don't like it, you can turn it off in System 
Preferences > Keyboard & Mouse. 

The new Sudden Motion Sensor parks 

the hard-drive heads during a fall or 
sudden movement, preventing them 
from banging against the disk platters. 
We still haven't built up the courage to 
test this feature since it debuted with 
the PowerBook G4 (Reviews, May/05, 
p38). We tried to run Bubblegym 

(donationware, www.balooba.se), a game 

that lets you tilt your 'Book to control 
the game, but at press time, Bubblegym 
didn't support the new iBooks. 

Speed. We ran a se ries of tests to 
compare the 14-inch 'Book's speed to the 

$1,49912-inch 1.5GHz PowerBook G4. 
In some of our tests, the difference was 
significant, mostly due to the PowerBook's 
5,400-rpm drive versus the iBook's 4,200-

rpm drive. When performing a Photoshop 

action, the PowerBook was 25 percent 
faster than the iBook. The PowerBook was 
40 percent faster when saving a lOOMB 
file in Photoshop. When we created a 
DVD image in iDVD, the PowerBook was 

16 percent faster. In Unreal Tournament 

This may 
be the last 

2004's flyby and botmatch 
benchmarks, the PowerBook was 25 
percent faster. In our In Design PDF Export 

test, 2GB Finder duplicate, iTunes CD-rip 
test, and iMovie HD video export, the 
PowerBook was about 5 percent faster. 
If speed is more of a priority than screen 
size, get a 12-inch PowerBook-to our eyes, 
however, a 12-inch screen is just too small. 
The iBook also had better battery life than 
the PowerBook, giving us 14 more minutes 
of full-screen-brightness viewing pleasure 
when watching Phone-a "genuinely 

disturbing work," according to The Sunday 

Telegraph-for just under 3 hours. 

The bottom line. The newest iBook not 
only reminds us of how much we love the 
iBook line, but its new features give us 
newfound appreciation.- Roman Loyola 

COMPANY: Apple 
CONTACT: 800-692-7753 or 
408-996-1010, www.apple.com 
PRICE: $1,299 

SPECIFICATIONS: 1.42GHz PowerPC G4, 512MB DDR333 SDRAM, 60GB 
Ultra ATN100 hard drive, 512KB L2 cache, 14.1-inch TFT display with 1024-by-
768-pixel resolution, 32MB ATI Mobility Radeon 9550 video card, SuperDrive, 
Bluetooth, AirPort Extreme 

CiOOD NEWS: Nice new features give iBook line new life. More stock 
RAM. Graphics system supports Core Image 
BAD NEWS: Slow hard drive affects performance. 
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44 /1 REVIEWS 
tr better living through smarter shopping 

QuicKeysX3 
ACE AUTOMATION UTILITY 

Dating back almost as far as the Mac 

itself, QuicKeys is a stalwart of Mac 
productivity, allowing you to automate 

nearly any task on your Mac. If you're 
familiar with AppleScript or Tiger's new 
Automator, think of it as a mix between 
the two-with an added dose of steroids. 

While QuicKeys is capable of nearly 

any task imaginable, it's surprisingly 
easy to use. The interface of the latest 
version has been revamped, and the 

result is a far-c leaner and more-intuitive 
experience. You can create QuicKeys 
shortcuts in two different ways: The 
first is similar to Tiger's Automator-you 
select predefined actions and align them 
in a list in order of execution. Because 
of QuicKeys' more-general scope, 
creating shortcuts isn't as effortless 
as it is with Automator, but you're also 
not confined to Automator's rigid list of 

actions. QuicKeys can perform anything 
that you can see or click within an app, 
which opens up a whole new world of 

automation capabilities . 
Simon says. The second method for 

creating QuicKeys shortcuts is to record 

• Use QuicKeys to 
trigger AppleScripts 
that control iTunes 
with a hot key. Skip 
or rewind tracks, rate 
songs, and more, 
all without having 

to switch to iTunes 
and away from wha t 
you're working on. 

•Fast User Switching 

is fast, but QuicKeys 
can make it faster. 
You can create a short 
sequence to open the 
user-switching menu, 
select the desired 
user, enter the 
password, and click 
the OK button. 

yourself 
performing an 
action. If you're 
familiar with 

AppleScript's 
Script Editor, 
you've 
probably 
noticed its own 
Record button. 

If you've 

ever pressed 
that button, 
you've also 
noticed that 
it rarely does 
anything-the 

problem 
being that 

AppleScript's 
recording 

capabilities 

0 t ~ oa 
Pause Type Keystroke 

ON THE 
DISC 

Inspector Rename 

Scopes &. Triggers 

• • OmniOutliner Professional : All Parts of OmniOutli ner Professional ~ 

0 0 hot key ~ ~ F6 

Steps: 2 

1 " @\\ Open file To Do 

0 Finder Selection 

@ Specified Item 

~ ToDo 
E l /Users/nlck/Oocumt!nts/To Do.oo3 

Open With : I Default Application 

2 Y mm in submenu of menu Reorganize 

Menu Action: I Select Menu r: I 
Menu: I Reorg~ize 

Submenu: I Keep Sorted 

: J 

Menu Item: [status, Unchecked to Checked 

( Choose Menu ... ) 

Checked: I Don~ Care r: I 
Exists: Y~s 

~----~ 

Enabled: ' Yes : I 

Options: 0 Show menus while performing menu action 

0 Perform as alternate menu action {option key) 

depend on the target app's support; and 
since support is nearly nonexistent, you 
wind up having to hack out your own 
Apple Script code, defeating the purpose 
of automation. 

QuicKeys works quite differently; 
it records every keystroke and mouse 
movement you make, allowing you to 
record nearly anything you do on your 
Mac. After recording a session, QuicKeys 
analyzes everything you did and attempts 
to create a step-by-step shortcut from 
your actions. While obviously a boon 
for easily recording_ a task, this method 
can produce not-so -hot results-you'll 
occasionally wind up with unnecessary, 
intermediate steps; or worse yet, 

Step Results : Cl)@ ' 

j ( Details ... ) 

](1§9 
J(l§g 

.C!EJ 

Step Resul!S: Cl)@ 

QuicKey's new 
editor makes 
short work 
of creating 

shortcuts. 

QuicKeys simply won't understand what 
you were trying to do. However, for the 
most part, the recording feature is a great 
way to create the foundation of a shortcut 
with very little effort. 

After creating a shortcut, you can then 
configure how it will be executed: a simple 
keystroke, a specific time, after an app 
launches, and more. With this flexibility, 
QuicKeys makes it easy to automate any 
task and boost your productivity. 

The bottom line. QuicKeys is an 
automation powerhouse. It's easy to 
use and can do anything you set your 
mind to. The recording feature may not 
be perfect , but it's certainly a helpful 
aid.-Nick Muerdter 

X-COMPANY: Startly Technologies 
CONTACT: 800-523-7638, 
www.startly.com 

REQUIREMENTS: Mac OS 10.3 or 
later, 128MB RAM 

GOOD NEWS: Makes 1t easy to automate anything on 
your Mac. New mlerface 1s much improved. 

PRICE: $99.95, $29.95 (upgrade) 
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Star Wars Battlefront drafts you as a 

soldier in some of the Star Wars saga's different tactics ; some maps use narrow 
most fa ous galactic battles, pitting pathways to create strategic choke 
two teams (Imperial Stormtroopers and---iPOints, while others are wide open, 
the Rebel Alliance) against each other on encouraging you to use vehicles for 
sprawling battlefields. The goal: Try to flanking maneuvers. 
take and hold multiple control points on Light speed. Speaking of vehicles, 
the game map. you'll find more than two dozen in the 

Ever since Battlefield 1942 (c; c; game, including land speeders, X-wings, 
Oct/04, p56), we've been huge fans of TIE fighters, tauntauns, and speeder 
this type of game-and the Star Wars bikes. Even if you're not a huge Star 
universe is a refreshing change of Wars fan, there's something 
venue from the overused settings magical about climbing into 
of WWII. these famous rides . We had 

Multi player matches, which the most fun on Hoth, where 
let you fight with up to a we took the reins of a giant 
total of 32 real folks on line, AT-AT, slowly stomping 
are naturally a blast. Even in our way towards the 
single-player mode, you feel Rebels' snow base 
like you're part of an epic while blasting away 
war, since the world from the head of the 
is populated by beast. Playing as 
dozens of Al the Rebel Alliance 
soldiers fighting in the same map, 
at your side-and we used our snow . 
they're reasonably speeders and tow 
smart, too. They know cables to trip up the 
to run from live grenades walkers (you can 
and will often jump or roll away switch to a third-
from enemy fire . person view to make 

Battlefront's 16 incredibly flying a lot easier-a 
varied maps include the ice nice touch). 
fields of Hoth, forests of Battlefront also 
Endor, deserts ofTatooine, has several different 
urban sprawl of Cloud City, classes you can play. 
and palace of Naboo. Most The Soldier class 
maps feel very distinctive 
and are rendered with 
detailed textures and 
architectural touches . 

COMPANY: Aspyr 
CONTACT: 512-708-8100, 
www.aspyr.com 
PRICE: $49.99 

Radeon 8500 or nVidia GeForce4 MX or 
better video card. 2.7GB disk space 

Play a grunt in four 
different armies
make ours Wookiee! 

can climb behind 
wheel of ao AT-AT 

lmp,erial w.,alk_gr. 
(AT-ATs hlW&I 

wheel~.J~E'll~ 

carries a standard 
blaster, the Anti
Vehicle class carries a 
missile launcher, and the 
Sniper class has-you 
guessed it-a sniper rifle. 
The multitalented Pilot class 
can dole out ammo, administer 
first aid, and repair damaged 
gun turrets and vehicles . Each 
faction also has its own special 
class with handy traits that are 
different depending on which 
team you're on-the Imperials' 
Dark Troopers, for example, have 
a jet pack that helps them get behind 
enemy lines. These all add depth to the 
game, but our one complaint is that 
Battlefront strangely doesn't let you 
pick up the weapons of fallen comrades. 
You can't, for example, trade a missile 
launcher for a sniper rifle. 

Battlefront's framerate seems 
noticeably smoother than Battlefield 
1942's, making it friendlier toward middle
tier Macs. Unfortunately, Battlefront does 
have a major weakness in that you can't 
play online with PC-based players. That 
means you'll have very slim pickings 
when searching for an on line game to 
join; Battlefield 1942, on the other hand, 
supports both Macs and PCs, and it's easy 
to find tons of active on line games. 

The bottom line. The on line limitation 
sadly dulls our enthusiasm for what 
is otherwise a great game. We logged 
several fun single-player hours, but in 
a genre that begs for strong multi player 
support, Battlefront falls short. 
-Helmut Kobler 

MacAddict RATED 

0 
GREAT 

November 2005 MacAddict 45 





• Buffs out scratches from vinyl LPs • Record or import audio into your Mac 
• Wipes out hiss, hum, and other 

noise from tapes or DVs 
• New Enhance leaves a fine polish 
• Tough on grime, yet gentle on 

your signal 

• Edit and process your audio 
• Create custom fade-ins and outs 
• Assemble tracks in a playlist and 

burn your own audio CD! 

Disca11er far yourself haw easy and fun they are ta use. 
Check out the demo an the MacAddict CD or 11isit 

www.bi~s-inc.com/dawnlaads/freetrials 

-:. ::-

bias -~ -;;. 
sound creative" 



X-

Photo Kit 
EFFECTIVE PHOTOSHOP PLUG-INS 

PixelGenius's PhotoKit is a Photoshop 

plug-in that helps you achieve 
darkroom-style control over digital 
images. Image-editing types will love 
this powerful tool kit-despite its lack of 

an image preview. 
Photo Kit contains the following sets of 

effects: B&W Toning adds tone effects to 
black-and-white pies; Burn Tone applies 
a graduated darkening effect; Color 

Balance applies color correction; Color 
To B&W converts color images to-you 
guessed it-black and white; Dodge Tone 
adds a graduated lightening effect; Image 

Enhancement contains various sharpening 
filters; Photo Effects adds grain, fog, or 

diffusion effects; and Tone Correction lets 
you make tone adjustments. Each set has 

a subset of effects; for example, the B&W 
Toning set has nine different tones you can 

add to a black-and-white image. We found 

that all of the filters worked well. 
No preview. We love the way PhotoKit 

allows you to save effects in layers, 
but some of these effects-such as the 
black-and-white filters-would benefit 

greatly from an image preview. You 
can visit PixelGenius's Web site to see 
examples of what to expect, but the lack 
of previews becomes less of a hassle 

once you've spent time with the filters 
and you know what they can deliver. 
Photo Kit's filters are a bit pokier than 

Photoshop's, but since the effects are so 

good, you won't mind the brief wait. 
The bottom line. PhotoKit is a deep 

package and deserves to be added to 
the arsenal of any photo professional or 
serious amateur. For $49.95, it's quite a 
bargain.-5teven Parke 

COMPANY: PixelGenius 
CONTACT: www.pixelgenius.com 
PRICE: $49.95 

REQUIREMENTS: G3, Mac 
OS 10.2.4 or later, 192MB RAM, 
320MB disk space. Photoshop 
CS or later 

CiOOD NEWS: Vast array of visual effects 
BAD NEWS: Can't preview effects 

LCM-17w7 
NARROW AND WIDE LCD DISPLAY 

Acouple of things you notice right off 

the bat about the LCM-17w7: First 
is the dated Westinghouse logo-you 
know, the one that probably adorns your 
fridge. Surprise! Westinghouse actually 
has a Digital division that produces 
LCD displays. The second thing is that 
the LCM-17w7 looks small for a 17-inch 

display. That's becuase it's a widescreen
format display, so its 17 inches span 
more horizontally than standard displays. 

Combine the widescreen format with 
the display's maximum 1,280 by 768 
resolution, and you're in for a tight fit 
vertically-a higher resolution would 
help the screen feel less cramped-but 
movie editors and enthusiasts will enjoy 
the widescreen format; it's nice to watch 
Napoleon Dynamite and other movies 

REQUIREMENTS: 

the way they're meant to be. The image 
quality for movies looked good- no 

noticeable streaking, nice color, and 
fine brightness. During regular Mac use, 
images looked good, and the brightness 
was even. Type, however, was fuzzy. 

Specs. The display claims a 600-to-1 
contrast ratio, a 15-millisecond response 
time, and a brightness rated at 400 

candela per meter squared. We found the 
claimed 170-degree viewing angle to be 
mostly true, though at extreme angles, 
we weren't able to see midtone details. 
The LCM comes with one DVI port, one 
VGA port, and an audio-in connector 
for the built-in speakers (which sound 
like bad AM radio). lfyou're into color 
coordination, the white-and-silver plastic 
bezel matches the Mac mini . Although 

CiOOD NEWS: W1descreen for movie buffs 

Working from an original photo (top), 
the Color To B&W filter gives you options 
such as Blue Contrast (middle) and Yellow 
Contrast (bottom). 

MacAddict RATED 
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Short and stout. 

the screen tilts forward and back, you 
can't adjust its height. 

The bottom line. The LCM-17w7 is an 
affordable alternative to 19- and 20-inch 
widescreen displays, but you'll have to 
adjust to its limitations.-Roman Loyola 

MacAddlct RATED COMPANY: Westinghouse Digital 
CONTACT: 866-287-5555, 
www.westinghousedigital.com 
PRICE: $299 

DVI or VGA video BAD NEWS: Small amount of vertical screen space Weak 
speakers 00 

SOLID 
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Mighty 
Mouse 
DISAPPOINTING 
MULTIBUTTON MOUSE 

C 'mon, Apple-you had 
over 20 years to design 

a multibutton mouse, 
and the best you could 
come up with is this? 
Although mouse 
choice is largely a 
matter of personal 
preference, we 
couldn't help but 
be disappointed by 
Apple's multibutton 
Mighty Mouse. 

The best thing. The 
simple fact that the 
Mighty Mouse has 
more than one button 
is the best thing about 
it. Although it looks 
like a one-button 
mouse, under its top 
front lie touch sensors 
that can tell if you're right-
or left-clicking-and the click 
is natural and audible. 

\ __ 

diagonally. Scrolling has a slightly 
notchy feel to it, but the Scroll Ball is 
so small that you have less feedback 
and control than with a traditional 
scroll-wheel mouse. Some MacAddict 
editors loved the Scroll Ball instantly; 
others found it too small and 
occasionally finicky, especially when 

scrolling diagonally. 
The not-so-good 
things. You can 

J 

customize each 
button's function 
through System 
Preferences> 
Keyboard & Mouse, 
but you need Mac 
OS 10.4.2 or later 
to be able to use all 
the features-and 
all in this context 
means "not much." 
Unlike many other 
multibutton mice, 
you can't program 
the buttons to 
perform common 
keystrokes
Command-W, for 

example, to close a 
window-or perform 

So far, so good. First, Intel processors ... 

a double-click. Instead, 
you're limited to setting 
buttons to launch an 

The so-so things. Then 
there are two other buttons: 

now this! 

Button three is the tiny (quarter-inch), 
clickable Scroll Ball-more on that in 
a moment. Button four is actually a 
pair of love handles-one on each side 
of the mouse-that act as one button 
when you squeeze the Mighty Mouse. 
However, not only are the squeeze 
buttons too small for large hands to 

app or activate Expose, 
Dashboard, or Spotlight. 

One other, if minor, quibble: the USB 
cable. Bluetooth and RF wireless mice 
are rapidly becoming the high-end 
mouse standards; we expect the best 
from Apple, and a cable-tethered mouse 
ain't it-especially a $49.99 one. 

~ easily use, you get next to no tactile 

The bottom line. It seems as if Apple 
paid too much attention to form and not 
enough to function when designing the 
Mighty Mouse. We'll stick with one of the 
many superior rodents from Microsoft, 
Kensington, Logitech, and others. 

0 

R
~ feedback when you squeeze them. 
: The Scroll Ball provides 360 degrees 
w of scrolling and panning indulgence-
\'i. 
-;; )I OU can go up, down, sideways, or -Rik Myslewski and Roman Loyola 

COMPANY: Apple 
CONTACT: 800-795-1000 or 408-996-1010, www.apple.com 
PRICE: $49 

GOOD NEWS: Has more than one button (yay') Looks good. 
BAD NEWS: Pricey Questionable e1 gonom1cs and feel Limited 
programmability. 

REQUIREMENTS: USS-equipped Mac, Mac OS 
10.3.9 or later (OS 10.4.2 required for advanced 
features) 

MacAddict RATED 
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Bluetooth 
headphones: the 

best of both worlds? 
Or the worst? 

Wireless 
Headphones 
for iPod 
HEAVY 'POD 
HEADPHONES 

We love our iPods, but something's 
missing-or rather, we wish 

something were missing: the dang 
headphone cord. But you can cut that 
cord with Logitech's Wireless Headhones 
for iPod. These behind-the-neck phones 
could be your ticket to unwired aural 
bliss-or dull pain. 

The headphones work effortlessly. A 
Bluetooth transmitter parks atop your 
'Pod and syncs with the phones on your 
head when you press both units' sync 
buttons. Smartly arranged, simple-to
use buttons on the right earpiece let 
you adjust the volume and skip or scroll 
through tracks. The transmitter and 
the phones sport internal rechargeable 
batteries (charger included)-they lasted 
about as long as our year-old iPod min i's 
8-hour charge . Unfortunately, the phones 
are on the heavy side, and some folks in 
the office found them uncomfortable. 

The bottom line. These phones don't 
crank loud enough or fit securely enough 
for any amount of serious head banging, 
but if you're looking for something that 
plays nice in the office without having to 
be removed every time you get up, these 
headphones deliver. And if you're lucky, 
wearing them won't hurt too much . 
-Niko Coucouvanis 

COMPANY: Logitech 
CONTACT: 
800-231-7717, 
www.logitech.com 

PRICE: $149.99 
REQUIREMENTS: 
Third- or fourth-generation 
iPod or iPod mini 
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Pixma iP90 
PORTABLE INKJET PRINTER 

If you're on the road, you'll be grateful 
you have the Pixma iP90 when you 

have to print a document while stuck 
in the Podunk Day's Inn at one in the 
morning. 

The 12.2-by-6.9-by-2-inch iP90 can 
handle media as large as 8.S by 11 
inches and as small as a credit card (2.13 
by 3.39 inches). The iP90 prints at 600 
by 600 dpi for black-only documents and 
4,800 by 1,200 dpi for color docs-it can 
print borderless, too. The printer uses 
two ink cartridges: one black and one 
cyan-magenta-yellow combo. The iP90 
connects to your Mac via USB (cable not 
included) and supports PictBridge for 
direct printing from a digital camera . 
There's an lrDA port that a PDA or other 
infrared-equipped device can use to 

Spend less time 
at Kinko's and more time 
in your hotel room watching pay-per-view. 

print. An optional Bluetooth adapter 
costs $79.99. 

Performance. We printed a 2S -page 
Word document in standard mode in 3 
minutes, SO seconds; a two-page Excel 
spreadsheet in just under 3 minutes; 
and a 1S-page PowerPoint presentation 
in 12 minutes, 26 seconds. A top-quality 

4-by-6-inch photo took a snappy 
90 seconds, and an 8-by-10 -
inch photo took 3 minutes. 
Impressive speed-and a lot 
faster than running down to 

your hotel 's office facility or a 
nearby Kinko's. 

The iP90's image quality is 
good overall, but if you're printing 

for a client who scrutinizes your 
documents with a loupe, you will 

need to visit Kinko's. Text isn't laser 
quality, but it's clean. In our tests, 
charts and graphs reproduced nicely; 
color photos were good for a four-color 
printer, but flesh tones at times lacked 
consistency. None of our documents had 
any banding or visible droplets. 

The bottom line. Road warriors, say 
hello to your new traveling companion . 
-Roman Loyola 

COMPANY: Canon 
CONTACT: 800-652-2666 or 
516-328-5000, www.canon.com 
PRICE: $249.99 

REQUIREMENTS: USB-equipped 
Mac, Mac OS 10.2.4 or later 

GOOD NEWS: Portable Fast. Good overall photo quality 
BAD NEWS: Ink runs out quickly Pricey USB cable not 
included 

MacAddict RATED 
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Mercury Elite-AL Pro FireWire 800/400+USB2 
FAST AND FASHIONABLE HARD DRIVE 

When we reviewed Other World 
Computing's Mercury Elite Pro 

FW800 ( Mar/OS, p46), we 
criticized its case design. So it's only 
fair to say right off the bat that the 
Mercury Elite-AL Pro's case is a vast 
improvement; it's a solid, sturdy 
aluminum job that has a grill like 
a Power Mac GS. And there's more 
to like about the Mercury Elite-AL 
Pro than just its case design: 
The drive comes with FireWire 800, 
FireWire 400, and USB 2.0 connectors
and kudos to owe for including cables 
for each connector. At the heart of the 
drive we tested-the 400GB model-is 
a 7,200-rpm 400GB Hitachi Deskstar 
7K400 with an 8MB cache. 

Speed. We took a look at the drive's 
speed using all three connectors 

on our dual 2.7GHz Power Mac GS. 
Over FireWire 800, the Mercury Elite 
showed sequential 2S6KB uncached 
data-transfer speeds of around S2 

You can't go wrong 
with a Power Mac-like design. 

MBps and S8 MBps when writing and 
reading, respectively, according to 
Xbench (free, www.xbench.com), a 
popular benchmarking utility. Those 
numbers compare quite favorably with 
the SS-MBps read and write speeds of 
the Power Mac's internal 2SOGB Maxtor 
Serial ATA drive. The Mercury Elite did 
even better in random reads and writes, 

showing speeds of 26 MBps and 30 
MBps; the Mac's internal drive 
reads at 21 MBps and writes at 
28 MBps. When we duplicated 
a 2GB file in the Finder, t he 
internal drive was just 2 seconds 

faster than the Mercury Elite. 
The bottom line. There's a lot to like 

about the Mercury Elite-great speed, a 
nice case, and a plethora of connectivity 
options.-Roman Loyola 

COMPANY: Other World 
Computing 

PRICE: $159.99 (80GB) to $499.99 (500GB); 
400GB tested 

GOOD NEWS: Excellent case design. Three 
connection options Bundled cables 

CONTACT: 800-275-4576, 
http://eshop.macsales.com 
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REQUIREMENTS: FireWire 800-, FireWire 400-, or 
USB-equipped Mac; Mac OS 8.6 to 9.x or 10.1.x or later 

BAD NEWS: Nothing we can think of-honestly. 



Xingtone Ringtone Maker 
STRAIGHTFORWARD RINGTONE EDITOR 

Xingtone Ringtone Maker lets you 

edit and convert non-ORM protected 

audio files into ringtones for your cell 

phone. It works, but you must have a 

compatib le phone and service provider 

if you want to use Sinatra's "Where Are 
You?" as a ring. 

Here' s what your phone needs: 

can't use ORM-protected 

songs), and more-load it, 

and t hen select the part 

you want to use as the 

ringtone. In Easy mode, you 

only have a trimming tool 

to cut the sound files . In 

Advanced mode, you can 
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text messaging, Web-page access, 

downloadable ringtone support, and t he 

ability to work with one of eight carriers. 

Xingtone's Web site lists the service 
providers and supported phones. 

also normalize, apply fades, Instead of annoying cell phone chimes, you can now use 

and adjust gain . Xingtone annoying music samples. 

Simple editor. Xington e is easy to 

use. Just find the 

ON THE 
DISC 

Xingtone Ringtone 
Maker 

sound file you want 

to use- MP3, OGG, 

AIFF, WAV, WMA, 

unprotected AAC (you 

Ringtone Maker can also 

record sound through a mic. 

To load the ringtone onto your phone, 

Xingtone sends it to your phone directly. 

You can' t save it on your Mac, upload 

it to a server, or export it out as some 

other file format. The transfers worked 

fine when we tried them on a Nokia N-

G age and LG PM-325. 

GOOD NEWS: Affordable Easy to use. 

We did run into a coup le of interface 

quirks: You can't use the Mac's spacebar 

to play or stop an audio file, and whenever 

we clicked on the Ea sy or Advanced 

buttons in t he upper right, we got a weird 

graph ical glitch. (We used Tiger.) 

The bottom line. Xingtone is useful

and fun .-Roman Loyola 

MacAddict RATED x. COMPANY: Xingtone 
CONTACT: www.xingtone.com 
PRICE: $19.95 

REQUIREMENTS: Mac OS 
10.2.8 or later, 64MB RAM, 20MB 
disk space, Internet connection, 
compatible cell phone 

BAD NEWS: Can't handle ORM-protected songs. Some 
interface quirks. _00 
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Take Your Digital Photos Beyond 
the ''Ken Burns Effect'' 
Photo to Movie TM brings photos to life by adding 
motion using a powerful version of the "Ken Burns 
effect". You can add music tracks, voice narration, and 
a variety of slide-to-slide transitions. Export movies 
from Photo to Movie and use them in iMovie TM, burn 
them to DVD, post them on the Web, or even email them. 

Use code PTM13527 for a 10% discount 
when purchasing from PhototoMovie.com 

Down!o!ld a FREE, full-featured trial version 
of Photo to Movie today and get ready to 
be amazed. Experience Photo to Movie's 
powerful features for yourself. Visit our 
web site for details. Retail price $49.95 

Available for Mac OS X or Windows XP. 

"It's simple and does what it 
does better than any other." 

Mac360.com 

"I've gotten more favorable 
comments on my project than 
anything I've done to date." 

Gregg, Photo to Movie user 

Sold at these and other retailers: amazon.com _., Phot • OVIB i~ml •Apple stores TrlJ·sr 
i~.. Et.£CTRon1cs www.phototomovie.com 



Radio YourWay LX 
• • 

PORTABLE DIGITAL RADIO RECORDER 

P oGo takes the antiquated pocket 
radio and gives it a high-tech 

makeover with the Radio YourWay LX. The 

result is a nifty device that can digitize 
your favorite AM and FM radio programs 
so you can to listen to them anytime. 

The Radio YourWay LX's design is 
'Podesque-it has a 2-inch-diagonal LCD 

near the top and navigational buttons 
arranged below it in a circle. The device 
measures a svelte 3.9 by 2.3 by 0.8 
inches and weighs a featherweight 3 
ounces. The built-in speaker does a good 
job of p,rojecting audio, but the sound is 
flat and distorted at high volume. In-ear 

headphones are included, but they're 
uncomfortable to wear. 

Playback. The device can play MP3, 
WMA, and RVF (a proprietary format) 

audio files, which you copy 

to the device over a USB 
connection; unfortunately, the 
LX can't play music purchased 

from the iTunes Music 
Store-sorry. The LX also 
comes with a rechargeable 

lithium-polymer battery (we 
got 18 and 25 hours of radio 
and file playback, respectively) and a 
slot for SD cards and MultiMediaCards. 
The model we tested had a seemingly 
meager 128MB of internal memory, but 
we were able to fit almost 9 hours of 

radio clips at 32 Kbps. Get a memory 
card if you plan on accumulating higher

quality audio. 
After deciphering the device's 

software interface (the cryptic manual 

MOOE -· 
'"' 

Record your favorite 
shows on this sound 
savior. 0 

\_ .._,/ 

·-
~ _/ ~ 

..... 
v 

doesn't help much), 

we found the recording 
features very flex ible. 

You can create up to 10 
different schedules and 

set MP3 quality from 

32 Kbps to 256 Kbps . 
Want to record a lecture? 

Use the internal mic or 
connect an external one to the 0.25 -inch 
line-in jack, then put your notebook and 
pencil away. Too bad you can't pause 

and time-shift live broadcasts as you 
can with Griffin's Radio Shark (t:' c:; . 

Feb/OS, p46) . 
The bottom line. The Radio YourWay 

LX isn't cheap. But if you ' re a radiophile 
and price is no object, then this gadget 

is for you. - Gi/ Loyola 

v COMPANY: PoGo 
fY.. CONTACT: 866-367-7646, 

www.pogoproducts.com 

PRICE: $199.99 (128MB), 
$249.99 (512MB) 
REQUIREMENTS: USS-equipped 
Mac, Mac OS 10.1 or later 

CiOOD NEWS: Built-In speaker. Long battery life. Memory-card 
slot Flexible recording 

MacAddict RATED 

0 00 
SOLID 

ARP2600V 

BAD NEWS: Can't pause or t1me-sh1ft live broadcasts Pricey. 
Uncomfortable earphones 

RETRO- COOL SOFTWARE SYNTH 

Remember the bubbling synthesizer 
underlying The Who's "Who Are 

You"? How about the growling bass line 
that drove Uber-white-guy Edgar Winter's 

venerable "Frankenstein"? If so, then you 
remember the ARP 2600, the legendary 

analog synthesizer that fuels these rock 
anthems. An original 2600 is hard to find, 
but Arturia has created a wonderfully 

dense, accurate software simulation 
called the ARP2600 V. In many regards, 
it's even better than the real thing. 

The original hardware ARP 2600 was 
monophonic-it could play only one 
tone at a time-but the ARP2600 Vis 
polyphonic, capable of producing up 
to 32 voices at a time. Functioning as a 
standalone app or as an Audio Units plug
in (the CD also includes RTAS, HTDM, 
and VST plug-ins), the ARP2600 Vis a 

wonderfully warm-sounding 
instrument. It worked 
smoothly in a variety of tested 

apps, including Ableton Live 
and GarageBand. 

Synth sounds. If you're 
looking for realistic horns and 
pianos, the ARP2600 Vis the 
wrong choice-it's all about 
seriously cool, demented, 

A classic analog synthesizer has been reborn in digital form. 

organic synth sounds. Electronica, 
dance, trance, rock-modern musical 
styles shine when interpreted through 
the ARP2600 V. However, the ARP2600 
V requires some hefty CPU host power, 
especially if you decide to use it on more 
than a couple of tracks in a song. 

In addition to the awesome array of 
tone-sculpting tools found in the original 
hardware, the ARP2600 V includes 400 

presets and other goodies we would have 
killed for in the original. Unfortunately, 
while the documentation explains basic 
functions, it does little to teach you how 
to use the 2600 for sound design. 

The bottom line. If you're looking 
for cool, retro-new 

sounds, the ARP2600 
V will rock your wo rld. 
-David Biedny 

ON THE 
DISC 

COMPANY: Arturia 
CONTACT: +33 4 38 02 05 25, 
www.arturia.com 

REQUIREMENTS: 1GHz G4, Mac 
OS 10.2 or later, 256MB RAM 

GOOD NEWS: R1cl1 polyphonic analog sound. Extremely 
programmable. Engaging reproduction of classic audio hardware 
BAD NEWS: CPU intensive. Documentation is a bit on the 
light Side. 

MacAddict RATED 

PRICE: $310 AWESOME 
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Wirecast 2 
IMPRESSIVE WEBCASTING SOFTWARE 

W irecast uses a simple interface 
to manage live video from a DV 

camera or iSight, integrate graphics, 
and transmit QuickTime video to viewers 

connected via LAN or the Internet. 
Video can also be recorded to disk for 
QuickTime playback. 

You don't create your video in a 
timeline as you do in iMovie. Instead, 

Podcasting? Passe. Move on to Webcasting. 

think of the video-editing elements as 

monitors in a broadcast control. room, 
and you are the di rector. The top-right 

corner of the Wirecast window shows the 
live shot; the top left shows a preview 
of the next shot, which you choose by 

clicking a shot in a list at the bottom 
of the window. Click the Go button to 
make the preview live. You can also 

skip the preview and make shots live 
with a single click. Wirecast can use 
prerecorded audio, QuickTime movies, 

or imported graphics. Pretty easy. 
Layers. You can add up to five layers 

(including titles, lower-third graphics, 

overlays, background 
ON THE images, and audio) 
DISC to your shots, though 

.Wirecast 2·1 Wire cast doesn't 

COMPAlilY: Vara Software 
CONTACT: www.varasoft.com 
PRICE: $449.99, $299.99 (educational price) 

GOOD NEWS: Easy to use. Chroma Key feature 1s cool. 
BAD NEWS: Some bugs. l1m1ted documentation. 

have any effects tools (a la iMovie) for 
modifying the original image. 

Wirecast includes prebuilt picture-in
picture shots into which you can insert 

your own live video or still images. Slick 
transitions, such as Swinging Door and 
Cube, keep shot changes lively. 

Wirecast's best feature is Chroma 
Key. Place your subject in front of a blue 

or green background, 

turn on Chroma Key by 
selecting Channel A in 
the main window, and 
Wirecast automatically 
makes the background 

transparent. Then 
select the Background 

option in the edit 
checklist and pick 
an appropriate 
background image 

from your shot list. 

Multiple users can 
access a Wirecast 

presentation over a 
LAN using QuickTime 
Player. Over the 

Internet, video can be sent to a single 
IP address without further resources. 

For multiple Intern.et connections, 
you'll need to reflect the Webcast off a 

QuickTime Streaming Server or use a 
content-delivery service such as Akamai 
(www.akamai .com) . 

The bottom line. Wirecast offers 
impressive options for making a Web 

broadcast-Tom Lassiter 

J7' BE PREPARED 
A good Wirecast show requires 
planning. Plan your shot order, 
how you want each shot to look, 
and which transitions to use. Live 
talent must be ready to perform 
on cue, and you'll want a script to 
keep it all organized. Just like on 
TV, avoid yawn-inducing dead air. 

REQUIREMENTS: 500MHz G3, Mac OS 10.3.5 or 

later, Quartz Extreme-compatible video card 

Disk drives don't last 
forever, but your 
data can with ... 

SoftRAID®3 
Real-Time 

Data Protection 
that's 

Get a free demo at 
www.softraid.com 

SoftRAID, LLC 
44801 Main Street 

P.O. Box 1600 
Mendocino, CA 95460-1 600 

SoftRAID is a trademark of SoftRAID LLC 
Mac and the Mac logo are t rademarks of 

Apple Computer, Inc., reg istered in the U.S. 
and other countries. 



Never Lose 
Anything Again 

Photos, e-mails, graphics, 
documents. Who knows what 

you've got hidden away? 

NoteBook takes all those snippets and 
turns them into searchable catalogs of 
information. Find anything instantly. 

Publish to the web in one step. 
NoteBook puts you in the driver's seat. 

You can take control. 
NoteBook can help. 

Try NoteBook free for 30 days. 

Introducing 
Circus Pon iesTM 

Note Book 

Powerful outlining and 
organizing for your ideas! 

~ 
~ 

Free demo at 
www.circusponies.com 

Macworld 

••••t design 
~-·-~·· 

maa-t0M! 

••••• 
Q Copyright 2005 Circus Ponies Software. Inc.All 
Rights Reserved. Circus Ponies, the C~cus Ponies logo. 
NoteBool<. •od the Note6ook logos •nd icoru are 
trademarks of Circus Ponies Sof\ware, Inc. 

mini Tower 
mini Grandstand 
USEFUL MAC MINI STANDS 

It may be the smallest Mac ever, 
but the Mac min i can still disrupt 

your desk's feng shui-you may need 
Plasticsmith's mini Tower or min i 
Grandstand to bring harmony back to 
your workspace. Both Mac mini stands 
feature solid construction and nice 
designs. We like 'em both, but we like 
the mini Tower best. 

mini Tower. The sexy, 7.25-by,-8-inch 
mini Tower wraps your Mac mini in clear 

versions of the Grandstand: one in 
thick, clear acrylic and another in a 
brushed steel that matches the sides 
of the Mac mini. Sorry, no Apple White 
available. 

The Grandstand is simply a display 
stand. It's 11 inches wide, so there's 

When it's not 
enough to simply 
have a buck-naked 

acrylic. Slide your Mac mini in (there's 
an opening for the disc drive) , and 
you're ready to go. The opening at the 
back of the case allows the Mac mini 
to breath-don't worry about your little 
number overheating. 

The mini Tower stands the Mac mini 
on its side. Sure, you can stand the 
Mac mini on its side without the mini 
Tower, but the Tower gives the Mac 
mini more support. Now comes the 
hard part: figuring out what to do with 
the 3.56 square inches of space you've 
regained. The possibilities boggle the 
mind-and if you have two Mac minis 
adorned in mini Towers, you can use 
them as bookends. 

mini Grandstand. There are two 

mini Tower 
COMPANY: 
Pla~ticsmith 

CONTACT: 
800-394-3774, 
www.plasticsmith.com 

PRICE: $39.95 
REQUIREMENTS: 
Mac mini 

GOOD NEWS: Solid construction. Attractive. 
BAD NEWS: Where's the 

-: ~ •' I 
matching white version? •••• • . . 

space along the sides of the Mac mini, 
and 9 inches deep; the acrylic stand is 
2.5 inche.s tall, while the steel version is 
2.38 inches tall. 

And, well, that's about it. It's a stand. 
It's strong and looks nice. If you're 
sitting there thinking, "Aha! I can stack 
stuff on it other than my display!" 
well then go to the head of the class, 
genius. If you need stacking ideas, here 
are a few suggestions: a lava lamp, a 
framed picture from the EverQuest II 
Quest for Antonia Pageant, or maybe an 
autographed rugby ball from the 2005 ~ 

women's national collegiate champs, the ~ 

Stanford Cardinal. ~ 

The bottom line. Ah, desktop harmony ~ 

is restored.-Roman Loyola if 

mini Grandstand 
COMPANY: PRICE: $35 
Plasticsmith REQUIREMENTS: 
CONTACT: Mac mini 
800-394-3774, 
www.plasticsmith.com 
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ot _ist 
THE BEST OF THE BEST FRO M RECENT REVI E W S 

The Sims 2 
Contributing Editor (and admitted 
Sims addict) Cathy Lu says, "Between 
making babies, working, changing 
diapers, studying, exercising, and 
cooking mac and cheese, it's easy to 
get caught up in a Sim life." 

magi color r 
2 ODL~ 
According to imaging pro Arthur Bleich, 
this affordab le color laser printer 
"knocks out beautiful color images that 
are virtually indistinguishable from inkjet 
photos printed on matte media ." 

Blizzard World of Warcraft 

MacSoft Close Combat: First to Fight 

MacSoft Unreal Tournament 2004 

dobe lnCopy CS2 

Adobe lnDesign CS2 

Adobe Photoshop CS2 

Adobe Photoshop Elements 3.0 

ILY SlimDVDup 

LaCie Big Disk Extreme 500GB 

LaCie d2 DVD±RW Double Layer 

Sony DRX-710UL-T 

WiebeTech TrayDock 

$99.00 

$339.00 

$49.99 

$49.99 The sequel to the megapopular simulation is loaded with goodies. 

$49.99 Apr/05, p40 This rich online role-playing game is more addictive than nicotine. 

$39.99 Sep/05. p3B One of the most intense squad-based tactical shooters around. 

$39.95 Jun/04, p4B The best first-person shooter adds new vehicles and weapons. 

$249.00 Aug/05, p42 This workflow app amps up any lnDesign team's producti ity. 

$699.00 Aug/05, p40 A strong upgrade to the world"s most feature-rich layout app. 

$599.00 Aug/05, p38 A raft of new photo-focused features makes this upgrade rock. 

$89.99 Mar/05, p36 Adobe's affordable image editor gets a significant upgrade. 

$429.00 Feb/05. p38 This natural-media champ is now faster and more capable. 

$699.00 Apr/05, p45 Quickly duplicate CDs and DVDs without tying up your Mac. 

$399.00 Aug/04, p55 Cutting-edge technology provides cutting-edge performance. 

$179.00 Feb/05, p48 Cram 8.5GB of data onto DVDs with this speedy burner. 

$229.95 Jun/05 .. p46 This double-layer burner has scorching single-layer performance. 

$169.95 May/05, p49 This slick hard-drive enclosure provides the ultimate in flexibility. 
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SIGNATURES 
Can I have multiple email signatures for 
multiple email accounts in Apple's Mail? 

r;;~e !he kitties! 
work sig 

11 
·I 

!:] Place signature a ove quoted text 

Random signatures are fun until you 
accidentally send the offensive one to 
your girlfriend's mom. 

Open Mail> Preferences and click the 
Signatures tab . In Tiger's Mail 2.0, 
the far-left column lists your email 
accounts, the middle column lists 
your sigs (press the plus-sign icon to 
add one), and the far-right column is 
where you compose and preview your 
sigs-drag in an image to adorn your 
sig, if you must. Use the pull-down 
menu to assign default and optional 
signatures for each account. Now when 
you compose a new email message in 

quick 
answers 

CLEAN CONSCIENCE 
How can I completely erase the hard 
drive on my old Quadra 610 so I can 
safely donate it to charity? 
You'll have to boot off the Disk Tools 
floppy disk that your ol' Quadra came 
with. Find the Drive Setup utility on that 
disk, launch it, and click the Initialize 

56 MacAddlct November 2005 

Mail, the message window's twin pop
up menus let you select which account 
to send from and which signature to 
append. Mail 1.x provides the same 
features, only you have to click the 
Edit button to bring up the signature
composition window-but otherwise, 
it's totally self-explanatory. 

iPOD TRANSPLANT 
My iPod was big and roomy when I got 
it, but now it's running out of space. 
Can I upgrade the hard drive? 
Absolutely- provided you use the 
appropriate upgrade drive. If you have 
a first- or second-generation iPod-one 
with SGB, 10GB, or 20GB capacity 
and the buttons flanking the control 
wheel-you can only replace the hard 
drive with one from another first- or 
second-generation iPod. Finding the 
right drive might be tricky, but we've 
seen (allegedly) new ones on the block 
on eBay (www.ebay.com) . If you have a 
third-generation or later iPod, then you 
can slap in any current 1.8-inch Toshiba 
hard drive ($191.75 for 60GB, www 
.newegg.com) and the iPod will happily 
accept it. Consult Newer Technology's 
iPod-disassembly instructions (www 
. newertech.com/support); technically, 
the instructions refer to replacing the 
battery, but that's right next to the hard 
drive-you can figure it out from there 
yourself. Or you could pay someone else 
to do the deed foryou-TechRestore 
(www.techrestore.com) offers the 
service with prices ranging from 
$119.99 (to replace a SGB drive with a 
10GB) to $219.99 (to replace a 20GB 
with a 60GB). 

button to completely erase the Mac's 
hard drive. Be a pal and reinstall the 
Mac's operating system before donating 
it. Can't find your old floppy? Check 
Apple's Older Software Downloads 
page (www.info.apple.com/support/ 
old ersoftwa relist. html). 

PIXEL DEATH 
What's a dead pixel? 
Millions of tiny transistors make up 
an LCD display, and sometimes a 
couple of them fail. Apple actually calls 
these "pixel anomalies" because the 
transistors can either not work (creating 

WIDGET WHAT? 
I read on the Web that Mac OS 10.4's 
Dashboard widgets can cause security 
problems that could let bad guys mess 
with my Mac. Is that true? 
Dashboard widgets operate deep in the 
bowels of OS X, and indeed, a savvy 
developer could devise a widget to wreak 
all kinds of havoc-such as execute a 
Terminal command to wipe out your 
system. When you download a widget, 
it automatically installs itself into your 
/user name/Library/Widgets directory. 
To seal up this potential security hole, 
the OS 10.4.2 update added a pop-up 
alert to give you a chance to change your 
mind and not install the widget; it also 
added a Widget Managerthat allows you 
to easily turn off or remove from your 
system widgets you're not using. 

IS?J g """""""""' e 
IS?J Google e 
(0 • MoonPhase e 
(S?J Lij Add""'• Book 

~ Calculator 

iCALONTIME 

Widgets 
were kind of 
scary before 
Apple added 
the Widget 
Manager . 

The iCal icon in my Dock always shows 
July 17. Why this date, and how can I 
make it show the actual date? 
Steve Jobs first introduced iCal on July 17, 
2002- hence the default date on iCal's 
Finder and Dock icons. If you hadn't 
noticed, launching iCal updates the Dock 
icon to the current date (but iCal's Finder 

a dark spot) or stay on all the time 
(creating a bright spot) . If your display 
is plagued with such spots, take it to an 
Apple service provider and demand that 
they replace it. 

GIGABIT DIRECT 
Now that both my Macs have Gigabit 
Ethernet, can I still use a crossover 
Ethernet cable to connect them? 
Sure. You could make a Gigabit crossover 
cable (don't forget to cross all four pairs 
of wires), but your Mac's Ethernet ports 
are auto-sensing; they can connect to 
each other via a standard Ethernet cable. 



icon doesn't change). If you'd rather not 
manually open iCal just to get the correct 
date on its Dock icon, make iCal a Login 
Item (Tiger) or Startup Item (Panther) ; go 
to System Preferences> Accounts, click 
your user name, and select the Login 
Items or Startup Items tab. Click the plus 
sign and navigate to /Applications, click 
iCal, and then click Add to get iCal on the 
list. Bonus: Check the check box next 
to iCal once it's in your list to keep the 
app hidden in the background while you 
enjoy its date-accurate Dock icon . 

Show AU 

CourtntyZoUt:r 
Ml'·•Qtlf 

Mr.Clun .......,. 

Pusword Picture Login ftt.ntS ~I 

Thut Items wlll optn a utomatic.ally when you I 

Hide Item Kind 
l!1 ,81r~~ - - -As>olkaclon 
ezl ~ Extensls Sultcase XI Application 

~ LCCOaemon Applica1lon 

Add iCal to your Login Items, and its icon 
will display the correct date. 

NEWS GROUPIE 
Are newsgroups still around, and if so, 
can I access them in Mac OS X? 
Newsgroups sprung up in the late 
1970s and are still popular among 
academics and info purists who cringe 
at the commercialization of the Internet. 
They' re a great place to meet people 
who share whatever obscure hobby you 
might enjoy-there are currently well 
over a hundred thousand newsgroups; 
thousands of new messages appear 

daily. You' ll need a 
ON THE newsreader (and an 
DISC ISP that provides 

MT-NewsWatcher 
X 3.4 (Class ic), MT
NewsWatcher 3.4 (Mac 
OS X), Unison 1.6.3 

access to the Usenet) 
to join in : We like 
Panic's Unison 

UNINSTALL NORTON 
How can I totally remove Norton Utilities 
from my Mac OS X computer? 
Use your favorite FTP client-we like 
Fetch Softworks' Fetch ($25, on the Disc 
or download from www.fetchsoftworks 

"'-~~* NortonUn\nsta l l . command 4 .20 ********* 
WARNING: This proQrom wil l remove all files and fo 

OS X products and any ft Les within those 
will lose ALL fi. Les that reside tn those 
that you hove created. 

1 - Remove a ll Synt0ntec files/folders. 

2 - ~it . Do not remove any f\les . 

Enter choi ce (1 or 2): 1 

Beat it, Norton! 

TERMINAL UNIX 
I should know what the Terminal is, but I don't, really. Is it Unix? 
Mac OS X's Terminal application 
(/Applications/Utilities) emulates a 
Unix command-line terminal, which 
is essentially a text-entry box-the 
only interface available to humans on 
some computers. Like the handy dialog 
boxes, OK buttons, and visual menus 
that make up your Mac's graphical user 

(gerOt1tno :-] ~col -Y 2006 
2006 

January F~bruary Morch 
S HTuW Th F S S l1Tu WThf S S MTuW ThFS 
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22 2J 21 25 26 27 28 19 20 21 Z2 23 21 25 19 z:e 21 22 23 21 25 
29 30 31 26 27 Z8 26 27 28 29 30 31 

Apr! l Hay Jooe 
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23 24 25 26 27 28 29 28 29 30 31 25 26 27 Z8 29 30 
30 

This is way faster than iCal-and 
completely devoid of frills. 

($25, on the Disc or download from 
www.panic.com) and Simon Fraser's 
MT-NewsWatcher (free, on the Disc or 
download from www.smfr.org) . 

Anlme 

Crafts 

Disney 

Food 

Macintosh 

f Favon tH All Croups } 

.,. :'· al Animation C29'l 

"' a Disney Parks (AU) U444~ 

Disneyland® 12021 

I .. . 
I 

• I 

When you want to talk Disney World at 
three in the morning, try a newsgroup. 

.com) and Panic's Transmit ($29.95, on 
the Disc or download from www.panic 
.com)-to download NortonUninstall 

from ftp ://ftp.symantec.com/misc/ 
consumer/mac (leave User ID and 
Password blank). In the NortonUninstall 
folder that appears on your desktop, 
double-click NortonUninstall.command. 
This will open a Terminal window; enter 
your password at the prompt, press 
Return, and follow the 
onscreen prompts to 
remove all vestiges of 
Norton Utilities from 
your system . 

ON THE 
DISC 

Fetch 5.0.2, 
Transmit 3.2.1 

interface (GUI) , the Terminal's command
line interface (CU) can control any and all 
aspects of the system, but it uses tools 
known as command-line utilities. The 
command line is an efficient way to get 
right down to business. 

While iCal provides convenient 
alarms, reminders, and to-do lists, what 
if you want to see how many five -Friday 
months are in the current year? You 
could hop through the months in iCal 
and hope you don't lose count, or you 
could launch Terminal and type cal -y 
instead. The cal command activates 
Unix's internal calendar, and adding the 
-y option shows you the whole year. You 
can also display a specific month and 
year; type cal 12 9999toshowthe 
calendar for December 9999-the end of 
time as Unix's calendar knows it. 

ART EXTRACTION 
After I added album artwork to my 
iTunes music collection, I can't fit as 
many songs onto my iPod. Can I get rid 
of all the album artwork on my iPod? 
iTunes embeds cover art directly into 
audio files, so an album worth of tracks 
with cover art can eat up an extra 5MB of 
your iPod's space. To remove the artwork 
from multiple songs at once, select 
multiple songs in the iTunes browser and 
select File> Get Info or press Command-I. 
On the right side of the Get Info window, 

check the box next 
to the little white 

. square labeled 
Artwork, and click 
OK to ditch all 
artwork currently 
attached to any of 

Cover art, begone! the selected tracks. 

,~Buz i s a graphic designer living in 
~Florid a. He has been a devoted Mac 

user for over 10 years and has worked for 
both Apple and Power Computing. 

S b •t technical questions u m1 or helpful tips directly 
via email (askus@macaddict.com) or c/o 
MacAddict, 150 North Hill Dr., Ste. 40, 
Brisbane, CA 94005. 
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58 /1 HOWTO 
tr make a chaptered podcast 

Make a Chaptered Podcast 
By Dan Pourhadi 

WHAT YOU NEED 

iTunes 4.9 or later (free, www.apple.com) 

.Mac account ($99 per year, www.mac.com) 
or other Web space 

iLife '04 or later ($79, www.apple.com) 

ChapterToolMe (free, www.rbsoftware.net) 

Podcast RSS Buddy ($19, www.christolley.com) 

ON THE 
DISC 

Podcast RSS Buddy 2.1, 
ChapterToolMe 1.4 

P 
odcasting-broadcasting iPod-friendly audio 
programs via the Internet-is all the rage with 
everyone from hipsters to hippies to plain folk who 
are just fed up with the wasteland of commercial 

Before you dive into podcasting, you ' ll need to get 
organized. Create a folder named Podcast on your 

desktop-th is is where you'll store all the files associated with 
your podcast to keep things tidy. Create another folder inside that 
called Images, and copy over any image files you want iTunes to 
display in the Album Artwork pane while your podcast is playing. 
Finally, mount your iDisk (Go> iDisk >My iDisk) and open the Sites 
folder; inside, create another folder named Podcast-this is where 
the finished pod cast will go. If you have a Web space other than 
.Mac's iDisk, ask your service provider how to access it. 

Now it's time to record your podcast. Launch 
GarageBand (/Applications/GarageBand), and select 

Create A New Project in the dialog that appears, or-if you 
already have a project in the works-select File> New (or press 
Command-N) when the main GarageBand window opens. Name 
your project Podcastl (or whatever you like) and save it to the 
Pod cast fold er you created on your desktop-leave the settings 
alone, and click Create. 

In your new project, select the default Grand Piano track and 
delete it (Track> Delete Track or Command-Delete), then select 
Track> New Track and select the Real Instrument tab. Click 
Vocals and pick an effect-or, most likely, No Effects-from the 
list, and click Create. Finally, click the Record button to start 
recording, pontificate your punditry, and then click it again 
to stop. Use GarageBand's playback controls to listen to your 
show; and if you hear too many awkward silences, use the Split 
(Edit> Split) and Join (Edit > Join) commands to remove them. 
For more information on recording your podcast in GarageBand, 
read Apple's tutorial at www.apple.com/support/garageband/ 
pod casts. 
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Exercise your first-amendment rights with your very own 
chaptered podcast. C'mon, everyone's doin' it! 

radio . Happily, creating podcasts is as easy as listen ing to 
them-well, kinda sorta. Follow along as we create a pod cast 
complete with audiobook-like chapters, titles, links, and 
images that display in iTunes while your podcast is playing. 

0 ite ms. 82.6 MB available 4 
The key to success is always staying organized. 

~ Show A ll 

Band Inst ruments 

Basic Track 

Bass 
Dru ms 
Effects 

Gu itars 

[ 

.,. Details ... 

!i 
I> No Effects 
I> Ambient Vocals 
I> Deeper Vocals 
.... Ep ic Diva 
I> Female Basic 
I> Female Rock Vocals 
I> Helium Breath 

Live Performance 

Male Basic 

Male Rock Vocals 

Input : ( Channel l & Z (Stereo) 

Volume : "' ~ .------+· .. --~ 

Monitor: ..._! O_ff _ _ _____ _,__,: J 

( Cance l ) 

Unless you wanna sound like Barry White or the Chipmunks, 
choose Male Basic, Female Basic, or No Effect. 



In GarageBand, select File> Export To iTunes. When 
iTunes automatically opens, select iTunes >Preferences 

and click the Importing tab (click the Advanced tab first if you're 
usi ng iTunes 5) . Make sure the Import Using option is set to 
AAC Encoder; in the Setting drop-down menu, choose Podcast 
(Spoken Podcast in iTunes 5) and click OK. Go back to your 
iTunes Library and locate your podcast, which should be named 
after your GarageBand project (Podcast1 in our example). 
Control-click (or right-click) it, and select Convert Selection To 
AAC. Afte r the conversion is complete, Control-click the newly 

Now it's time to add some flair to your audio-only 
podcast. Fire up ChapterToolMe (free, on the Disc or 

download from www.rbsoftware.net), which lets you add 
chapters with titles, links, and images. Drag your podcast 
audio file from your Pod cast folder to the icon in ChapterToolMe 
labeled Drag The AAC File Here. Add a chapter by clicking the 
Add A Chapter button, then drag the black arrow on the timeline 
to where you want the chapter to begin . Change the chapter
specific settings (such as the chapter's title or associated 
image) by selecting the chapter you want to edit, clicking the 

Your podcast is now on line- but how is anyone going 
to find it? For that, you'll need to create an RSS feed 

for the podcast that iTunes can use to locate your podcast 
episodes. Fire up Podcast RSS Buddy ($19, on the Disc or 
download from www.christolley.com), select your time zone, 
follow the onscreen example (or the screenshot above) to 
fill in the info, and then click Save; next, Podcast RSS Buddy 
presents its main interface, which lists your p0dcasts and 

Click Podcast RSS Buddy's Add A New Episode To 
Podcast button . (If you have multiple podcasts, select 

the target podcast from the pull-down menu first.) Fill in the 
required fields, and in the Podcast Link box, type http:// 
homepage.mac.com/user name/ Pod cast /Pod castl 
.m4a, replacing user name with your .Mac account name. 
Click Preview to see a mockup of how iTunes will present your 
podcast info, then click Close. Click Publish To Disk, and when 
you're asked for the name of your feed , type feed and click 
Save. Podcast RSS Buddy will place a file called feed .xml on you r 

Your podcast is ready-now it's time to drum up an 
audience. The best way to do that is to get listed in the 

iTunes Podcast Directory. Launch iTunes and select Podcasts 
from the Source list on the left side; click the Podcast Directory 
link at the bottom of the resulting page, and then click Submit 
A Podcast on the directory page. In the Podcast Feed URL field, 
type ht tp : //homepage.mac.com/user name/Podcast / 
feed.xml, replac ing user name with your .Mac account name. 
Review your podcast submission - if it looks right, click Submit. 
If you've minded your Ps and Qs, not used any copyrighted 
materials, written a captivating description, and come up with 
intriguing artwork, then the 'Pod gods may approve, and your 

Im po rt Using : ( AAC Encoder 

Setting : ._, High Quality (128 kbps) ... . 
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podcast, 
Apple's ready 

created track, and select Show Song File to reveal the file 
(Podcastl.m4a in our case) in a Finder window. Option-drag 
that file to your Pod cast folder to copy it there. 

Step One - Organize Yoursel 
'step Two - On The Air 

is easier than 
thinking of an "as 
easy as" simile. 

Toggle Info View button , and modifying the various fields. Once 
you've finished adding chapters, click Create The Chaptered File 
and save it to your Podcast project folder. Finally, open the new 
file in iTunes to make sure your chapters are set correctly. Copy 

that file to the Pod cast folder you created on your iDisk. 

Title: Pourhadi Podcast 

Long Description: This is the Pourhadi Podcast from llfl'I 
Dan's .Mac IDisk. ~ 

~ · -Short Descri ption: I Pourhad l's Personal Podcast tn' 

anyone to download 
your podcast, be 
descriptive when you 
make your feed. 

provides options to add episodes to existing podcasts, edit the 
podcast's settings, or delete a podcast. 

0 , ... (!luml&) 

you preview 
how your 
podcast will 
look in iTunes. 

desktop ; copy it to the Pod cast folder on your iDisk. When you 
want to add a new episode, simply repeat step 6 and copy the 
new feed .xml file to your iDisk, replacing what's already there. 

~·~-· .... ··-···""''"'""\!' ~wu;S>O<l"100.UOVttUM.~. ~ng o 
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the actual podcast 
file , to iTunes. 

podcast should show up in iTunes' Podcast Directory within a 
few days. Congratulations-you're a podcaster! 
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Find Your Effin' Cursor 
by Niko Coucouvanis 

WHAT YOU NEED ON THE 

Mac OS 10.3 or later 
DISC 

Mouse Locator (free, 
www.2point5fish.com) 

I 
n these days of splendiferously 
acre-acious 30-inch Cinema 
Displays and multiple-display 

Mouse Locator 
Mac setups, finding your cursor 

can be a real eye-straining pain . Here are a few of our 

favorite tricks for keeping track of that pesky pointer. 

Control-Click Cursor Detection 
The simplest way to locate a shy cursor is to right-click (or 
Control-click) your mouse; a Contextual Menu will pop up at 

the cursor's location-unless the cursor is in a window's title 
bar, border, or scroll bar. The fatal flaw: Right-clicking may 

change the currently active window, release any selected 
items, or cause 

other mayhem. 
Besides, we've 
got better ways to 
go cursor hunting. 

Control-clicking 
works great if 
you're not in the 
middle of doing 
something. 

Supersize on the Fly 
To zoom in on your 
cursor with a single key 
combo, go to System 
Preferences > Universal 
Access> Seeing, and 

click the Zoom On radio 
button (Tiger) or Turn On 
Zoom button (Panther). 

Click Zoom Options to 
configure the zoomage 

(up to 20x) and tracking 
options. We like So The 
Pointer Is At Or NearThe 
Center OfThe Image. 

Set rangt for ro1pid z.oomlng In .. nd out: 

Maximum Zoom:----- -----
I ! I' I I I 'I I' I I It I' 

Mf9rtiltu11ot1W· 2 ' r. a 10 11 I• ltj; It 2D 

Minimum Zoom: 6 ' ' • , ' , ' ' ' , ' , ' ' ' , , 
key~rd short<uu can ~ u•td any lime zoom is on. 

To zoom put 1ht maximum or minimum u 1Ung. hokl down 
JC"\".111of X'\:"-, 

Show pr.view rtcungk wht.n zoomed out 

~Smoo1h lmo1ges (Prtss"XX\ to tum smoothing on or oft} 

Zoom follows the keyboud focus 

Whtn zoom1d In, the sc1un Image moves. 

0 ConUnuou1ly with polnt'r 

Q only when the polnier 1uches 1.n t dge 

e So tht pointer Is o11 or nor I~ «nter oftht lmo1ge 

Warning: Zooming the view too quickly 
may induce nausea. 

That way, when you press your zoom-in hot key-by default, 
Command-Option-Plus (+)-the screen centers on your cursor. 

Enlarge the Sucker 
Mac OS 10.4 (Tiger) introduced cursor enlargement, whereby you 
can jack your cursor up to a fairly ridiculous size. Open System 

Preferences> Universal Access, click the Mouse tab, and twiddle 
the bottom slider until you get a hon kin' Playskool-style cursor. 
Unfortunately, that's not ideal when you're trying to impress the 

.. ..... ___ ,,..... ...... _. __ _ ............... -.... --~·----- ... - .... -~-·-... _ .... ___ ·-·---·-·-'···-·--
::;;.:~::::::::::~-·---
....... , ____ ,...._,... .. _ ..... ----~--·---.. -·------.. ·-~·- ... ---... ... ·~--- ... --·-----~--
___________ ... _,,.. __ ,, ___ ......... __ ... ______ _ 

·""""""' .... "' ·---··-·- ... .. -... ,.. ___ ... ___ .... , ... ___ _ 
-~-- ...... ---.. - ...... -, ___ ,.. ___ _ ........ __ .. _ .... _ ...... --··-"'·- ....... -. __ .. __ .. __ •. _ .. _ .... _ .. ._ ..... _ -~-~--
Supersize Even More Fly 

new office cutie with 

your youthful vigor. 
See "Supersize on 
the Fly" for a way to 

zoom when nobody 
else is looking . 

If you're not shy about 
your fading vision, a 
big cursor is kind of 
avant-garde. 

To streamline the zoomage, turn Zoom Off (again, in System 

Preferences> Universal Access > Seeing) and click the Options 
button. Set the Maximum Zoom to around lOx. Now you can use 
the zoom hot-key combo to instantly enable and disable the lOx 
zoom. (Unfortunately, this only works in Tiger-sorry Panther.) 

Like all of your Mac's keyboard shortcuts, you can change the 
keystrokes via System Preferences > Keyboard & Mouse; just 

click the Keyboard Shortcuts tab. 

On Oturllltllin 
S- YS<TmSholf --- - -
!f S1Vtpkrureolw:1nnnlilile 
@I Copy plcttlre of j(letn 10 t~ dipbcwd 
~ ~plclureof wlecudarn.uatile 
&!I Copy plaur• of scl.t<ltd 1.ru 10 1tie dipbo:ud 

( fz'!~~~!li!!;;11 . :: 
!I Zoom in 
! Atvusebl<1<kandwhl1e 

fl 
Don't like the 
default zoom key 
combo? Then pick 

In the time-honored tradition of leeching off the hard work of others, the slickest way to keep track of 
your cursor is with Mouse Locator (free, on the Disc or download from www.2point5fish.com). In sta ll 
this freeware gem and follow the directions to configure Locator's beacon, a target-like graphic (which 
you can customi ze) that appears around your cursor when you move it after a 
specified period of inactivity. We set the Trigger Delay to maximum, Display Time 
to minimum, and our hot key to Fl so we could instantly summon the locator, find 
our cursor, and be done with it. 
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Talk about having 
a target painted 

on your back. 



UPGRADE AMNESTY 
Upgrade from ANY Copy of Poser for Only $9999 

Poser 6 includes advanced features such as OpenGL preview, breathtakingly realistic 

high-res figures & content, Image Based Lighting and Ambient Occlusion for real-world 

lighting and soft shadows. 

Buy it Now at www.e-frontier.com/go/macamnesty 
Poser is a trademark of e frontier America, Inc. A ll other trademarks are the property of their respective owners. All rights reserved. 
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fJJ get smart with Spotlight 

Get Smart with Spotlight 
by Niko Coucouvanis 

Spotlight puts untold file-finding power at your fingertips-as 

long as you know how to use it. If you simply press the 

Spotlight menu-bar icon to start a search, you're missing out 

on some of the good stuff: one-click searching, tons of obscure 

(and useful) search-limiting criteria, and advanced filtering logic 

to narrow down your searches . Here are five ways to become a 
smarter Spotlight user. 

Serv(ic)e Yourself 
Cocoa apps (such as 

TextEdit, BBEdit, and 

Flit Edi! 

Abcut TutEdlt 

P1rftrtnns ... x • 

ForlNl Wlrldow litlP 

Uittllltd 
. _ ... ~ 

BBE.dil 
Cl'llnutTutConverttr 
011klhUUy 
FlndlnWordM!rlU 

Safari) support Mac OS X's 

Services; such apps benefit 

from the Services menu and 

the Spotlight item contained 

HldeTu1Edl1 XH 
Hldr.O!;hr.n "\:XH 
Show AU Flndtr 

~"'~"-Tu_<E4_1<_XO'-"' ~:~1u~0~1h l •llE<Mchy 

Cnb 

therein. To use it, just highlight a word 

or phrase in a document window and 

select-in TextEdit, for example

Application >Services> Spotlight. This 

bypasses Spotlight's menu-bar input. 

Cmpon lm1111t 
1n1erarchy 
IUHKtllghlUMP 
1.oolcUplnOlcllonary 
Malt 
Malbmlth 
Mlkt NtW5UdcyNott 
01MnURL 
OpenUP.Lln Clmlno 
~Ull.lln()pt~ .,.,. 
POP 
Pnn1fllt usnng .•. 
PrlntSt ltCllon 

I 

' 
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' 
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••• 

' 

5trlptCdltor ., 

The Services menu reveals yet another 

Spotlight shortcut: Shift·Command·F. 

Surch With Google OXL 
StndFlltTolllue!OOthDtvi(t .•. i'JXll 
Spuch 

SummulH 

Pick Up the Slack with Plug-ins 
Spotlight chokes on some application-specific file formats 

(including AOL Memos, OmniGraffle, DeltaGraph, and a few 

others). It can't index the contents of such files, thus neutering 

any search-by-content fantasies you might harbor. This is where 

plug-ins come to the rescue; Apple keeps a repository ofthird 

party plug-ins for adding Spotlight support. All you have to do is 

find your app's plug-in at www.app le.com/downloads/macosx/ 

spotlight, download it, and follow the included installation 

instructions. 

.,_ • CJ Apple.Works.mdimport'e.r 
Lj Ke.ynote.mdimponer 

IJ!~~~!!.!!!!.!.._....,:~g~m···~ c::> Melle.l .mdimporter 
~·p Microsoft Office.mdimporter 

"' ~ Page.s.mdlm orter 

Even some Apple apps, such as AppleWorks and Keynote, need 

plug-ins for Spotlight support. 

Boolean Is Not a Ballroom-Dance Step 

Searching ·computer'" 

t:) Uger2_data.csv 

~ wh1ne-d~s ~ 
-fij winNOs -- ·-

Home 

Select an nem ro see its path. 

12 items 

. _ -~---8{1SJOS 1132_! A~ _ 
---- To~av at 11;4~ ~~

Today at 11:4 7 AM 

"Find flies created by Max, containing Apple or Mac and Intel, but 

not Windows." 

Take It out of Context(ual Menu) 

Another built-in Spotlight shortcut wo rks in Cocoa apps as well 
as their Carbon (Mac OS 9 and X) counterparts: the Contextual 

Menu. To Spotlight-search an item in a document or Web page, 

simply highlight the word 

or phrase and Control

click (or right-click with 

your Mighty Mouse 

or other multi button 

mouse). Then just select 

Spotlight from the 

resulting menu. 

Right-click your Mighty 

Mouse for some context. 

l,TakeltOutOl~MMu) 

Anoihtt bunt-in shoncutto Spotli1tc worlu In Coco;1 apps as wet! u lh t'l 

~~;-=~~~~=~'~ 

S. Go Raw" Or6o Horlt1 
Spottlght rs way smantr whe 

Foldttor Fl!e>Find). Thtdth1u!t 
Op1ntdandstltt:1.21tst,from1 
ln to1hl1Mstede.ooltanthl11a. 
lon1uyou'rthne.addviyoc 
tak~'lliththeH.uhonorotr. 

"· Do I from Thi D»hbowd 
Asawesomtas 1he~ 

1£1 ;.,. l '" 1 

xx 
xc 
xv 

Font... X D 
Paragraph... '"\:XM 
Bullets and Numbering .. . 

Look Up 

Hyperllnk... XK 

Get URL With lnterarchy 

Remember to Re-index 

If your Spotlight searches seem to be missrng items, or if you 

download a Spotlight plug-in as described above, you can 

force Spotlight to re-index your hard drive to add those items. 

Open System Preferences, and click the Spotlight icon; click 

the Privacy tab and drag whatever you'd like indexed into the 

window. Then select the item and press the minus sign to 

remove it from the list; in 

a few moments, Spotlight 

will begin re-indexing the 

drive or location. 

Don't sweat the reported 

time remaining-this 
purported 6·hour job 

took 45 minutes. 

Indexing .. . 

Spotl ight helps you quickly find things on 
your computer. 

Spotlight will be available as soon as the 
contents of your computer have been 
Indexed. 

tndexing Cuomino 

Abou1 6 hours rr.m;1 lnlng 

Spotlight is way smarter when you speak its language-Boolean logic. Invented by George 

Boole in 1848, Boolean logic classifies items based on three relational operators : AND, 

OR, and NOT. Apple integrated these operators into Spotlight so you can type thislthat to 

search for either this OR that, this that to search for this AND that, or this -that to find 

this but NOT that. See MaclnTouch's excellent "Tiger Review: Exa mining Spotlight" for more 
(www. maci nto uch .com /tigerrevi ew I spotlight. htm I). 

62 MacAddict November 2005 

Boolean AND, NOT, and OR operators 

can help you search far and wide-or 
really narrow. 
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~aving trouble getting your point across? 
fry an application that's actually designed to make this stuff look good. 

@MITTJ~~LJCQJ{f[f~® ~ 
Powerful diagramming and drawing made easy 

Download a free trial of the brand new version at www.omnigroup.com/macaddietl 1. 
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Make Your Mac a GarageBand Singer 
by Niko Coucouvanis 

Before you make Zarvox sing, get to know thy GarageBand interface. 

WHAT YOU NEED 

GarageBand 2 ($79 as part of ilife '05, 
www.apple.com) 

Soundflower (free, www.cycling74.com) 

Your Mac has voices in its head : 22 of them, to be exact, and they've been there for years. So why aren't you 
using them? We'll show you how to use TextEdit, GarageBand, and a freeware app called Sound flower (free, 
www.cycling74.com) to turn your Mac's voice into a superstar singing sensation . Now get ready to rock! 

ON THE 
DISC 

Open System Preferences >Speech, and click the Text To 
Speech tab (Default Voice in Panther). Preview a voice 

by selecting it and pressing the Play button-most of them are 
pretty lame, but the human-named choices (Agnes, Albert, 

Fred, et cetera) are more intelligible than choices like Cellos, 
Bubbles, or Zarvox-but that's the beauty of music: to each 
his or her own. Once you've selected a voice, tweak the rate of 
speech if you desire. Now check the Speak Selected Text When 
The Key Is Pressed check box (in Panther, click the Spoken 
User Interface tab to find this box) . Click the Set Key button and 
specify a hot key or key combo in the resulting dialog box. 

Speaking Ra1e : --~-;--' -~-
s~ Normal rm 

Announce when atem ire dlsplaved 

Announce when ,1.n apptlutlon requlru your attention 

~ Yousay 
"banana," Zarvox 
says "b'nana"

~Speak selec1ed mo when the kev Is pressed ~ 

changing the 

Speaking Rate 
can fix that. 
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Now it's time to tell the Mac what to sing. Launch TextEdit 
(/Applications/TextEdit); in a blank document, type 

what you want your Mac to say, click and drag.to select it, and 
press the hot key that makes your Mac speak. Chances are 
it won't sound quite how you hoped it would-but that's OK. 
Change word spellings to alter the Mac's pronunciation, and 
use punctuation (mainly commas, periods, and line breaks) to 
control the pacing. The particulars vary with the different voices, 
so listen, tweak, and repeat until you ' re satisfied . 

• Tu;tEdlt File • l'in• Format Window He.Ip 

8 Q e I Undo TyplnG XZ l'-----1 

~~ ;::o K: ......,...~~......-.< 
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I'm too toity fGr my sh Paste and Ma!Ch S1yle ~!>XV 
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~:! 1~~r~o::c1·~:::~ M Compltlt 
And I'm too 'c)(y lor ~ St:IKt All 

~°: _::;~:.':r;f,°: :0a~, Insert 
rm o modd you know ' Find 

~==h' ! :: ~~~i>l':~ni Spe1Un9 
1 do mr llute tur11 on th·····••IJ!lll!,!:£,.~.,illl,.!!,,111.,,• 
~~o ~°:x:e;: ::; my ca~ Special Charmers ... ~XT 
And rm to<> nxy fOI" m 
Too SC!llY for my h.3t wh<it do you think llbo\lt th.At 
I'm 1 modtl yo1.1 kl\OW whit 1 mean 
And I do mv Uttle turn on the C4twalk 

Avoid this mouse 
marathon by using 

a hot key to trigger 

speech. 



To get your vocals into GarageBand, you need to set 
Soundflower as the system's audio output and as 

GarageBand's audio-input source. First open System Preferences 
>Sound and click the Output tab. Select Soundflower (2ch) and 
close the window. Now go to GarageBand >Preferences, click 
the Audio/MIDI tab, set Audio Input to Soundflower (2ch), and 
close the window. Now click GarageBand's New Track button (it 
looks like a plus sign), click the Real Instrument tab, and create a 
Vocals track with No Effects. 

Ol'umJ 
Effuu 
Gulm 1 
voe.i s 

o • I 
""" Noetfeas 
,. Ambient Vocals 
,. Ouper Vou h 
,. Epfc Oiva 

You need to create a vocal 
track before laying down 
the vocals-

To cut a loop out of the live recording, double-click the 
track in the track list to open it in the Track Editor. Now 

move your cursor over the track in the Track Editor-when the 
cursor turns into a plus sign, click and drag to select the length 
of audio for your loop. Select Edit> Add To Loop Library. In the 
resulting dialog, enter a name for your loop, and select the 
appropriate descriptors so you can find it in the crowded Loop 
Library. Now click the eye to open the Loop Browser, find your 
loop by name or classification, and drag it into the track area. 

Double-click the track 
(1), then click and drag 
in the timeline (2) to 

Since the Zarvox loop is a recorded Real Instrument, 

you can adjust its pitch via the Region pane. Double
click your Zarvox loop to open it in the Track Editor, then use 
the Region Pitch slider to match your loop's pitch to the Master 
Track's. To change the song's overall volume or pitch, select 
Master Volume or Master Pitch from the Master Track's pull
down. Click anywhere on the line to add a control point, then 
slide the point up or down to raise or lower the value; then click 
again further down the line to set another control point. 

Tweak a loop's pitch with Region Pitch, and when you're done 
mixing, set the pitch for the whole song using Master Pitch_ 
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In TextEdit, select the text you want your Mac to speak. 
Then click Garage Band's Record button, go back to 

TextEdit, and press your speech hot key to start the Macophony. 
When it's done, click GarageBand's Record button again 
to stop recording. To hear the results, you'll have to switch 
Garage Band's audio output from Soundflower to Built-In Audio, 
or you won't hear any playback. 

Once you record your vocal track, it's ready for you to edit and add 
effects and accompaniment. 

Every GarageBand project contains a Master Track, 
which you can use to set the overall volume and pitch of 

a song-as well as the default Echo and Reverb effects . Select 
Track> Show Master Track, then double-click on the Master 
Track in the tracks list to open its Track Info window. Click the 
Details triangle to reveal the preset Echo and Reverb. Settings 
you change here trickle down to the other tracks; open any 
track's Track Info window, and you'll find Echo and Reverb 
sliders-use them to apply some or all of the Master Track's 
Echo and Reverb on a per-track basis . 
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The Dance Energy preset 
combines a custom Echo 
with the Large Hall Reverb 

Now add a Compressor effect to tighten up your audio 

levels. Double-click the Master Track to open its Track 
Info window, click the Details triangle, and set the pull-down 
menu beneath Echo and Reverb to AUMultibandCompressor. 
Pick a preset from the secondary pull-down menu to the right, 
or if you're brave, click the little pencil icon to dig into the 
effect's parameters. Note that AUMultibandCompressor is one 
of the most complex effects in GarageBand, so if you don't use 
a preset, get ready for a lot of trial and error. Finally, uncheck 
Compressor in the Track Info window. 

AUMt.1lllb~pr11M1r 

rtknelknol.. 

C•OtUIWt2: 

( fOJIQlo ... f) ; 

tw:~ooml. 

[Q l : 

fUl mdSmc>oth 

Sutl Comn:iil J = r-40.0 -0:0dl 
'----"-"-.co.o --0:0 di 

0.01 

... 
- 10.0 

....... ~---0.20 0.02 St.ts 

-~--~J.00 0.04 St:n 

- -e----n oso loo.o Hz. 
---e-~-22oso ~ 11: 
- ---- llO'SO -.000 Hl 

--:&a" di 

~-~-e-- co.o l'Mc11 
20.0 -0.0 di 

GarageBand gives you easy 
access to Apple's powerful 
Audio Units- but even we 
don't yet fully understand all 
the options. Use a preset, or 
prepare for a headache_ 
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"Mirrored Drive Doors• models 

"Quick Silver" models 

"Digital Audio" "Glgablt Ethernet" 
"Sawtooth" "Yikes• models 

Competitive prices 

See these and more featured 
PowerMac G4 Enhancements 
at macsales.com/motm 

ual ty products Expert tech staf 

NEW! 
High-Performance 
Video Card 
supports Dual 
Displays & capture 
ANToo!~ 

Hard Drives 
uptoSOOGB 

starting from 
~ 

Memory 
More Memory = Faster Mac 

Did you know memory makes the difference? 
For today's applications and OSX, increasing your 

memory to 768MB or greater can more than DOUBLE 
the performance of your Mac! See fewer 'spinning beach 

balls' and notice how much faster your Apple is with the right 
memory! Speak to one of our knowledgeable owe reps at 800-

275-4576 or use our online memory guide at macsales.com/memory 

PowerMac GS & iMac GS 
All Models up to Dual GS 2.SGHz 

184 Pin DDR DIMM upgrades 
512MB module $55.99 

lGB module $129.99 
lGB kits $109.00 

2GB kits $249.00 

PowerBook G4 
Aluminum & iBook G4 

{all models) 
All Models up to 1.67GHz 

200 pin DOR 50-DIMM upgrades 
512MB from $54.99 

1GB from $139.99 
lGB Samsung Factory 

Original $169.00 
Same Module installed by Apple 
for less than half the price! 

Your Online Mac Upgrade Center 

All PowerMac G4, 
eMac G4 & iMac G3/ 
G4Models 
SDRam or DOR Memory 
module upgrades 
256MB from $28.95 
512MB from $54.99 
1GB from $119.99 



Internal Options 
PowerMac G3/G4/G5, iMac G4 

and eMac G4: Apple Genuine 
4X SuperDrive DVD-R/eDRW only 

$45.00. Up to the latest Pioneer 16X 
DVDRW w/DL 40X CDRW for $59.99. 

And 4 Value Bundles starting from just 
an extra $5 add media and software that 

makes getting started even easier! _ l 
PowerBook G4s and iMac GS LJ 
owe Mercury BX DVD w/ DL Internal 
'SuperDrive' Kit $159.99. Includes Dantz 
Retrospect, Dragonburn and 10 pieces 
of DVD-R media. 

External FireWire/USB2 Options 
Any Mac with available Fire Wire or USB 

High Performance FireWire & USB Storage 
Mercury Elite Series 

You can use Apple's iDVD, 
iPhoto, iTunes, Discburner, 

etc; Roxio Toast; nearly 
any CD/DVD authorizing 

software ava ilab lel 

FireWire 400, 800 & USB combo solutions. High-Performance for 
the most demanding audio/video, backup, music, and. general 

storage needs. 

-==~~~= 

owe Mercury Pro 16X DVD SuperDrive External 
FireWire/ USB Solution $139.99. Includes Dantz 

Retrospect, Dragonburn, 
5 pieces of DVD-R 

media and 25 Pack 
eD-R media . 

Hard Disk Controller Cards 
rma 
Seria l ATA 4-Channel PCl-M $79.95 
l@NN\!llr 
Tempo ATA & SATA Mac PCI Controllers 
Tempo SATA/ 150 $75.99 
Tempo HD Ultra ATA/133 $78.95 
Tempo Trio FireWire/ USB2/ATA-133 
all in one PCI $149.00 

FirmTek 
2-Channel SATA Controller $63.99 
4-Channel SATA Controllers 
from $119.95 

SATA External Enclosures 
owe 
* NEW* OWC Mercury Elite-AL SATA 
DUAL BAY $99.95 

FirmTek 
Dual-Bay Hot Swap External Serial ATA Enclosure 
w ith SATA PCI Controller Card $257.95 
l®NN@r 
Sonnet Fusion 4-Bay SATA Kit $549.00 

,.,,~~~'!:lil''~ll Most Popular: 
Elite Pro FW400+USB2 Combo Solutions 
2SOGB 7200RPM 8MB Buffer 
300GB 7200RPM SMB Buffer 

Elite Pro FWS00/400 Solutions 
16068 7200RPM BMB Buffe 
250GB 7200RPM SMB Buffer 
400GB 7200RPM BMB Bulfer 



Mac Improvement 

Rain Design 1360° 
A Turntable for 
your IMac GS 17" 

eye candres for 
yourlMac.Slx 
to cfioose from. 

iPod Replacement Batteries & Enrichment Products 

n > OE!LUE!rt:ec:hnologyi 
iPod Replacement Battery Kits 
Easy to Install, Tools Included+ Online Installation Videos. 
Get up to 78% more capacity & 20+ Hours Runtime! 
NuPOrNer Q.-l!!ti!!' "\i@lii!I ~!.9',.-No_1_co_m_fo-r1-ab-1e_o_p-en-in-g-yo_u_r -. 

w w <ID <(Do iPod? Fo r $39 + the cost ofthe 
600mAh for mini $24.95 50%more capacity battery, OWC insta lls it for you 

900mah for Photo $29.95 28% more capacity · iPod shipping Box and FedE x 

750mAh for 4th Gen $25.95 20% more capacity ov:~~~:~e~~:~~~;~dai~~t~l~ml 
850mah for 3rd Gen $25.99 30%morecapacity 

' 1800mAh for 1st /2nd Gen $19.99 *While Supplies Last• 46% more capacity 

21 OOmAh for 1st / 2nd Gen $29.99 *While Supplies Last* 70% more capacity 

NEW! 2200mAh for 1st/ 2nd Gen $34.95 78%morecapacity 

RoadTrip & RoadTrip Plus 
Listen to your iPod on-the-road! 

iPod cases 

Finally, an easy to use and GREAT sounding FM Transmitter 
for your iPod! Just plug, tune a single station and jam on 

without interruption. Easier to use and sounds 
better than products costing 2 times as much! 

Network Adapters 
D·Llnl{ 
D-Link 10/100 
Ethernet PCI Card 

PRAM Batteries 

O'Reilly Books 
The latest Mac titles 
from~ Over30Mac 

Tl6esln Stocki 

RoadTrip~m Lt""tl!R'll'li!\IM 
FM Transmitter+ iPod Charger $27.95 

For iPod mini, 3rd Gen, 4th Gen, and Photo 
Models. Charges and broadcast s clean and 

clear- all in one . 
• ([i}JI 

RoadTnpf mE?.-i!!ii!!'*Wilt~!Y 
FM Transmitter for All Apple ~ 

iPod Models $14.95 

High-Speed Nat ionwide Dial-up and DSL Services 
Toll-Free Tech Support & More from Mac Experts 

from only Visit FasterMac.net or ca ll toll free $6 per month! 800-869-9152 to learn more or to sign up 

Shuttle Express 
Jog/Shutt le (5 
programmable 
buttons) 
$39.99 



ATI MacEdition Performance Video Cards 
When your Mac is Fast, Don't let a SLOW video card hold you back! 
PCI Video Upgrade for Performance or 
Additional Displays: 
All Radeon 9200 w/128MB for any 
Mac with an Available PCI Slot 
$127.95 
Up to 2048x1536 reso lution. 
Compatib le with up to 24" Displays! 

High-Performance AGP Video Card Upgrades 
*All of the following support up to two displays* 

For all PowerMac G4 Models: \ 

NEW! ATI Radeon 9600 $199.99 
2S6MB of high-speed video memory 
4x or 8x AGP 

NEW! I 
1 , ATI Radeon 

_ 9600only 

Dual DVI 
TV Out 

ATI Radeon xSOO MacEdition 
with 256MB $395.00 
TOP OF THE LINE GS VIDEO Card 
supports up to Apple's 30" Display! 
For PowerMac GS Only. 

- $199.99 , 

have 
with up to 6412•. 
• More Speed for Less Cost 
• Use all your existing memory, 

peripherals, etc. 
• Plug & Play and ZOOM 
• Works wl~h the Latest Software 

& OS X Ti9!!r tool 
• Makes youi::eurrent Mac like 

new again! . 

OWe Is your Apple Upgrades Expert. Everyday new 
customers are blown away by the.difference made by 
one ohhe upgrades we offer. even comments ti> the 
factofthelrold .system With an upgrade is laster than 
the neJNMac they bought stoc;kl On select upgrade 
l;>ra.nds, v..:e arepleased to offer a 30 Day Money Back 
Guar;mtee so you i::an see for yourself. Try one out, 
and If it's not from )!OU - we'O refund you 100% with no 
hassle. See what 'that old Mac' can really do, check out 
an upgrade from owe today! 

\ 
30 Day 

Money-Back 
on NewerTech, 

Powerlogix, and OWC 
brand upgrades! 



The Mac Experts! 
Located in Oregon, the land of forests, 
friendly people and no sales tax 

Hot Prices on Cool, New Macs! 
eMac G4/1.42GHZ 256/80/combo drive/modem . •.•. $799 
eMac G4/ 1.42GHZ 5121160/super drive/modem . . . .. • $999 
14" iBook G4/ 1.33GHZ 512160/combo . . . .. . . .... .. .• $1149 
12" PwrBook G4/1.5GHZ 512160/combo!AP ext . . .. . . $1494 
75" PwrBook G4/ 1.67GHZ 512180/super/AP ext . . .... $2388 
17" iMac GS/2.0GHZ 5121160/super/Airport/Bluetooth $1494 

----- 20" iMac GS/2.0GHZ 5121250/super/AP ext/BT . . . . . .. $1794 
Mac mini G4/1.25GHZ 512140/combo drive . . . .. .. . . . $479 
Mac mini G4! 1.42GHZ 512180/combo/AP Ext . . .. .. .. • $579 
Mac mini G4/1.42GHZ 572180/combo/AP Ext/BT . ... .. $629 
Power Mac dual G5/2.3GHZ 5121250/super . . . . . . ... $2488 

:..:, _ ·_ , Power Mac dual GS/2.SGHZ 5121160/SuperDrive •. . . $2599 

0 
Trade-In Your Mac! 
Thinking of upgrading to a new Mac? 
You can trade in your old Mac" for 
credit toward a brand new one. Call 
us today or go online to find out how 
easy it is to recycle your old machine! 

20" GS iMac DEAL 
Hard to beat this price on this great 
machine - complete with GS/ l.8GHz 
processor and 160GB hard drive! 

20" G5! 1.8GHz, 256MB RAM 
160GB HD/SuperDrive 
. . . .... . .. .... . $1499 

Look What 
Power Max 
Customers 

Are Saying! 

We Have Macs for Only $19 99
/ 

It's true, we're the web's largest Certified Pre-Owned Mac dealer. We 
have a massive selection of quality, pre-owned PowerBooks, iBooks, 
iMacs and PowerMacs. Choose from over 1200 configurations: 

\ - .. -~ 

Does Your Computer 
Break Your Heart? 

Beige Power Macs-· 7200s, 7500s, 8600s ••. .• . . . .. starting at $1999 

G3 PowerBooks -- wallstreets, pismos, etc. ••. . . .. . . starting at $459 
G3 iBoaks - clamshells, snows, etc. . •... •••.. . • . •. starting at $499 
Titanium PowerBooks .. . •.• .. •. . ... ..• . . •.. . .. . starting at $809 

Come check out the PowerMax 

Match Maker! 

G4 Power Macs -· graphites, quicksilvers, etc. .. . . . . starting at $329 
G3 CRT iMacs -· all colors available! . .. . .. . ... . .. . starting at $119 -
G4 LCDiMacs .... ... .. . .... .. .. ...... .. . . .. .. .. starting at $639 

All Certified Pre-Owned macs are thoroughly cleaned, inspected, bench-
tested and come with a 90-day warranty. 

r 

.ef' • 

If you and your computer have lost that lovin' feel ing, it might 
be time to look into a new Mac. In order to ease the transition, 
PowerMax created MatchMaker. All you need to do is answer 
a few questions and MatchMaker will provide an increasingly 
refined selection of Macs for you to choose from. With Match
Maker, you'll never get stuck with the wrong computer again! 

~~~~~~~~~~~~~~~~~~~~~~~ - ::;:, 

PowerMax PowerBook Battery 

only $119 
Last longer than 

any other bat
tery we've seen. 

For 15-inch 
Aluminum PB. 

. ' ... \ ' Dr. Bodel1"n's Get the most out of 
u Dr. Bodelm s_ J\lSt 1'· • your iPod with these 

Laptop ...,..f iPod Accessories cool accessories! 
Bumpers o Wireless iPod/iPod Mini Auto Adapter Kit 

just $ 19" ! Listen to the iPod over your car stereo via FM transmitter! 

A must-have for o Wireless iPod Shuffle Auto Adapter Kit 

I 
Same functionality as above, but for the iPod shuffle! 

every aptop. 7 o iPod Shuffle Portable Audio System 
colors available! Your shuffle becomes a boombox with these compact speaker 

o Silicon iPod Shuffle Skins 
Open-Box Macs on Sale! I Get the Card -- Get the 

Get up to 70% Mac Of Your Dreams! 
off our regular, "!!'!!Bl ;q,£,,7 Become 

These protective skins come in a variety of colors 
o Retractable Sync Cable for 30-pin iPod 
o Retractable Sync Cable for USB iPod 

~-it~''/ low prices on · - -· ... "':'.... a preferred 
these brand new, r ;-~~::,:::: customer 
but opened-box with PowerMax 
Macs! and save! 

o Car Charger Adapter for 30-pin iPod 
o Car Charger Adapter for USB iPod 

Dr. Bodelin's Optical Mouse 
Works on practica lly any surface. 

Choose from three styles! 

Local: (503) 624-1827 ·Fax: (503) 627-1635 

Email: sales@powermax.com 

Knowledge is Power 8 Authorized ti Apple Specialist 
Reseller 

Micronet's MiniMate 
hard drive was created 
specifically to com
pliment Apple's Mac 

mini; up to 
--......._-.--"'.1"~-'l".1250GB 

capacity! 

16068 Minimate USB!FW external drive .. . .. .. . $178 
250GB Minimate USB/FW external drive ... . . . $229" 
400GB Minimate USB/FW external drive . . .. . . $387" 
BOGB Platinum 7200 rpm USB/FW ext. drive .. . . $123" 
120GB Platinum 7200 rpm USB/FW ext. drive . .. . $128" 
300GB Platinum 7200 rpm US8/FW ext. drive . . . $249" 
BOOGB Platinum SCSI desktop RAID . . . .. . . $1569" 
I.OTB Platinum FW 800 desktop RAID .. . . .. $1577" 
1.STB Platinum SCSI desktop RAID ... . .. . .. $2419" 

Personal Financing 
Fast P.O. Approvals 

• Business Leasing 
• Daily Specials on 

our Web Site 

Prices subject to change without notice. Credit card orders strictly verified against fraudulent use. With use of credit card as payment, customer acknowledges that some products are subject to final sale. Many prices are 
limited to stock on hand. All brand names are registered trademarks of their respective holders. Not responsible for typographical errors. "after mail·in rebate(s) t excludes mac mini t t some restrictions apply 



SportSuit Convertible 
MP3-Bandit 

Protection, flexibility, and a secret pocket for head
phones or breath mints. Clip it to your candy sack. Its 
sporty style and fashion colors matches any leotard. 

The perfect accessory for Zorro. This simple, 
lightweight adjustable armband is designed to 
securely hold your shuffle during swordplay. Ole! 

~ 

BruddyClip 
Four out of five superhe
ros choose BruddyClip 
for their iPod shuffle. 
"Watch me wrap my 
earphone cords," says 
Middle Manager Man. 

OnTour Speakers 
Blare the hiss and screech 
of the Alien from your 
hydrangea bush with 
these portable speakers. 
Yeah, scare'm good. 

111• MP3 B RND ·IT·-

'~ ./ 

iSkin eVo 2 - Blush 
Going as chewed-up bubble 
gum or as a Sockeye 
Salmon? Complement your 
costume with skin-tight pink 
silicone iPod protection. 

iSkirt 

PocketDock - FireWire 
With this tiny adapter, the 
Human Torch can whip out 
his trusty FireWire cable and 
charge his iPod anywhere. 
Flame on! 

Smartwrap 
Every good Ninja needs 
nunchucks, a Japanese
to-English dictionary, and a 
colorful 3-pack Smart
wrap - to wrap their 
earphones of course. 

sumaJ1n 



G3/500 Pismo, 256mb, 12gb, DVD, 14" ·$399 
G4/550, 256mb, 20gb, Combo Drive, 15" • $799 
G4/867, 128mb, 60gb, SuperDrive, 12" • $979 

iBooks: 

G3/700, 256mb, Combo Drive, 12" • $549 
G3/BOO, 256mb, 30gb, Combo Drive, 14" • $599 
G3/900, 256mb, 40gb, CQmbo Drive, 12" • $649 
G4/1 .2, 256mb, 60gb, Combo Drive, 12" • $799 

NEW 

Mac Repairs & Parts 
OVERNIGHT· NATIONWIDE: 1·877-34-REPAIR 

Overnight Power Supply Repairs 
For G3, G4, G5 & iMac: Only $129 
Includes Overnight Shipping! 

Overnight Logic Board Repairs 
Starting At $149 

Mac Parts: 

Cases, 
Video Cards, 
Cables, 
Drives, 
and much more! 

FirD&I ' 

iPod Upgrad!')s: 
1st Gen. 5gb to 20gb $1 ~9 
2nd Gen. 1 Ogb to 20gb $129 
3rd Gen. 15gb to !!JOgb $189 
4th Gen. 20gb to 60gl:i $219 
Includes Round-Trip Overnight Ship~ing 



ALL MEMORY ON SALE!!! 
65 1 gb/2ob KH ~ 
Mac Mini lob 4'# 
iMac 65 1 ob /512mb 
iMac G3/G4 256/512mb/1 ob 
PwrBook/iBook 512mb/1 ob 
64 Tower 256mb/512mb/ 

All Models only $99 

(•@ 
iresh Juice! 

Available for: 
Powerllook Git Titanium 
iBook IZ" White/Snow 
iBook Clamshell models 
iBook W' White/Snow 

AirPort;\\ quantities 
limited 

Original AirPort" Card in stock 

D atsoavailable 

AirPort" Extreme Card 

New Pioneer SuperDrives iBook & Power11ook 
A106 4x OVO-R $ 39 Superllrives 
A11016x OVO-R 59 available now 

Notebook Drives ~;, Internal Serial AJA 
Capacity RPM ~ Capacity Cache 

80gb 5400rpm $109 250gb Bmb $109 
100gb 5400rpm 169 400gb Bmb 239 
120gb 5400rpm 259 500gb Bmb Call! 

Wanna Keep Your Personal Information 
and Projects TOP SECRET? 

Use . .. 

TopXNotes 
ADVANCED NOTEPAD FOR OS x 

A modern notepad for Mac OS X loaded with handy-features! 

MULTIPLE FONTS, PREDEFINED 

SIZES, AND COLORS AND CUSTOMIZABLE 

Fuu DRAG & DROP 
NOTE TEMPLATES 

AUTOMATIC 

LINK RECOGNITION 

"OmcKNOTEs" 

FOR OUICK ACCESS 

TO YOUR NOTES 

TABLE OF CONTENTS 
ENCRYPTION 

WITH CATEGORIES 

AND GROUPS 
KEEPS SENSITIVE 

DATA SAFE 

MULTIPLE, 
• • • AND MUCH, 

INDEPENDENT 

NOTE VIEWS 
MUCH, MUCH MORE 

-·~ --~ 

~:~ ~~~ 
. .,_~ 

l!J =.--.- == :· ; __ •· . 
u- · - , '9-·- ·w- 11 ··-~- =~ ... : 

~--- ··~ . 

Trop ic.-il 

Software 

TopXNotes 

. --!ii --:-J f212l _ ,, liii 

!: • l.tii . 

VISIT HERE TO DOWNLOAD AND TRY ToPXNons 

• Troolcal Software 
~ l www.TOPXNOTES.COM/MACADDICT 

MacUpdate ~versiontracker 
**'**"' 5.0 11.itlno 

We've got your back. 
Thousands of parts and accessories for your Powerbook 

> avoid costly service 
> do-it-yourself Powerbook & iBook parts 
> free online Fixlt Guides 
> thousands of parts and upgrades 
> 6-month warranty on most products 

pbfixit . com 

••• some call them Hoods! 
(800) 818·3946 

www.HoodmanUSA.com 
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Auto/Air Power Adapters 
for all 

Titanium G4s & iBook models 
Replacement Mini 

AC Adapters 
for all 

Titanium G4S & iBook models 
(65 Watts max.) 

Mini AC adaptersfeahire: 
• 100 • 240 auto switcl1i11g input 
• Fold away outlet prongs 
• Conuinient cable wrap 

with Vclcro1 '" Strap 
• 4-1 :it J.6 x '·' '" 

LUonAuxiliary Power Packs 
For all Ti G4S & iBooks 

Extend your laptop J'Untime 
3 to 4 times longer 

Lightwieght 
2.4(MP6o)lbs - 3.4(MP9o)lbs 

Size - 11.25 x 8.5 x .5" 

I. ind uduJ.'lersfcalu1•c : 

. !~~;~rA~~d~~!~~!~'.~;~;1ilry 
• Durable ABS housing 
•Nylon C(ln•ying case 

MaxPowe1• 60(95WH) 
& MaxPowcr 90(140WH) 

Order online at: 
www .lindelectronics.com 

or call #800-897-8994 to order 
Lind Eledroni<-'~1 Hu:. 6-1-14 Cu1uhridgc Stri'l"l. :\lim1cttpoJI,., MN ~.:i...J.2(' 119;i:!·l):.?7·h:iO:I 

Software Savings for Students, Teachers, and Schools! 

j Adobe® Ou ark® Macromedia® Alias® 
j Creative Suite 2 QuarkXpress 6.5 Studio B Maya 7 Unlimited 
i Save! 67% Save! $756 Save! $710 Save! 85% 
~ Order Today! Only! $189.95 E1 Only! $289.95 Only! $389.95 

!.1 
Get the Best for Less! The lndustJy-Standard ! Brand New Version! Brand New Version! 

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are 
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us on line today and start saving! 

Adobe"' Macro media"' 
Acrobat Pro 7 .... .... .... Save 69% Dreamweaver 8 ...... ..... ....... $189 
Photoshop CS 2 .. ...... . Save 53% Flash Professional 8 .. ......... $239 
Video Collection .. ... ... Save 55% Contribute 3 .... ..................... $89 

Alias"' 
Maya 7 Complete Student..$289 
SketchBook Pro 2 Student....$89 

Corel"' 
Painter IX ................. .. .. ......... $89 

Microsoft"' 
Office 2004 Student!Teacher .. $139 

Wac om"' 
Graphire3 6x8 Tablet... ......... $169 
·1ntuos3 6x8 Tablet ...... .. ........ $279 

Give us a call anytime! 

We carry many of the products 
reviewed in this magazine! 

Griffin TuneCaps (set of 3) .. .. .. ... ... ... .. $9 
Norton AntiVirus 10 .............. ........... $49 
Roxio The Boom Box ..... ..... ..... ...... .. . $39 
Canon Pixma iP90 ..... .. .. ......... ....... $225 
Epson Stylus Photo RX620 ...... .. ... .. $279 

Hey Parents! 
"You are eligible 

to buy for your 
students at home 
or away at school." 

Prices subject to change at any time. 



The best just got better ... 

Introducing ilisten MX 

Includes the top of the 
line YXi Talk Pro USB 
Headset/Microphone to 
give you the clearest 
audio for improved 
recognition. 

Also comes with everything you need to dictate into 
all your favorite applications, to control your mouse 
using your voice, and includes over 200 voice 
commands for controlling iDVD, iMovie, iPhoto, 
iTunes and Garageband. 

Available at the finest Mac resellers 
Get iListen MX today from 

http://www.macspeech.com/promo/macaddict.html 

MacSpeech, Inc., 50A Northwestern Drive, Salem, New Hampshire 03079 

~-------------ii\ High-Performance \1 ~ Mac Memory 

iMac GS iBook G4 

256mb - $39 
512mb - $69 
1Gig - $125 

PowerMac GS 
512mb - $69 
1Gig - $125 
2Gig - $249 

eMac DOR 

256mb - $39 
512mb - $69 
1Gig - $125 

256mb - $45 
512mb - $69 
1Gig - $199 

PowerBook G4 

512mb - $69 
1Gig - $199 
2Gig - $395 

G4DDR 

512mb - $69 
1Gig - $125 
1.5Gig - $179 

Ramjet, Inc. has served the Macintosh community since 1996. 
Offering top quality components and genuine Mac expertise, 
Ramjet is frequently cited as the top Macintosh memory company. 
Being geared toward Iha professional user, Ramjet performs 
stringent compatibility and performance bum-in tests to assure 
maximum reliability. This quality control, coupled with an easy 
and generous warranty, makes Ramjet the smar1 choice. 

Professional Fast De endable 

--
Powerful. Swift. Reliable. 

The Ml Ni's Sweet Too ••• 
Sign Up For a FatCow Hosting Plan Sept. 15th Through December 5•h 2005 and You Could 

Win a MINI Cooper® or a Mac mini® or an iPod mini® 

The FatCow · , "+"'" 
. 1 Gig of disk space 

1Q~~~-~~~~~-~ 
. 30 Gigs of monthly transfer 

• 100 e-mail boxes 
· WebMail 
Spam & virus filtering 

· ShopSite Shopping Cart 
· SiteDelux Site Editor 

·Web Statistics 
• CGI, PHP, MySQL 
• Search Engine Tools 
• Message Board 
·Toll-Free Support 

11\e K4tyspa" 4-Port Print Server is an ideal print 
shoring sol\atlon for creative professio~ls! 

High Capacity: Connect as many as 4 USB printers to your 
wired or wireless network. 

Bi·Direttional: Transmits print jobs to attached printers. 
Reports ink/paper status back to the MadPC. 

Versatile: For use with inkjet printers, laser printers, 
photo printers, label printers and plotters. 

High Performance: Supports simultaneous use of attached printers. 

,, cvr DAN Connecilan5 for your Computer 
ft&; I ..;,rft www.keyspan.com 
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7 great reasons to choose DriveSavers: 
• Fast, advanced, proprietary techniques. 
• All operating systems; Mac, Windows, OS/2, 

Netware and UNIX. 
• All storage devices including SAN, RAID and 

NAS systems. 
• Instantly retrieve recovered data 

with DataExpress'". 
• Recommended and certified by all 

hard drive manufacturers. 
• Government Contracts 

"""e Can Save Itl" • Featured on MacAddict,MacWorld, 5,, " 1985 
vvi • CNN, BBC and others. 

Visit DriveSavers at www.drivesavers.com 
©2003 DRIVESAVERS. INC 400 BEL MARIN KEYS BLVD .. NOVATO, CA 94949 INTL: 4 l 5·382·2000 

Special web site hosting offer 
for MacAddict Readers! 

Web Hostin 
Co-Locatio 

www.lnno-Tech.com/MacAddict 

Special Buy Memory Sale! 
65 lgb 
65 512mb 
PowerBook 64 1 gb Samsung 
PowerBook 64 512mb Samsung 

$112 
59 

206 
93 

G-RAID 
$ 349 

499 
929 

1,099 

AirPort® Card 
Original 802.11 B 

limited quantities available 



MacPrices.com 
Nothing But (Mac) Prices 

Find the lowest price! 
Get the best free bundles! 

www.macprices.com 

MAC 
OF ALL 

TRADES~ 

WE BUY AND SELL 

USED MACS 

www.macofalltrades.com 

FAMILY HISTORY - GENEALOGY 

REUNION®8 
Reunio n 8 is the perfec t tool to 
organize your family history. Plenty of 
room for names, dates, places, stories, 
notes, tidbits, and 
sources. Include 
all your fa vorite 
pictures, sounds, 
and home movies. 
Automatically 
build multimedia 
web pages to 
share your fa mily 
hi story on the 
Internet! Pr in t large, co lorfu l t ree 
charts, timeline charts, and fan charts 
"'"'""""'"""3 for family reunions. Fun 

and educationa l fo r the 
w hole family. Reunion 8 
takes advantage of OS X 
and includes over x 
100 new fea tures 
and enhancements! 

Leister Productions 
web site/demo: www.LeisterPro.com 

e·mail: in fo@LeisterPro.com 

To order, call... 
MacConnection 800-800-2222 

s: 
Q) 

. . . 0 
features ~ 

a. 
a. 

) L~G OUT,,,",,~,,,,,,,,,,,,,,, 

A BETTER MACHINE . 
A BETTER MAGAZINE. 

--~ Call toll-I ree 

1-888-111-6222 r. to start vour subscription to MacAddict 

Mactallic-
mactallic.com 

Soothing heat for cold, stiff hands! 
www.ThermalRest.com 
800.818.3946 

Your iMac's other half. 
"iGo is a desk designed with the iMac 
in mind, and the two together 
are quite a sight:' 

* * * * Macworld UK 

l 
Let's interact! 

NEW. i360° swivel base provides 
an elegant and dynamic way 
to turn your iMac GS and 
Cinema Display (17': 20" and 23") 

1.800.797.7321 www.raindesigninc.com rain design • 

( Mac Shop NOV/05 



LETTERS 
THE LEETNESS 
I, in my ultimate geekitude, 

noticed that that the Max 

motherboard in Shut Down 

(Sep/OS, p80) is from an LC 
47S. If I am co rrect (and you 

print this letter), all of my 

friends will bow before me in 

my radiance of 1337l\l3SS! 

-Michael Beardsworth 
Congratulations-a gift basket 

full of muffins, cookies, and 

seasonal cheese logs is on its 

way to you right now! Nah, not 

really ... but you're still pretty 

smart.-Max 

The LC 475 (aka Quadra 605) 

was born in 1993 and died in 

1994. Rest in peace. 

SPLOTCH LIGHT 
Thanks for your "46 Bugs" 

article (Aug/OS, p16), 

but you missed a pesky 

Spotlight pest. If you have a 

file named myjournal 

.txt, for example, and you 

type journal into Spotlight's 

search, myjournal.txt will 

not show up in the results . 

If you type my, however, 

Spotlight will find the 

file. After several tests, I 

discovered that Spotlight 

won't find groups of letters 

in a file name unless (a) the 

file name starts with those 

letters; (b) the letters are 

separated in some way, such 

as with spaces, dashes, 

underscores; or (c) capital 

letters are used to separate 

words, as in MyJournal 

.txt. I don't remember Find 

(Command-F) having this 

issue before Spotlight came 

along-sounds like a bug to 

me!-Wanze Marder 

STEADY AS SHE GOES 
About three weeks before 

reading Niko Coucouvanis's 

"Make a Steadicam Rig" 

how-to (Sep/OS, pS8), I built 

something similar for in-car 

and driving shots. The whole 

thing cost me about $30. 

It's made from PVC piping, 

some sheet metal, and a 

hacked-up $8 tripod . Check it 

out.-Chris Carroll 

You'd better watch out, Niko. 

Chris is after your job. 

Survey 
Says 

What do you like best about 
Mac OS 10.4 Tiger? 

Here are the results 

of our July 200S 

survey. Check out 

www.macaddict.com 
each month for a 

new on line poll. 

36% Those cute 
Iii' time-wasting 

Dashboard wid ets 

36% Using 
Spotlight to find 

stuff I've 
mis laced 

Analog clocks 

made out of 

digital media

oh, the irony! 

MAKING TIME 
How do you recycle your CDs? I make clocks out of them!-C/iff 

As the late, great Douglas Adams once wrote, "Time is an 

illusion. Lunchtime doubly so."-Max 

THE KISS OF DEATH 
I believe I may have 

stumbled upon an interesting 

phenomenon-any time you 

feature a movie on your cover, 
that movie ends up sucking, 

bombing, or both. Hulk 

Oul/03)? Sucked. Van Helsing 

Oun/04)? Sucked harder. Now 

your September cover features 

a picture-larger and more 

central than the Hulk or Van 
Helsing pies, I might add-of 

The Island, which both sucked 

hard and bombed big at the 

box office. Better keep this 

under wraps, lest the studios 

16% I'm waiting to 
upgrade to Leopard 
on a Mactel. Ma be. 

8% One word: 
Dictionary! 

4% Toying around 
with Automator, 
trying to get it to 
do useful work 

realize your mag is a potentially 

devastating tool of sabotage. 

-Bob McClellan 

It's true; we wield enormous 

destructive power. As of this 

writing, The Island has barely 

cleared the $34 million mark. 

So if you've got any movies 

you'd like to see ruined, 

send your emails now. I'm 

pulling for an entire issue 

devoted to Deuce Bigalow 3: 
Mesopotamian Gigolo.-Max 

GTAISMIA 
I'm sure you've been emailed 

by irate Mac addicts with the 
same be.ef as me hundreds 

of times, but where's Grand 

Theft Auto? I've been 

patiently waiting for, like, 

four years now for news, and 

nothing!-DeathPunk 
Haven't you heard? That GTA 

game causes cancer and eats 
puppies. Trust me, DeathPunk, 

you don' t want that sort of evil 

inside your Mac.-Max 

PENTIUMANCY 
Little did I know that when 

my PC-loving coworker gave 

980 respondents 
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me this "Pentium Guy" back 

in 1999 and I embellished 
him with an Apple logo, it 

was truly a prediction! 
-Carol Sierzega 
The 26th quatrain of 

Nostradamus. Strange bumps 

on the surface of a Red 
Delicious. That fortune cookie 

from P.F. Chang's that said, 
"Apple wilt find happiness 
with Intel." Indeed, the signs 

were everywhere ; we just 
chose to ignore them.-Max 

Hindsight is 20/20. 

HONOR THY MOM 
AND POP 
I thoroughly enjoyed Nikki 

McDonald's article, "Mom 'n' 

Pop and Apple" (Jut / OS, p6) . 
We all love the Apple brand 
and hesitate to beleaguer 

ou r underdog geniuses, but 
I, for one, want to be counted 

as saying that I don't want 

Apple to play dirty tricks on 
independent Apple providers. 
Thanks for a great story-and 

Apple, if you're listening, 
let's put that shine back on, 
OK?-Audrey P. 

PODRACING 
A friend of mine 

owns a company 
specializing in 
vinyl graphics for 

vehicles owed me a 
favor, so I had her 
make me an iPod 
clickwheet. I think it 
looks rather spiffy 
on the hood of my 
car. Too bad it's not 
an iRock Camara. 
-Brad Bartkus 

SOFTRAID 
CLARIFICATION 
Thanks for the great review 
of SoftRAID (t::H:H:i 0 

Sep/ 05, p51) ! We just 
wanted to clarify one point 

about moving SoftRAID 

volumes to other Macs . The 
SoftRAID driver is included 

with every copy of Mac OS 
10.4 (Tiger), so a SoftRAID 

volume can be moved to a 
Tiger machine and will be 
instantly recognized just like 

an Apple volume. There is no 
need for the additional step 
of installing the driver as you 
say there is in your review. 
-Miriam Block, Managing 

Director, SoftRAID 

HOLY DAYS 
"From Adam's Apple" (Aug/05, 
p80) was a great blog, but 
wouldn't Adam's rib be sore on 

Day Eight since the Landlord 

took the seventh day off? 
What a way to start the next 

week, though! If I am correct, 
this is another example of why 

bloggers aren't journalists. 
-Gary E. Kampe/ 
In Genesis 1:27, the Landlord 
created "mate and female" on 

Day Six. Now, I wasn' t there 
myself, but I'm guessing the 

rib-removal action happened 
after Adam had crashed for 
the night, and the Landlord 
did the deed before 11:59 
p.m .-Max 

WIN! 
Win Avid Xpress Pro! 
Want to join the ranks of truly pro-level video editors? Here's 

your chance to move on up to Avid Xpress Pro 4.8 ($1,695, www 
.avid .com) . Optimized for Mac OS 10.4 (Tiger), this video-editing 
software include tools that tap Tiger's Core Image technology
prepare to be amazed at the effects you'll be able to produce. If 
you ' re looking to fully unleash your cinematic creativity, all you 

need to do is write the best caption for the image below. 
Only one entry per contestant. 

Entry Form 

Write a caption 
for this picture. 

CONTESTANT INFORMATION 

Full Name: 

Address: 

Ci : State: 

Zi : 

Email or telephone: 

Send email entri es to: contest@macaddict.com with the subject : Avid Contest 
(Don't forget to Include your address information!) 
Send snail-mail entries to: Avid Contest, MacAddict magazine , 
150 North Hilt Dr., Ste. 40, Brisbane, CA 94005. 
Deadline for entry: November 30, 2005. 
Contest results will appear in our Mar/ 06 issue. 

Contest Rules The judges wi l l be MacAddict ed itors and will base their decision on 33 percent hum or, 33 percent 
originality, and 33 percent creativity. All entries must be received no later than November 30. 2005, with the win ner 
announced around March 2006. By entering this contest, you agree that Future Network USA may use your name, 
likeness, and Web site for promotional purposes without Further pay ment. All prizes will be awarded . and no minimum 
number or entries is required . If two or more people enter identica l w inn ing captions, the entry received first will be 
awa rded the contest prize . Prizes won by minors w il l be awarde d to thei r pa rents or legal guard ians. Future Network 
USA is not respons ible for damages or expenses the winners might incur as a result of this contest or the receipt or a 
prize . and winners are responsible for income taxes based on the va lue of the prize received . A li st of winners may also 
be obtained by sending a stamped, self-add ressed enve lope to Future Netwo rk USA c/o MacAddict Contest, 150 North 
Hill Or. , Ste. 40, Brisbane, CA 94005. Th is contest is l imited to reside nts of the Uni ted States. No purchase necessary, 
void in Arizona, Maryland, Vermont, Puerto Rico , and where proh ibited by law. · 

W ., n n er I Congratulations to Tucker Hiatt, whose caption 
~~~~~~· won him an 8-megapixet Olympus Evatt E-300 
digital SLR ($799.99, www.olympusamerica .com)-and better 
tuck next time to the 45 readers who sent in the identical caption, 
" iChat to the Max! ;' 

.. . 
. 

Volume 10, Issue 11 

"Well, boys, it looks as though 
'thinking outside the box' just isn't in 
the cards for us." 
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funds only. Ganadian price includes postage and GST 128220688. IPM 0962392. Outside the U.S. and Canada, price is $53.95, 
U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddicl. P.O. Box S126. Harlan, IA 51593-0626. Future 
Network USA also publishes Maximum PC, Mobile, PC Gamer; Official Xbox Magazine. PSM, Guitar World, Guitar One, Guitar 
World Acoustic, Bass Guitar; Guitar Legends, Future Music, Future Snowboa.rding, Snowboard Journal, Snowboard Trade News, 
Skateboa.rd Trade News, and Scrapbook Answers. En!ire contents copyright 2005, Fu!ure Network USA. All rights reserved. 
Reproduction in whole or in part is prohibited. Future NetvJork USA is not affiliated with the companies or products covered 
in MacAddict. Ride-Along enclosure in the fo!lowing edition(s): A2, B. 81. -82, B3. PRODUCED IN THE UNITED STATES OF 
AMERICA. Publications Mail Agreement #40043631 . Returns: 4960-2 Walker Road, WITldsor ON N9A 6J3 

November 2005 MacAddict 79 



Power Your iPod with 
a Car Battery 
by Niko Coucouvanis 

Last month we showed you how to power your iPod with a 9-
volt battery ("Power Your iPod with a 9V Battery," Oct/05, 
p62)-but if 9 volts are good, wouldn't 12 volts be even 

better? No 'bout a-doubt it! Follow along as we juice our precious 
iPod shuffle with a NAPA Auto Parts Sure Start 65-month car 

ON THE 
DISC 

Quicken WlllMaker 
Plus 2006 

battery we lifted from Art Director Mark Rosenthal's 1991 Honda Civic. 

WHAT YOU NEED 

Safety goggles 

12-volt car battery ($67.99, www 
.napaonline.com, part number 
NBR5051) 

Jumper cables ($47.10, www 
.pepboys.com, part number 
756100) 

5-volt fixed-voltage regulator 
LM7805 ($1.59, www.radioshack 
.com, catalog number 276-1770) 

USB-A-female-to-USB-A-male 
extension cable ($6.99, www 
.cablestogo.com, product 
number 19003) 

Sure, you could simply drop into the local Pep Boys or 
NAPA store, but where's the fun in that? Save a few bucks cable to the LM7805 5V regulator as shown in our 

Oct/05 9-volt how-to, connect the female end of the extension by finding an unlocked car in your local 
parking lot, popping the bonnet (that's 
Brit-speak for "hood," y'gormless 
pillock), and, uh, "repurposing" 
the battery. (NAPA, by the way, has 
nothing to do with the California wine 
country-it's an acronym for National 
Automotive Parts Association. Ain't the 
Web wunnerful?) 

Remember, red is positive, and 
black is negative. Or maybe it's 

the other way around_ 

Carefully ease the free ends of the jumper cables toward 
the USB-cable wires. When the distance between them 

approaches a few millimeters, a 
high-amperage jolt-think lightning, 
only shorter-will vaporize the 
intervening air and bond the jumper 
cables to the wires. Of course, it may 
also singe your hair, depilate your 
eyebrows,searyourcorneas,and 
cause an immediate heart attack-eye 
protection is highly recommended. 

Instant vaporization- no 
soldering iron needed! 

80 MacAddict November 2005 

cable to your iPod shuffle, and then 
connect the jumper cables to the 
12-volt car battery. Now position the 
other ends of the jumper cables near 
the stripped ends of the USB cable. 
With the 800 cold-cranking amps of 
the NAPA Sure Start at your service, a 
soldering gun won't be necessary to 
assure a solid weld . 

Nerves of steel, brains of 

Cream of Wheat. 

a formless white plastic blob, you've succeeded. If it's 
bleedin' demised, buy another one, 
and try again . Oh, and by the way, 
we've got a bunch of 'em up on eBay 
you can get for a song. They work 
fine. Really, they do. Trust us. If your 
iPod is good to go, hook it back up, 
strap the whole battery 'n' cables 'n' 
iPod rig onto a hand truck, and go 
for a music-enhanced stroll-a long, 
long, long stroll. 

Did your iPod survive? Did you? 

,~Niko Coucouvanis may be a wee bit doolally and a tad dagenham, 
'!:...l but he's not daft enough to actually try someth ing this dangerous. 
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Domain Registrat ion 

Real-Person Customer Serv icem 

Online Sa les & Marketing Tools NetworkSolutions® 
» SSL Certificates 

... And More 

Call or click: l.86~455.2005 I www.networksolutions.com 
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THE NEW SAFE YOU CAN TOSS IN YOUR POCKET. 

IN A SAFE ISN'T ANYTHING NEW, BUT CARRYING THAT SAFE AROUND WITT-i YOU IN 

DATA ANYWHERE WITT-i THE NEW IACIE SAFE HARD DRIVE WITH BIOMETRIC ACCESS. 

AND SECURE, ENSURING THAT YOU CONTROL WHO HAS ACCESS TO YOUR 

Y DRIVE IS PLUG & PLAY AND USB 2.0 BUS-POWERED. WWW.LACIE.COM 


